





removeNodeAlias

Use the removeNodeAlias command to delete alias information from the sphere database.

See Resolving Discovery Issues, for a discussion of the use of this command in resolving discovery issues.


Command Syntax


btmcli removeNodeAlias -n nodeName -alias aliasName
                       -s sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The canonical name of the network node. Typically a fully-qualified domain name. For example, jbujes-myPC.edgility.com
	-alias	-alias	An alias for the network node. This can be a domain name or a static IP address.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the removeNodeAlias command.


btmcli removeNodeAlias -n jbujes.edge.com -alias Athena
                       -s http://localhost:8080/btmcentral/sphere/
                       -l admin:abracadabra






Looking at Dependencies

In addition to discovering business components, Business Transaction Management can discover how components relate or depend on one another by observing message traffic as it flows from one component to the next. Dependency information provides an accurate picture of how your composite application is really behaving. It might alert you to the fact that certain components are not being called, and it provides a basis for defining business transactions.

You can view dependencies between services, endpoints, (service instances), or operations. Each dependency map provides information appropriate to the element selected.

You can also delete dependencies if dependency graphs show out-of-date dependencies.


Showing Related Elements

No matter what type of dependency it is showing, a dependency diagram is rooted in the selected object and displays all the links that lead out from and into that starting point. Anything that is not directly upstream or downstream of the root object is not shown. To display these additional elements, click on the wrench icon to display the Layout and Show-Related controls.

The default value for Show Related is None, meaning that only elements directly linked to the root object are shown.

	
Select One to show the next level of objects indirectly linked to the root object, or select All to show all objects linked to the root object.


	
Click OK.








Service Dependencies

To view service dependencies

	
Select the Services To Endpoints view or the Services to Operations view in the Navigator.


	
Double click on the service of interest to open the tab area if it is not already open. If it is open, just select the service of interest.


	
Select the Dependency tab. Business Transaction Management displays the dependencies between the selected service and the other services with which it interacts. Arrows display traffic flow; their thickness indicates relative throughput size.


	
You can move the cursor over the services displayed to have Business Transaction Management display their component type.




You can also display service dependencies by choosing the Maps > Service Map view from the Navigator.





Endpoint Dependencies

To view endpoint dependencies:

	
Select the Services To Endpoints view in the Navigator.


	
Expand the service of interest to display its corresponding endpoints. A (logical) service might have several corresponding endpoints if the service has been replicated or if different endpoints are used for secure/unsecure communication.


	
Double click on the endpoint of interest to open the Tab area. If it is already open, just select the endpoint of interest.


	
Select the Dependency tab. Business Transaction Management displays the dependencies between the selected endpoint and the other endpoints with which it interacts. Arrows display the direction of traffic flow and relative throughput. For each endpoint, the host name and port for the container where the endpoint resides are also displayed. The means by which the endpoint is discovered is shown in parenthesis; the following table describes the possible types.





	Means of discovery	Meaning
	observer	The endpoint was discovered by an observer
	router	The endpoint was discovered by a router. (The existence of a hardware router was inferred based on discrepancies between the HTTP Host header and the physical address of the observed container(s).)
	registered	The endpoint was manually registered
	DTA	The existence of the endpoint was inferred based on outbound traffic addressed to it from an observed endpoint.






As you pass the cursor over individual endpoints, Business Transaction Management displays the endpoint name, the container's host and port, and the service and component type of which the endpoint is an instance. Core measurements are also given.





Operation Dependencies

To view dependencies between operations:

	
Select the Services to Operations view in the Navigator. You can view dependencies between logical or physical operations. Logical operations are listed immediately under the service; physical operations are listed under logical operations. The name of a physical operation takes the form

endpointName on containerName

For example: checkCredit.CreditServiceSOAP on uitest20:7011


	
Double click the operation of interest to open the tab area. If it is already open, select the desired operation.


	
Click the Dependency tab if it is not already selected.


	
The call chain containing the operation is shown.


	
Pass the cursor over the operation to display additional float-over help.








Deleting Dependencies

You might need to delete all dependencies if your application has changed and the dependency graph does not reflect these changes. Dependency data does not age out, so in those cases where the graph includes obsolete data, you might want to clear all dependencies and regenerate the graph by running more traffic.

To delete dependencies:

	
Select Delete Dependencies from the Admin menu


	
Click Delete.


	
To regenerate dependencies, run more traffic.










Oracle Business Transaction Management

Online Help

Release 12.1.0.2

E26585-05

July 3, 2012




Oracle Business Transaction Management Online Help , Release 12.1.0.2

E26585-05

Copyright © 2012, Oracle and/or its affiliates. All rights reserved.

Primary Author: Joanna Bujes 

This software and related documentation are provided under a license agreement containing restrictions on use and disclosure and are protected by intellectual property laws. Except as expressly permitted in your license agreement or allowed by law, you may not use, copy, reproduce, translate, broadcast, modify, license, transmit, distribute, exhibit, perform, publish, or display any part, in any form, or by any means. Reverse engineering, disassembly, or decompilation of this software, unless required by law for interoperability, is prohibited.

The information contained herein is subject to change without notice and is not warranted to be error-free. If you find any errors, please report them to us in writing.

If this is software or related documentation that is delivered to the U.S. Government or anyone licensing it on behalf of the U.S. Government, the following notice is applicable:

U.S. GOVERNMENT RIGHTS Programs, software, databases, and related documentation and technical data delivered to U.S. Government customers are "commercial computer software" or "commercial technical data" pursuant to the applicable Federal Acquisition Regulation and agency-specific supplemental regulations. As such, the use, duplication, disclosure, modification, and adaptation shall be subject to the restrictions and license terms set forth in the applicable Government contract, and, to the extent applicable by the terms of the Government contract, the additional rights set forth in FAR 52.227-19, Commercial Computer Software License (December 2007). Oracle USA, Inc., 500 Oracle Parkway, Redwood City, CA 94065.

This software or hardware is developed for general use in a variety of information management applications. It is not developed or intended for use in any inherently dangerous applications, including applications that may create a risk of personal injury. If you use this software or hardware in dangerous applications, then you shall be responsible to take all appropriate fail-safe, backup, redundancy, and other measures to ensure its safe use. Oracle Corporation and its affiliates disclaim any liability for any damages caused by use of this software or hardware in dangerous applications.

Oracle is a registered trademark of Oracle Corporation and/or its affiliates. Other names may be trademarks of their respective owners.

This software and documentation may provide access to or information on content, products, and services from third parties. Oracle Corporation and its affiliates are not responsible for and expressly disclaim all warranties of any kind with respect to third-party content, products, and services. Oracle Corporation and its affiliates will not be responsible for any loss, costs, or damages incurred due to your access to or use of third-party content, products, or services.




Viewing Discovered Services

Business Transaction Management displays information about discovered services, service endpoints, routers that distribute message traffic to endpoints, and service operations.

	
services refer to logical services


	
endpoints refer to service instances and routers


	
operations are invoked by request and response messages that one service sends to another




When you start Business Transaction Management, no services are shown. For services to be discovered:

	
Services must be deployed to application servers where observers have been installed and the appropriate probes have been activated.




	
Traffic must flow from one service to another service (unless you manually register a service).




Once services are discovered, you can access information about them from the Services To Endpoints and Services To Operations Navigator views. You can view services dependencies in the Maps > Service Map view.


Service Types

Business Transaction Management assigns a type to a service based on the type of the first endpoint discovered for the service. Service types include Web Application, Web Service, and Database. (A web application is a component that interacts with the user via HTML pages (screens)). Note that a service might have multiple endpoints of different types and be discovered by different observers. For example a web service might have multiple endpoints on different containers implemented using different technologies: JAX-RPC, JAX-WS, WCF, and so on.





Deployment Topologies and Service Information

The service information displayed varies with the topology of your deployment. If you have only one instance of a service running, one endpoint for that service is shown. If you have several instances of a service running, several endpoints are shown for that service.

There are a variety of reasons why you might discover and have to monitor several instances of a service:

	
The service is replicated for performance or failover. In this case all the replicated instances are shown as the service's endpoints. The router distributing traffic to those instances is also shown; the router name is the endpoint name with the suffix Router.


	
The service is deployed in a container with both secured (HTTPS) and unsecured (HTTP) ports. One endpoint will be shown for each port only if traffic flows to that port.


	
A WSDL includes different bindings for a service, each binding defining a different set of operations that can be implemented by different endpoints. This case is rare, but Business Transaction Management will recognize it and discover the endpoints.








How the Existence of Routers is Inferred

It might take a while to determine that a router is being used to re-direct traffic. Business Transaction Management uses the Host headers in HTTP traffic to detect when messages were originally sent to a different address than the container where they were observed, and connects the caller to the recipient in the dependency graph.

When the Host header contains a different host name but the same port, Business Transaction Management will initially add aliases for the container and its endpoints. When the Host header contains a different port than the container is actually listening on, or the same Host header is observed in traffic sent to two or more containers, Business Transaction Management infers the existence of a hardware load balancer between the caller and the service, and will add router endpoints to the sphere model as needed to connect the caller and its target endpoints in the dependency graph.





Viewing Services

You can view service using either the Services To Endpoints view or the Services to Operations view from the Navigator.

To view Services To Endpoints, select the view from the Navigator. Business Transaction Management displays information in the main area of the console. The following table describes the contents of this view.

The Services To Endpoints view is useful in that it shows endpoint replicates. Replicates are distinguished by their address, shown in the main area. They also have distinct definitional and performance information, as shown in the Tab section of this view.


	Column name	Description
	Name	The Name of the service. Expand the top logical service name to show the endpoints it contains. Expand an endpoint to view its operations.
	Up/Down Arrow	Green arrow specifies that the service, endpoint, or operation is running; Red arrow specifies that it's down. Yellow indicates that a service contains endpoints; some of which are running and some of which are down.
	Address	Address of the service's container. Replicate endpoints will have different addresses.
	Type	The type of the service. This is based on the type of the first service endpoint discovered.
	Container type	The type and version of the service container.






To view detailed information about each service, endpoint, or operation double click the desired element to display detailed information in the Tab area, which includes the following data:


	Tab	Description
	Summary	Shows a summary of performance measurements for the object selected in the main pane.
	Analysis	Shows performance information across a specified period of time.
	Alerts	Shows alerts for the selected object.
	Message Log	Shows available messages if message logging is enabled for a given operation.
	SLA Compliance	Shows the compliance of the selected object with service level agreements defined for the given object.
	Profile	Shows definition of selected object. You can edit some of this information by selecting Modify > Edit Profile for object name.
	Dependency	Shows the dependencies between the selected object and related objects.
	Policies	Lists the policies applied to the currently selected object.
	Downtimes	Specifies the scheduled downtimes for the selected object.
	Properties	Specifies the properties defined for the selected object. Use the Edit button to modify, duplicate, or delete these properties.






To view Services-To-Operations, select it from the Navigator. Business Transaction Management. The type of information displayed is the same as for the Services-to-Endpoints view. Tab information is also the same.








resetSphereUrl

Use the resetSphereUrl command to make sure that the sphere URL for container services currently registered with this sphere matches the current sphere URL. You might need to use this command if the base address of the sphere changes.


Command Syntax


btmcli resetSphereUrl -s sphereUrl -l username:password



	Name	Long Name	Description
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/apcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the resetSphereUrl command.


btmcli resetSphereUrl -s http://localhost:8080/btmcentral/sphere/
                      -l admin:abracadabra






About Command Line Utilities

Business Transaction Management includes a set of command line utilities that allow you to perform certain tasks from the command line.

For Java platforms, the utilities are located in: [install_dir]/tools

On Windows platforms, utilities use the JRE bundled with Business Transaction Management.

On Unix-like systems, you must specify a JRE to use by doing one of the following:

	
set the JAVA_HOME environment variable and remove the directory

BTM_install_dir/server/jre directory


	
replace BTM_install_dir/server/jre with a link to a valid JRE directory




The following table lists Business Transaction Management utilities.


	Name	Description
	datastoreUtil	Allows you to connect to a database. Once connected, you can do the following:
	
generate the DDL of the specified schema definition within the connected database


	
check the status of the specified schema within the connected database


	
create the specified schema within the connected database


	
upgrade the specified schema within the connected database


	
drop the entire specified schema from the connected database


	
save the database connection information into a file for easy reconnection to the database at a later time


	
display the owner of the database instance (service name and UUID)


	
reset ownership of the database instance by removing knowledge of its current owner


	
enter the database explore mode (commands to search and display data)





	logMerger	Merges Business Transaction Management system service deployment log files (logdir) to consolidate analysis or archiving.
	showProductInfo	Outputs information about the Business Transaction Management product.










Customizing the Consumer Label

RequiredBusiness Transaction Management application role: btmadmin.

You can customize the text of labels in the Management Console that by default use the terms "Consumer" or "Consumers". For example, you might want to monitor service levels and usage per department, rather than per individual. In this case, it might make sense to change the labels in the Management Console to use the term Department instead of Consumer. You should specify both the singular and plural forms of your term.

Your modified label will be used in the Navigator, in the Analysis pane names, in the Filter tool, and so on.

To modify the Consumer label:

	
Choose Admin > Edit Data Model Attributes.

The Edit Data Model Attributes dialog box opens.


	
Scroll to the bottom and find the Business Object Domains section.


	
Type the singular form of your new label into the Name field.


	
Type the plural form of your new label into the Plural Label field.


	
Edit the Description field as appropriate.


	
Click Apply.


	
Refresh your web browser to see the effect of your change by selecting Refresh from the View menu.









register

Use the register command to register the services (found within the specified WSDL file) with the sphere and write the location URLs of the WSDL's service endpoints to standard output. This command produces the same output if the WSDL is already registered with the sphere. You might need to explicitly register a service in those cases where Business Transaction Management cannot discover SOA-type components directly. For example, a service in a container that cannot be observed or in a container where no observer has been installed.

The register command determines whether the specified WSDL has already been processed. If it has, and the -f (force) flag is not used, the system does not register the WSDL again.

It is possible that Business Transaction Management does not correctly evaluate whether WSDLs are the same, and objects in the sphere might not correspond exactly to those in the WSDL. In this case, you can use the -f flag to reprocess the WSDL. For example, if you want to manually merge services with interfaces that aren't exact matches, you might then also want to reprocess the WSDL.

You can use this command to register more than one service and to match these with friendly names and version information. (This reflects the capabilities offered by the GUI.)

You can also specify a version for each service you register. Business Transaction Management does not enforce any specific versioning notation. For a service with existing replicates, there are two possibilities:

	
If another service with the same qualified name and the given version already exists, merge the specified WSDL's endpoints into that version of the service.


	
If no such version exists, but this WSDL has been processed before, update its service version to the new version.




By default, registered services are placed in the System container (in the Console this is shown in the Unassigned endpoints node). If you prefer to group services together in their own container, you can use the registerExternalContainer command to register a container and associate that container with the base address of the endpoints of the manually registered services.


Command Syntax


btmcli register -w wsdlUrl1 [[wsdlUrl2]...] [-L username:password]
                [-service svc1 [[svc2]...]]] [-fn fName1 [[fName2]...]]]
                [-V version1 [[version2]...]]] -f
                -s sphereUrl -l username:passwword



	Name	Long Name	Description
	-w	-wsdlUrl	The URL for the WDSL file whose service(s) you want to register.
	-L	-wsdlLogin	The user credentials required to access a secure WSDL file.
You can encrypt passwords for use with this command using the encryptPassword command.


	-service	--	Register only the service(s) with matching name attributes in the WSDL. Other services defined in the WSDL are not registered.
	-fn	-friendlyName	Registers a friendly name for the service defined in the WSDL. If the WSDL defines more than one service, you must specify the services you want to register using the -service flag. The friendly names you then define with the -fn flag are mapped to registered services based on their position in their respective list.
	-V	-version	The version of the newly-registered service. Use the "-" string to represent the default, unnamed version.
If a service with the same qualified name and version already exists, the endpoint(s) read from this WSDL are merged into the existing service.

If multiple services are specified using the -service flag, you can specify a single version to use for all services, or a different version for each. Versions are mapped to services based on their position in their respective list.


	-f	-force	Force the WSDL to be reprocessed even if it has not changed since it was last read.
	-s	-sphereUrl	The URL of the sphere where the WSDL is installed.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example registers the service in the specified wsdl using the "friendly name" AmazonSearch.


btmcli register -w http://soap.amazon.com/schemas3/AmazonWebServices.wsdl
                -n AmazonSearch -s http://localhost:8080/btmcentral/sphere/
                -l admin:abracadabra





Preface

Oracle Business Transaction Management Online Help explains how you use Business Transaction Management Release 12.1.0.2 to discover services, define and track transactions, monitor performance, define service level agreements, monitor failures and perform root-cause analysis to locate errors and improve performance. 


Audience

This document is intended for developers and system administrators interested in developing and managing distributed applications.


Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.


Conventions

The following text conventions are used in this document:


	Convention	Meaning
	boldface	Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary.
	italic	Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values.
	monospace	Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.








Persistent Data

This section provides information to help you administer Business Transaction Management persistent data and includes the following subsections:

	
Configuring the Business Transaction Management Database Credentials


	
Setting up the Message Log Database


	
About Persistent Storage Directories


	
Relocating Business Transaction Management Persistent Storage Directories






Configuring the Business Transaction Management Database Credentials

When you installed Business Transaction Management, you configured it to use an Oracle database. If the credentials used for accessing the database change, you must modify the associated setting in Business Transaction Management accordingly.


To modify the database credentials setting:

	
Choose Admin > Edit Database Settings.

The Edit Database Settings tool opens. This tool lets you set the user name and password used by the Business Transaction Management central services to access the Business Transaction Management databases.




	
Note:

Do not select the Embedded Database option. All three databases should have the External Database option selected.








	
Edit the user name and password as appropriate for each database.


	
Click Apply.









Setting up the Message Log Database

If you enable message logging on a transaction, then you must ensure that a database is set up for the monitors to log messages to. During installation and initial configuration of Business Transaction Management, you should have created a message log database (messageLogDB) and provided connection settings for this database. These connection settings were automatically stored in the Default Message Log Database policy and applied to all monitors.

However, you are not restricted to using a single database for message logging. You can create additional databases and configure some monitors to use one database and other monitors another database. You do this by first editing the Criteria section of the default policy so that the policy no longer applies to the monitors that will log to a different database. You then create a new policy for each new database, and use each policy's Criteria section to apply the policy to the appropriate monitors. You must take care that each monitor has only one policy applied to it. For information about creating a message log database, refer to the Business Transaction Management Installation Guide.

If you change the location or the logon credentials of any of your message log databases, then you must reconfigure the settings your monitors use to connect to it. You do this by editing the appropriate message log database policy.

To view the monitors to which an existing message log policy is applied:

	
Select Administration > System Policies in the Navigator.


	
Select the policy in the main area.


	
Click the Targets tab.




To edit or apply a new message log database:

	
Create or identify the Oracle database instance that you want to use for your message log database.


	
Open the message log database policy you will use for configuring the database connection:

If you want to edit the default message log database policy:

	
Select Administration > System Policies in the Navigator.


	
Select the Default Message Logging Database Policy in the main area.


	
Choose Modify > Edit Definition for Default Message Logging Database Policy.




If you want to apply a new message log database policy, choose Admin > Create System Policy > Message Log Database.

The Create Message Log Database policy opens.


	
Ensure that the Database Type is set to Use External Oracle Database.




	
Note:

The embedded database is not supported for production systems.








	
If you want to allow Business Transaction Management central services to directly access the message log database, ensure that the Allow Central Access option is enabled.

If this option is disabled, the central services can access the message log database only by way of the monitor.

Some central services (such as the transaction monitoring component) require access to message content stored in the message log database. These central services can access the database either by way of the monitor or by a direct connection. Using a direct connection improves the performance of message log queries. You should enable this communication channel whenever possible.

In some deployment scenarios, you might not want the central services querying the database directly and would prefer that the monitor do so on their behalf. One such case is when the monitor and database are firewalled off from the central services. In such a scenario, the central services could communicate with the monitor, but presumably not with the database.


	
Provide a connection string and user credentials for accessing the database.

The user whose credentials you provide must have privileges to create and drop tables and indexes.


	
Adjust the Maximum Transaction Metrics Rows, if necessary.

In the beginning, you should probably leave this at the default setting.

This field specifies the maximum number of rows recorded in the temporary tables used for tracking individual transaction start and end messages prior to the computation of aggregated transaction measurements. Increasing the value allows the performance server to process transaction measurements more efficiently at the expense of more disk usage by the message log database.


	
You can edit advanced options by enabling the Show Advanced Options checkbox.

The following table describes the advanced options:


	Advanced Options	UI Default Setting	Description
	Indexer Tuning Parameters	-	-
	Use Auto Statistics	enabled	Boolean
If this parameter is enabled, the monitor gathers database statistics from the database on a regular basis. It is essential that up-to-date database statistics are maintained to allow message log queries to run efficiently. The statistics are gathered based on the number of inserts to the database that have occurred.


	Log Bundle Read Batch Size	300	Integer
Determines how many messages are processed by the indexer in a single database transaction.


	Indexer Wakeup Interval	10	Integer - time (in seconds)
Determines how often the indexer should wake up to check for any impending work.


	Clean Database Check Interval	120	Integer - time (in seconds)
Determines the interval at which the indexer performs various maintenance tasks. When performing maintenance, the indexer:

	
Deletes expired information from the database.


	
Cleans the summary statistics table.


	
Removes database tables which hold the result from expired cursors.





	Clean Cursors Check Interval	3600	Integer - time (in seconds)
Determines the interval at which the indexer will remove expired query results from the database.

Although this task is part of the indexer's normal maintenance, this may need to be done more often than other tasks.


	Stop Indexing	disabled	Boolean
If set to true, this option tells the indexer to suspend all activity. Content to be indexed will still be captured by active logging policies, but will not be transferred from on-disk storage into the database until indexing is resumed.

This option is especially useful during times of heavy message traffic, when optimization of resources and a steady flow of traffic is more important than being able to inspect indexed messages. You can later set the Stop Indexing value to false to allow Business Transaction Management to index the messages and enter them into your database.

Note: Be aware that during the time the indexer is suspended, Business Transaction Management does nothing to manage the disk space being used. It is up to you to make sure that there is enough empty disk space to capture messages being logged by logging policies.


	Database Error Min Delay	10	Integer - time (in seconds)
Specifies the minimum amount of time the indexer will wait before retrying logging-related database operations when a database error occurs. On each successive failure, the delay will be adjusted upward by multiplying the current delay by the value of the Database Error Delay Expansion Factor parameter. The maximum wait time between retries is bounded by Database Error Max Delay.

An example of a database error that this parameter applies to would be the monitor being unable to contact the database. For example, at the default settings, if the monitor loses its connection to the database, it will attempt to reconnect after 10 seconds. If it cannot reconnect, it will wait 20 seconds and try again, and so on. The longest it will wait between attempts is 3600 seconds (1 hour).


	Database Error Max Delay	3600	Integer - time (in seconds)
See description for Database Error Min Delay.


	Database Error Delay Expansion Factor	2.0	See description for Database Error Min Delay.
	Max Messages Indexed per Bundle Run	5000	Integer
Limits the maximum number of messages indexed for a particular endpoint on each indexer run. All endpoints in a single monitor are indexed by a single worker.


	Maximum Indexer Query Execution Time	300	Long - time (in seconds)
Specifies an upper-bound time limit on the run time of any indexer-initiated query.


	Maximum Query Execution Time	30	Long - time (in seconds)
Specifies an upper-bound time limit on the run time of any user-initiated query. Users may initiate long-running queries against the message log. Once submitted, users do not have a way to cancel the query and must wait for it to complete.

The default value for this parameter is 30 seconds. Setting this value to 0 allows all queries to run to their completion regardless of their complexity. For this reason, this setting (0) is not recommended.


	Num Indexer Worker Threads	3	Long
Specifies the number of worker threads used by the log policy indexer. The indexer cycles through the endpoints with applied logging policies and indexes each endpoint in turn. Adding threads allows for more endpoints to be indexed concurrently.


	Metadata Insert Batch Size	300	Long
Controls metadata insert statements. This parameter specifies the number of rows of a particular type to batch together before running a SQL statement. The actual batch size is also influenced by the Log Bundle Read Batch Size parameter because it sets the maximum transaction size.


	Message Insert Batch Size	30	Long
Controls message insert statements. This parameter specifies the number of rows of a particular type to batch together before running a SQL statement. The actual batch size is also influenced by the Log Bundle Read Batch Size parameter because it sets the maximum transaction size.


	Num User Query Connections	5	Long
Specifies the number of connections to the message log database that should be created for the purpose of user queries. The pool is a shared pool and consists of connections created for system processing (controlled by Num Indexer Worker Threads) and connections for user queries (controlled by Num User Query Connections).


	Reuse Tables	disabled	Boolean
The Rotation Interval setting in the Message History policy controls how long messages are retained in the database. By default, messages are deleted by deleting tables and added by adding tables. Enable this setting if you want to reuse tables rather than delete and create new tables. The tables are cleared before being reused. In most scenarios, it is more efficient to leave this setting disabled.


	Min Entries per Fragment	0	Long
Messages are stored in sets of tables, called fragments. This setting specifies a minimum number of messages a fragment must have before being rotated. This constraint is in addition to that of the Rotation Interval setting in the Message History policy. Note: a request/response pair is considered to be two messages.


	Indexer Setup Data Version	-	-
	label.IndexerSetupData.generateEndpointStatistics	disabled	In general, you should enable this field only if requested to do so by the Oracle support team.
If a monitor is managing an endpoint that participates in a transaction, then the monitor will be running the message indexer (the out-of-band indexer) for the purpose logging. When the message indexer is running in a monitor, the monitor's Status tab includes information about the performance of the message indexer. By default, the tab displays summary indexer statistics for all the endpoints for which message indexing is active. If you enable this setting, the tab's indexer statistics include detailed performance information for each endpoint participating in message indexing.








	
In the Criteria section, choose the monitors that will log to the database.




	
Note:

Take care that you do not apply more than one message log database policy to any single monitor. This means that if you are applying a new message log database policy, you must first edit the Criteria section of your existing policies so that they don't apply to the same monitors as your new policy. If you apply more than one message log database policy to a single monitor, Business Transaction Management generates a system alert.
All monitors in a monitor group must log to the same message log database.










	
Click Apply.









About Persistent Storage Directories

At initial startup, Business Transaction Management creates a set of persistent storage directories to collect system output log entries and store user preferences for the system deployments. By default, the persistent storage directories are created within the application server's installation directory at the following location:

	
On WebLogic servers:


WL_install_dir/user_projects/domains/domain_name/servers/server_name/btmstorage/*


	
On WebSphere servers:


WAS_install_dir/profiles/profile_name_name/btmstorage/node_name/server_name/*




Your company's in-house procedures and rules for persistent storage might require you to place the persistent storage directories in a different location. In such a case, you can reconfigure the location of the persistent storage directories.

An installed Business Transaction Management system is composed of a set of deployments (EAR files), which are themselves composed of subdeployments (WAR files). Each subdeployment has an associated persistent storage directory of the same name, minus the “.war”. The following table lists the names of the deployments, subdeployments, and persistent storage directories.


Table 11-2 Business Transaction Management deployments, subdeployments, and persistent storage directories

	Deployments (EARs)	Subdeployments (WARs)	Persistent storage directories
	
btmMain

	
btmui

btmcentral

btmcontainer

	
btmui

btmcentral

btmcontainer


	
btmPerformanceServer

	
btmcontainer

btmperformance

	
btmcontainer

btmperformance


	
btmTransactionServer

	
btmcontainer

btmtransaction

	
btmcontainer

btmtransaction


	
btmMonitor

	
btmmonitor

	
btmmonitor












Relocating Business Transaction Management Persistent Storage Directories

This topic explains how to change the default location of the persistent storage directories for Business Transaction Management deployments to a location outside of the container that hosts these deployments.

This topic contains the following subsections to guide you through the steps required to relocate persistent storage directories:

	
Backup Before Relocating Persistent Storage Directories


	
General Instructions for Relocating Persistent Storage Directories


	
Detailed Instructions for Relocating Persistent Storage Directories






Backup Before Relocating Persistent Storage Directories

Before following the procedure for relocating persistent storage directory locations, it is very important that you backup any persistent storage directories that already exist in the default location in your container. These default persistent storage directories are created the first time you start up your Business Transaction Management deployments, and are listed in the sections below for each container. You will later need to copy the contents of these directories to the new location you have defined for each deployment's persistent storage directory.

If you do not backup and remove the existing persistent storage directories, the settings in your new persistent storage directories might not be loaded and used the next time you restart Business Transaction Management. By default, Business Transaction Management references the default locations for the deployments' persistent storage directories. If the default directories still exist after you have set their new location, the new location might not be recognized. User preferences are also contained within these storage directories. Business Transaction Management reads these user preference files on each restart.

The default locations of the persistent storage directories are platform dependent and are as follows:

	
On WebLogic servers:


WL_install_dir/user_projects/domains/domain_name/servers/server_name/btmstorage/*


	
On WebSphere servers:


WAS_install_dir/profiles/profile_name_name/btmstorage/node_name/server_name/*




You should document where you relocate your persistent storage directories because you will have to define their location again if you redeploy Business Transaction Management applications (for example, during an upgrade). It is also important to document your new persistent storage directory locations if you want to use the LogMerger tool to collect and merge output of system log messages from these locations. It is easiest to create a configuration file for the LogMerger tool, as that will also act as a documentation source for your new persistent storage directory locations. For more about the LogMerger tool and creating a configuration file for the tool, see logMerger utility.






General Instructions for Relocating Persistent Storage Directories

The following steps outline the general instructions to relocate the persistent storage directories.

	
Shutdown your Business Transaction Management deployments.


	
Backup your persistent storage directories and place them in a safe location.


	
Modify persistent storage directory locations in each deployment's web.xml file.


	
Move backup copies of the persistent storage directories to the new persistent storage directory locations.




	
Note:

If you do not plan to use the information already collected in the persistent storage directory in the new location, you must create an empty persistent storage directory in the new location using the same name as the original storage directory.








	
Package and redeploy, if required, each deployment whose persistent storage directories you want to relocate.


	
Restart your deployments.


	
Confirm new system output log (logdir) entries in the new locations.









Detailed Instructions for Relocating Persistent Storage Directories

The Business Transaction Management deployments can be found in the following directory locations. You will need to locate these deployments in order to edit the location of the persistent storage directory in each deployment's web.xml file:

	
On WebLogic servers:


WL_install_dir/user_projects/domains/domain_name/server_name/ .wlnotdelete/extract/server_name_n_n/public/btmstorage/*


For example, the btmcentral deployment is located in this directory:


WL_install_dir/user_projects/domains/domain_name/server_name/ .wlnotdelete/extract/server_name_btmcentral_btmcentral/public/btmstorage/btmcentral


	
On WebSphere servers:


WAS_install_dir/profiles/my_profile_name/installedApps/cell/ear/war/WEB-INF/web.xml





To relocate persistent storage directories:

	
Shut down your Business Transaction Management deployments.


	
Backup the contents of the current default persistent storage directories and place them in a safe place.


	
Modify persistent storage directory locations in each deployment's web.xmlfile:

	
Locate the exploded war file for the deployment whose storage directory you want to change.


	
From the exploded war file, open the deployment's WEB-INF/web.xml file in a text or XML editor.


	
Set the new location for the persistent storage directory by setting the storageDirectory parameter value for that deployment as follows:

Edit the AmberPointDefault value in the following lines and set it to the location of the new storage directory:


<!-- PERSISTENT STORAGE DIRECTORY To set the persistent storage area to some value, change the value of param-value to some EXISTING directory where you want things stored. -->
<context-param>
<param-name>com.amberpoint.storageDirectory</param-name>
<param-value>AmberPointDefault</param-value> </context-param>





	
Note:

You must not change the names of the persistent storage directories. You may change only the path to the directories.










Examples:

	
On Windows systems – if you want the persistent storage directory for btmcentral to be in C:\btm_data\btmcentral, change the default entry within your btmcentral web.xml file to the following:


<context-param>
<param-name>com.amberpoint.storageDirectory</param-name>
<param-value>C:\btm_data\btmcentral</param-value> </context-param>


	
On Unix-like systems – if you want the persistent storage directory for btmcentral to be in opt/webserviceapplogs/btm_data/btmcentral, change the default entry within your btmcentral web.xml file to the following:


<context-param>
<param-name>com.amberpoint.storageDirectory</param-name>
<param-value>/opt/webserviceapplogs/btm_data/btmcentral</param-value>
</context-param>





	
Create the new empty persistent storage directory in the new location (if you want to start from scratch), or move the backup copy of the original persistent storage directory to the new directory location.


	
If required, undeploy and redeploy each deployment whose persistent storage directories you want to relocate as follows:




	
Note:

When repackaging system deployments, make sure to include the manifest file associated with the deployment, as this file contains important information required for deployment.







On WebLogic:

	
Package the new deployment that includes the edited web.xmlfile into a new application war file.


	
Undeploy the existing deployment using the WebLogic Console.


	
Shut down the WebLogic server and delete the original persistent storage directory.




	
Note:

You must delete the persistent storage directories from their default locations. If the deployments find persistent storage directories in their default locations, they will ignore the new directory locations.








	
Restart WebLogic and redeploy the new system deployment using the WebLogic Console.




On WebSphere:

	
Update the new deployment that includes the edited web.xmlfile using the WebSphere Console.


	
Shut down the WebSphere server and delete the original persistent storage directory.




	
Note:

You must delete the persistent storage directories from their default locations. If the deployments find persistent storage directories in their default locations, they will ignore the new directory locations.








	
Restart the WebSphere server.





	
Restart your deployments.


	
Confirm new system output log (logdir) entries in the new locations.

Data should now be written to the persistent storage directory locations you defined in each deployment's web.xml file. Check to make sure new system service log files (logdir) and other directories have been created in the new location upon container startup.

If you use the logMerger tool to merge system service logs, make sure that you refer to the new persistent storage directory locations when merging log files.













sendEventNotification

Use the sendEventNotification command to create and send an event notification using the Notifier Service. How the notification is handled is determined by the currently active subscriptions.

The system automatically generates alerts when one of the following happens:

	
An SLA enforcement policy issues a failure, warning, or compliance alert


	
A condition definition causes the Transaction Monitoring Service to issue a condition alert.


	
A system service throws an exception, causing the system to issue a system alert.




In addition to these cases, an administrator might also want to issue an alert to notify users that the system needs to come down for maintenance or upgrade, or to let users know that some administrative action will regenerate the data used to create reports. The sendEventNotification command is provided to enable this kind of notification. (It would also be possible to send an event notification using the sendToNotifier command, but it would be a lot more work.)


Command Syntax


btmcli sendEventNotification -source source -n name
                   -topic topic [-subtopic subtopic] 
                   -severity SEVERE | WARNING | INFO | CONFIG | FAILURE | SUCCESS 
                   -message message
                   [-attributes name1:value1 [[name2:value2] ...]] 
                   -s sphereUrl -l username:password



	Name	Long Name	Description
	-source	--	Indicates where the notification was generated. Possible sources include ASLM, ExM, and System. You can specify an arbitrary value.
	-n	-name	The name associated with the event notification. This should provide information as to what the event is about.
	-topic	--	The event notification's topic. Used to help categorize similar event notifications.
	-subtopic	--	The event notification's subtopic. Used to help categorize event notifications.
	--	-severity	Indicates the importance of the situation that caused the notification.
	-message	--	A textual description of what the event notification means and whether any user action is required.
	--	-attributes	A list of name:value pairs that will be attached to the event notification and made available to anyone who receives the notification. These attributes typically reference objects related to the notification.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the sendEventNotification command used to notify current subscribers that the system is about to be backed up.


btmcli sendEventNotification -source System -n BackupWarning 
               -topic SysNotifications -severity WARNING
               -message "System backup in 10 minutes. Please save your work."
               -s http://localhost:8080/btmcentral/sphere/
               -l admin:abracadabra






Setting up Load Balancers

Setting up load balancers allows Business Transaction Management to model the flow of traffic correctly and allows you to access the load balancer's administrative console from the Business Transaction Management console.

This section also explains how you set up an F5 device to load balance messages from one observer to multiple monitors. It includes the following sections:

	
Setting up a Load Balancer


	
Registering an F5 Network Device


	
Configuring an F5 Device to Work with Replicated Monitors






Setting up a Load Balancer

If you deploy a service in more than one container, Business Transaction Management understands these replicated endpoints are part of the same service, and it can infer the existence of a load balancer that routes messages to these replicated endpoints. That is, Business Transaction Management can model the flow of traffic correctly in dependency diagrams even though it does not monitor the flow of traffic through the load balancer itself. However, without your help, Business Transaction Management cannot provide more detailed information about the inferred load balancer. Setting up a load balancer means giving Business Transaction Management information that allows it to do the following:

	
provide information about the load balancer in the management console; for example, the name you want displayed for it and the vendor associated with it


	
identify the device hosting the load balancer


	
give you easy access to the load balancer's administrative console


	
specify the lifecycle phase of the load balancer device and all the endpoints that are created within it




Setting up a load balancer starts with registering it, which you can do using either the CLI command registerDevice or using the management console. In some cases, you might also need to specify an entry point to the load balancer and define target entry points that correspond to the destinations where messages are being routed.

This section explains some basic terms related to load balancing, describes the devices that Business Transaction Management supports, and explains the following user tasks:

	
Registering a load balancer


	
Modifying information about a load balancer


	
Adding entry points to show routing relationships


	
Unregistering a load balancer




Business Transaction Management supports a variety of load-balancing devices. It provides the greatest support for F5 load balancers, but it can also recognize and model other hardware and software load balancers.


Basic Terms

The figure below illustrates the use of a load balancer to route messages A and B to three replicated endpoints (E1, E2, E3). Note the elements marked: routing entry point and target entry point. The load balancer receives messages at the routing entry point and forwards them to the target entry points. There are situations in which you might have to supply entry point information after registering the load balancer, as described in the next section.

[image: Description of basic_load_balancing.gif follows]









Supported Devices

Business Transaction Management can work with three kinds of load balancers: F5 devices, other hardware devices, and software load balancers. The work you need to do to help Business Transaction Management model message traffic varies with each case:

	
Business Transaction Management knows the most about the F5 device and requires only a single registration step to derive the information it needs. Business Transaction Management might perform additional discovery passes to complete its picture of an F5's role in message routing.


	
For hardware load-balancers, Business Transaction Management can usually detect and model any routing entry points automatically, based on the information in the HTTP Host headers of the observed messages. However, explicitly registering the device (using the CLI command registerDevice or using the management console) allows Business Transaction Management to display information about the device's location and other attributes.

If you do not register any device, Business Transaction Management automatically registers a default load balancer and is able to model the flow of messages through this device. In this case, you can still edit the Profile page for the default load balancer to specify a name, the base address, admin UI, and vendor.

If the observed messages do not carry information about their original recipient (the load balancer) in the HTTP Host headers, you will need to register the device and specify routing and target entry points in the same way as you do for software balancers, described next.


	
For load balancers implemented by software that make a separate HTTP connection to the back-end servers (rather than just forwarding HTTP messages), you need to describe the routing relationships in order for Business Transaction Management to model them correctly. To do this you must register the device, add an entry point for the load balancer, and specify target entry points that correspond to the destinations where messages are being routed.








Default Load Balancer

The default load balancer is either the first load balancer registered or the one you set to be the default using the setDefaultLoadBalancer command.

The calling service uses a routing entry point to communicate with the load balancer. Business Transaction Management discovers the routing entry point by observing messages. If no load balancer has yet been registered, Business Transaction Management creates a default load balancer and assigns the discovered routing entry port to it. Any newly discovered routing entry points will be modeled as part of the default device unless they belong to a registered F5 load balancer.

You can edit the profile of the default load balancer that was created for you, to provide additional details or, if you prefer, you can unregister it and register your actual load balancer explicitly.





Registering a Load Balancer Using the Management Console

You can register a hardware or software load balancer using the CLI command registerDevice or using the console.

After you complete the registration, the device is listed in the summary pane when you select Explorer > Devices in the navigator.

To register a hardware or software load balancer using the console:

	
Select Admin > Register > Device and then choose F5 Networks to register an F5 load balancer, or choose Other to register any other load balancer.


	
In the ensuing dialog, specify values as shown in the following table.


	Field	Description
	Vendor	Not editable for F5; required for other load balancers.
If you chose F5 Networks in Step 1, this field is set to the non-editable value of F5.

If you chose Other, specify the name of the vendor of your load balancer. This field is purely descriptive. You can specify any value (except F5). The specified value is displayed in the Management Console.


	Device Name	Required.
Specify the friendly name for your load balancer. This name is displayed in the Management Console.


	Notes	Optional. Add any notes to remind you of the nature or purpose of this load balancer.
	Lifecycle phase	Select the lifecycle phase from the drop-down list. Available values are deprecated, development, production, staging, and test. These are case insensitive.
	Configuration URL	Required and displayed only if you chose F5.
Specify the URL of the F5 console in the following format:

https://managementPortIP/iControl/iControlPortal.cgi

Replace managementPortIP with the appropriate host name and port number. This URL normally ends with iControl/IControlPortal.cgi.


	Username and Password	This value is required and displayed only if you chose F5 Networks.
Specify the user name and password of an account on your F5 load balancer. A user role of Guest provides sufficient privileges.

You can encrypt passwords using the encryptPassword CLI command, for example:

btmcli encryptPassword -password "myPassword"


	Base Address	Required and displayed only if you chose Other.
Specify the base address of the URL for your load balancer, for example:

https://myLoadBalancer:443/


	Administrator URL	Optional and displayed only if you chose Other.
Specify the URL of your load balancer's HTML administrative console. A link to this URL is displayed in the Business Transaction Management Management Console to provide easy access to your load balancer's console.

This flag is not needed for F5 load balancers because Business Transaction Management obtains the URL automatically.








	
Click Apply.


	
If needed, assign routing entry points and target entry points as described in the Adding Entry Points to Show Routing Relationships.








Modifying Information About a Load Balancer

You can modify information about a device you have already registered or about a default device.

To modify information about a device:

	
Select Explorer > Devices from the navigator.


	
In the summary area, select the device whose attributes you want to specify or edit.


	
Select Modify > Edit Profile for deviceName.


	
Modify the fields of interest (as described when registering the device) in the ensuing dialog.


	
Click Apply.









Adding Entry Points to Show Routing Relationships

In most cases, Business Transaction Management automatically detects and models routing relationships by observing message traffic and reading destination information from the message headers. However, if the observed messages do not carry information about their original recipient (the load balancer) in the HTTP Host header, you will need to manually create a routing entry point to the load balancer. You will also need to add target entry points to indicate where the messages are being routed.

If you do not specify routing relationships, Business Transaction Management will not be able to draw contiguous dependency flows. In the case of transactions, you could still connect these disjoint flows by linking related services using manual keys.

To add routing entry points and target entry points:

	
Select Explorer > Devices from the navigator.


	
In the summary area, select the device whose routing relationships you want to clarify.


	
Select Create > Entry Point for deviceName.


	
In the ensuing Create Entry Point tool, specify the following information: --In the Hosted on section, specify the IP address and port number where the load balancer is receiving observation messages (the HTTP port). -- Click the Add Target Entry Point and choose a destination from the drop down list. Each destination refers to a target entry point where the load balancer is routing messages. Do this for each potential destination.Note: There will be more entry points on the drop-down list than the router is using. Some of these might be addresses to which another load balancer is sending messages. (Basically, the drop down list shows every entry point known to the sphere.)


	
Click Apply.








Unregistering a load balancer

You can only use the management console to unregister a load balancer.

To unregister a load balancer:

	
Select Explorer > Devices from the navigator.


	
In the summary area, select the name of the device you want to unregister.


	
Select Modify > Delete deviceName Registration


	
Confirm deletion action by clicking Delete in the next dialog.











Registering an F5 Network Device

Registering an F5 network device allows Business Transaction Management to read F5 configuration information and to model that device (its entry points and the routing policies applied to them) in the management console. You can only register devices that are running iControl v9.x software.

Before you register the device, select Administration > System Services from the navigator, and check the services listed to make sure that the F5 Intermediary Adapter service is up and enabled.

To register an F5 Network Device

	
Select Admin > Register > Device > F5 Networks.


	
Specify a name for the device. This name will be used to identify the F5 device in the Explorer > Devices view that you can access from the navigator.


	
Add any notes to identify the device or what use you intend to make of it. These notes will appear in the Profile tab for the device after it has been registered with the Sphere.


	
Select the life cycle phase of your deployment from the drop list. Values include Deprecated, Development, Production, Staging, Test, and Unknown. These values are not checked or enforced in any way; they are available only to help you organize your work.


	
Specify the URL for the F5 console as illustrated in the following example


https://ManagementIP/iControl/iControlPortal.cgi 


for ManagementIP specify the IP address of the management port your BIG-IP Load Balancer is configured to listen on.


	
Enter the user name and password for the administrator's account of the F5 device.


	
CLick Apply.


	
To view device information, select Explorer > Devices in the navigator.




You can also use the CLI command registerDevice to register an F5 network device.






Configuring an F5 Device to Work with Replicated Monitors

Monitoring in Business Transaction Management relies on the communication that takes place between an observer that monitors message traffic through a given service and a monitor that analyzes and stores the data obtained by the observer.

To scale your system and make it fault tolerant, you can associate several replicated monitors (monitor group) with observers. Replicated monitors require a third-party load balancer that can route messages from observers to the monitors. This section explains how you set up an F5 device to load balance messages from an observer to two or more monitors.

In order to understand F5 setup, it is helpful to review the mechanism that allows an observer to communicate with a single monitor; this is illustrated in the following figure:

[image: Description of single_monitor.gif follows]




As shown in the figure, communication between the observer and the monitor proceeds by means of two paths:

	
The observer queries the monitor for configuration information and receives that information from the monitor's HTTP port. (Although configuration data is mostly flowing from the monitor to the observers, the connection is made by the observer.) This port is specified using the AP_NANO_CONFIG_URL Java system property or using the AmberPoint:NanoConfigRL Windows key, depending on the platform. The sample URL shown in the figure is MyApSvr:8080/apmonitor/agent/agent. When the observer starts up, it sends a request to this URL to get configuration information, which tells it what it should measure and how often. In this way, the observer can be reconfigured dynamically as your need for different kinds of information changes.


	
The observer sends measurement data to the monitor at the socket port specified in the Observer communication policy. By default, this port is 36963.




When you set up communication between your observers and replicated monitors by way of an F5 device, the device must be configured to include these same two (configuration and data) paths for every replicated monitor you add. The next figure shows how the F5 device connects an observer with the replicated monitors.

[image: Description of replicated_monitors.gif follows]




Creating a scheme like the one above involves configuring the F5 device, setting the Java system property or Windows key, and defining the observer communication policy for the replicated monitors.

When you set up the F5 device, you must use the admin console for that device to do the following:

	
Create an HTTP virtual server to be used by the observer to get configuration information. This is shown at port 5060 above.

Assign a pool to the HTTP virtual server with member port numbers that correspond to the HTTP ports of the monitors to which you are connecting. As illustrated, the pool for the HTTP virtual server includes ports 11080 and 11081.


	
Create a socket virtual server to be used by the observer to send data to the socket ports of the monitors. This is at port 5061 above. Assign a pool to the socket server with member port numbers that correspond to the socket (data) ports of the monitors to which you are connecting. As illustrated, the pool for the socket virtual server includes the ports at 36330 on each host machine.




When you set the AP_NANO_CONFIG_URL Java system property or the AmberPoint:NanoConfigURL Windows key, you must provide a value like the following:

http://10.147.46.152:5060/btmmonitor/agent/agent/

Note the bold portion of the URL: it is the IP address of the F5 device (host) and the virtual sever HTTP port. (Of course, these numbers will be different for your deployment.)

The values you specify for the observer communication policy correspond to the values defined for the F5 device as follows:


	Observer communication policy (Through router to monitor group)	F5 device values
	Router IP address	The IP address of the F5 device. With reference to the figure, this would be 10.147.46.152.
	Router port number	The virtual server socket number. With reference to the figure, this would be 5061.
	Monitor port number	One of the pool member ports. With reference to the figure, this would be 36630.
If, for some reason, the replicated monitors are located on the same machine, the port numbers for each monitor would be different, and you would need a different observer communication policy for each monitor.








It does not matter whether you define the observer communication policy first and the F5 second. What matters is that the socket ports assigned to the monitors correspond to those defined for the virtual server socket pool in the F5 device.

This section assumes that a certain amount of work has already been done to deploy and register the replicated monitors and to create the monitor group. Consult the Business Transaction Management Installation Guide for information on how to do this, and on how to define the observer communication policy.








putSetupData

Use the putSetupData command to read the setup file from standard input or a supplied input file and to save it as the setup data for the specified system service.

See Backing up and Restoring Business Transaction Management, for a discussion of the use of this command in backing up the system.


Command Syntax


btmcli putSetupData -e endpointUrl [-i inputFile] 
                    -s sphereUrl -l username:password



	Name	Long Name	Description
	-e	-endpointUrl	The URL of the system service.
	-i	-inputFile	The name of the file from which to get input.
	-s	-sphereUrl	The URL of the sphere where the service whose data you want to read is installed.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following examples show files written as the setup file for another service at the specified endpoint.


cat myFile | btmcli putSetupData -e myServiceEndpoint

btmcli putSetupData -e myServiceEndpoint -i myInputFile






About Consumers

In addition to presenting performance results based on the performance of individual transactions, services, and endpoints, Business Transaction Management allows you to view performance results in terms that are meaningful to your business. You can see transaction performance segmented by business criteria: your suppliers, your users, your re-sellers, or your customers. And you can see this information even in those cases when the object of interest participates in a series of different transactions. To this end, Business Transaction Management provides a consumer business object that you can define to segment performance data using the criteria that is important to you. You can then monitor your business objects to make sure that your objectives are being met. For example,

	
You can view custom graphs showing performance segmented by a given consumer.


	
You can have Business Transaction Management generate alerts when the performance of your system for a given consumer does not meet the targets you define.




Consumers refer to Business Transaction Management consumer business objects; a consumer is an instance of the Consumer business object you have defined for your environment. The default name "Consumer" implies that this business object could be the initial client of a transaction; but it could also be the country or city where an order originates, a company name, and so on. Throughout this section, we will use the default name "consumer," with the understanding that this can refer to the wider range of criteria just mentioned.

To make the actual segmentation criteria more clear, the Business Transaction Management administrator can customize the consumer label that appears on fields, buttons, and links in the Management Console. For example, your administrator could change the label from "Consumer" to "Department", "Supplier", or any other descriptive term.

The following sections explain how you set up consumers:

	
Setting up Consumer Segmentation


	
Creating Consumers


	
Changing the Default Consumer Name






Setting up Consumer Segmentation

In the simplest case, to obtain performance segmentation by consumer, you must do the following:

	
On the start operation for a transaction, create a property whose value is the request message element that uniquely identifies the consumer. It could be an ID number, a social security number, a name, or an email address. If the consumer is not a person, it could be a company name, a code identifying the company, and so on. (The information you choose to supply for the property value can be based on a single message element, an xpath expression, or content in the message header.)


	
Map this property to the consumer attribute on the consumer business object. This mapping process is called mapping messages to consumer.


	
Enable consumer segmentation in your transaction definition.




The figure below shows a simple mapping between a property called email (associated with the request.submit.order.customerEmail element of the starting message of a transaction) and the default attribute of the business object, Consumer Name.

[image: Description of simple_bus_obj.gif follows]





If consumer segmentation is enabled for the transaction, once traffic starts to flow, Business Transaction Management inspects the value of the email property of this transaction as part of its measurement gathering. For this example, let's assume the property value is 123hop@gmail.com:

	
If it finds an existing consumer whose name is 123hop@gmail.com, it records measurements for that consumer.


	
If it does not find a consumer of that name, it creates the consumer, assigns it the value of the property as its name, and records measurements for it.




The business object that Business Transaction Management provides by default is adequate for the simple case where you are monitoring one specific kind of consumer and you are satisfied to use the value of the property as the consumer name. In reality, you might need to handle more complicated situations. To do that, you can customize the definition of the consumer business object by adding custom attributes. Using these attributes, you can teach Business Transaction Management to recognize the same consumer though the consumer is identified by different properties.

For example, what happens if we want to monitor several transactions, and in each transaction the consumer of interest is identified in a different way? In one transaction, the consumer is identified by email address, and in the other, by a social security number.

The following figure shows two transactions, Tx1 and Tx2. Tx1 has a customerEmail element mapped to the email property; Tx2 has a custID element mapped to a SSNumber property. You want Business Transaction Management to monitor both transactions and to recognize that the same consumer is involved whether that consumer is identified by the email property or by the SSNumber property. To do this, you must add two custom attributes to the Consumer business object and map each property to its corresponding attribute.

[image: Description of complex_bus_obj.gif follows]





For the sake of this example, let us assume that all consumers involved in these transactions have already been created. Once traffic starts to flow, Business Transaction Management inspects the value of each of the properties shown as it observes messages. If it encounters either an email address or social security number associated with an existing consumer, it records measurements for that consumer. This makes it possible to see performance information for a given consumer that is an aggregate of performance across all the transactions in which the consumer participates.

In this more complicated case, setting up consumer segmentation would involve the following:

	
Add custom attributes to the consumer business object that will correspond to the properties you will create in Step 2.


	
For each transaction you want to segment by consumer: Create a property whose value is the request message element that uniquely identifies the consumer.


	
Map each property to its corresponding business object custom attribute.


	
Enable consumer segmentation in your transaction definition.




(You can do steps 2-4 all at once when you define consumer segmentation for a transaction.)






Creating Consumers

Business Transaction Management creates consumers in one or more of the following ways:

	
If you have set up consumer segmentation, Business Transaction Management automatically creates a consumer whenever it encounters a message for a consumer that does not already exist.


	
According to the information you provide when you choose Create > Consumer and supply values for the consumer name and attributes.


	
According to the information you provide using the importBusinessObject command.




If you create consumers manually, as with the last two options, consumer monitoring will only start after you set up consumer segmentation.






Changing the Default Consumer Name

By default, discovered consumers are named according to the value of the message property to which you map them. For example, if you use a property that holds an email address, the name of the consumer displayed in the Management Console is the email address of the consumer. If the value of the property is the user's full name, that name is displayed in the Management Console. You can edit the name that will be displayed for a consumer by editing the consumer profile. If you see a combination of formats used to display user names, this might result from the fact that some were created manually (and assigned an actual name) and others were added automatically and assigned the value of the property used to map messages to consumers.

If you decide that you want to change the default consumer name, please note that you must add an attribute to the business object that corresponds to the property used for segmentation and that you must then map the property to that attribute. In the following illustration, an Email custom attribute is mapped to the email property. If you then change the default consumer name to an actual name (by editing the consumer profile), Business Transaction Management will continue to gather measurements for this consumer when it sees the message and evaluates the email property, but it will display the name you supply in the main pane of the Consumers view and in the Name field of the Profile tab for the consumer.

[image: Description of simple_bus_obj_attr.gif follows]











10 Utilities

This chapter describes the Business Transaction Management utilities. You use these utilities to connect to and manage a database, to manage system service deployment log files, and to display information about the Business Transaction Management product. This chapter includes the following sections:

	
About Command Line Utilities


	
datastoreUtil utility


	
logMerger utility


	
showProductInfo utility







SLA Compliance Tab

The SLA Compliance tab displays the current state of SLA compliance for the selected object, either a transaction, service, endpoint, operation, or consumer. Because some types of information are relevant to only certain types of objects, the layout of the Compliance tab can vary from object to object.

The SLA Compliance tab has two subtabs, Threshold Compliance and Baselines.

	
The Threshold Compliance subtab provides real-time monitoring of the selected object.


	
The Baselines subtab displays historical baseline values for the object that you can use as a reference point. Data is shown only if you have defined baselines for the selected object. (For more information, see Defining a Baseline SLA.)




There are no baselines for consumers. The information that is displayed on the Threshold Compliance subtab for other object types is displayed directly on the SLA Compliance tab for consumers. This information is described below.

The Threshold Compliance subtab uses a grid view. Each row represents one performance objective.

The columns provide various types of static information that identify and define the objectives. Also provided are two dynamic columns with real-time monitoring values. These are the Value and the Current Status columns.

The Current Status column can have three possible values:

	
A green circle indicates that the object is in SLA compliance.


	
A yellow triangle indicates that the warning threshold for the objective is currently in violation.


	
A red diamond indicates that the failure threshold for the objective is currently in violation.




The Value column displays the current value of the instrument on which the objective is based

Click the magnifying glass next to a value to pop up a chart showing the instrument's recent history, for example:

[image: Description of pop-up_chart_with_callouts.gif follows]




The chart displays a time period equal to the SLA's evaluation period. The right-hand edge is the current time. In this example, values above the yellow line have crossed the warning threshold. Those above the red line have crossed the failure threshold. (If you set up an objective whose value must remain above a specified threshold, then colored warning and failures areas are displayed below the threshold lines.)

Objectives are listed per consumer only if the objective is part of a usage SLA. For objectives that are not part of a usage SLA, the Consumer column is empty.






configureAlivenessCheck

Use the configureAlivenessCheck command to specify whether the sphere checks the aliveness of containers or endpoints and the preferred method for doing so.


Command Syntax


btmcli configureAlivenessCheck -baseAddress baseAddress | -e epUrl1 [[epUrl2]...]
                               -method standard | skip | getwsdl |geturl | ping
                               [-alternateUrl alternateUrl]
                               [-endpointDreds username:password]
                               [-pingHostPort host:port]
                               -s sphereUrl -l username:password
                               



	Name	Long Name	Description
	-baseAddress	--	The base address for which to configure aliveness check. The effect of this flag depends on the setting of the -method flag:
If -method is set to standard, geturl, or ping, the base address is tested only once and all endpoints under this base address inherit its aliveness value.

If -method is set to getwsdl, each endpoint with the specified base address has its WSDL fetched.

If -method is set to skip, no aliveness checking is performed for this base address, but endpoints with this base address might be checked individually if specified with the -e or -alternateUrl flags.


	-e	-endpointUrl	One or more endpoint URLs for which to configure aliveness checking. All endpoints with the given URLs are configured identically.
	-method	--	The method to be used for aliveness checking. Choose one of the following: standard: open and close a socket to the given host:port
skip: do not check aliveness

getwsdl: do an HTTP GET on the endpoint's WSDL

geturl: do an HTTP GET on the given url

ping: do a TCP ping on the host and port specified with the -pingHostPort flag.

See below for more details.


	-alternateUrl	--	The URL to use in place of the base address or endpoint URL. This flag is required when the geturl method is used.
	-endpointCreds	--	Authentication credentials (username:password) to use when fetching the alternate URL for an endpoint. It is ignored for any other configuration.
	-pingHostPort	--	The host and port to ping in place of the actual base address of the endpoint URL. This flag is required only when the method ping is specified.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on the various options available for furnishing login credentials.

You can encrypt passwords using the encryptPassword command.








Choose the method that best suits the endpoint you are monitoring. For example, for WebLogic JAX_RPC or JAX-WS services, fetching the generated WSDL will succeed if the container is up and the service is deployed and running, so it is as good an aliveness check as actually calling the service without the inconvenience of having a sample message to send that is both valid and harmless. The advantage of the getwsdl method compared to the arbitrary http fetch (geturl) is that you can specify it at the base address level and get the effect of configuring the aliveness check for every endpoint in that base address to fetch its own wsdl without running a separate configureAlivenessCheck command for each of them. However, there are possible disadvantages:

	
loss of efficiency (WSDL may be large and generating it resource-intensive)


	
inappropriate for endpoints registered from a copy of the WSDL that was hand-created and/or copied from another server, since you are then checking the aliveness of that HTTP server instead of the endpoint


	
inappropriate for observer-discovered endpoints whose WSDL is saved as text in the sphere, since you are then checking the aliveness of the sphere.





Examples

The following example shows the configureAlivenessCheck command with the getwsdl method for performing the aliveness check.


btmcli configureAlivenessCheck -baseAddress http://jbujesPC:8080 -method getwsdl
                  -s http://localhost:8080/btmcentral/sphere/ -l admin:abracadabra






About Alerts

In addition to ongoing monitoring of the performance of services, endpoints, and transactions, you can have Business Transaction Management alert you when specific events occur.

Business Transaction Management issues several types of alerts:

	
Service level agreement alerts (also called violation alerts and SLA alerts) are issued when a deviation occurs from the standards of performance you have defined for an endpoint, service, or transaction. These standards might be based on fixed values or historically determined baselines.

You define standards of performance using one or more service level agreement policies that you then apply to an endpoint, service operation, or transaction.

SLA violation alerts can be queried, filtered, and viewed on the Alerts tab of the related service, endpoint, operation, or transaction instance. SLA alerts in the last hour are displayed using the Alerts in the Last Hour > SLA Alerts view (from the Navigator). Alerts are also displayed on the operational summary dashboard.

In this case, when performance deviates from the Warning Value threshold set in an SLA policy, a warning alert is issued, and when it deviates from the Failure Value threshold set in an SLA policy, a failure alert is issued. The Warning Value is optional.


	
Condition alerts are issued when a condition is satisfied.

A condition is created on a transaction and is based on evaluating messages and message content per transaction instance.

Condition alerts can be queried, filtered, and viewed on the Alerts tab of the related transaction instance. Alerts issued in the last 24 hours can also be filtered and viewed using the Alerts in the Last Hour > Condition Alerts view (from the Navigator). The dashboards include various condition alert counts.

You might define conditions to enable fault monitoring on transactions, to test for specific property values, or to report a missing message.


	
System alerts provide information about the health of the monitoring infrastructure. Business Transaction Management issues system alerts in situations such as the occurrence of a fatal error, a container going down, the rejection of a policy, deletion of an attribute that is in use, and so forth.

To check for system alerts, do one of the following:

	
Select Alerts in the Last Hour > System Alerts in the Navigator.


	
Select Administration > System Policies in the Navigator and then click the Alerts tab.












About the Command Line Interface (CLI)

The Business Transaction Management Command Line Interface (CLI) allows you to issue management commands from the command line or through the use of scripts (in bash, perl, ruby, DOS). You can use the CLI from the Unix and DOS command lines, and any other environments that work with your Business Transaction Management installation.

CLI commands allow you to configure the system, manage DNS aliases, resolve replication issues, register services, manage metadata, control monitoring, apply policies, migrate data, or generate data needed for reporting.

The CLI executable (btmcli.bat on Windows and btmcli.sh on Unix-like systems) is located in the BTM_Install_Directory/tools directory. On Windows platforms, the CLI uses the JRE bundled with Business Transaction Management. On Unix-like systems, you must specify a JRE to use by doing one of the following:

	
set the JAVA_HOME environment variable and remove the BTMi_nstall_dir/_server/jre directory


	
replace BTM_install_dir/server/jre with a link to a valid JRE directory




There are several command line utilities for performing additional actions. See About Command Line Utilities for more information.



Getting Help and Version Information

To get a list of all CLI commands with a brief help summary, enter the following command:


C: > btmcli help


To get detailed help for an individual command, enter a command like the following:


C: > btmcli help commandName


To get version information, use the following command:


C: > btmcli -v






Executing CLI Commands and Scripts

You can execute a Business Transaction Management CLI command or script in any command shell using the following syntax:

btmcli commandName commandFlags

To execute a single command, specify the command and its parameters at the command prompt. For example:


C: btmcli encryptPassword -password "abracadabra"


To execute a script, specify the name of the script at the command prompt. For example:


C: > myBTMScript.cmd


	
The script can contain any Business Transaction Management CLI commands.


	
The name of your script file should have an extension that is appropriate for your operating system (.cmd, .bat, .sh).


	
Script comments should be formatted as appropriate for your operating system.


	
The script can make use of the environment variables described in Environment Variables.









Security Options in Accessing CLI Commands

Nearly all CLI commands require that you provide a credential in the form of username:password to execute the command.

You can provide this credential in one of two ways:

	
Using the -l flag to the command.


	
Setting the AP_USER_LOGIN environment variable to the value of the credential. In this case, you do not have to specify the -l flag.




Whether you use the -l flag or the environment variable, you can specify the credential in one of two ways:

	
by providing the user name and password directly when you enter the command, or by setting the AP_USER_LOGIN environment variable to that username:password value.


	
by creating a username:password credential in a credential store, and passing the credential name to the command or by setting the AP_USER_LOGIN environment variable to the value of that credential name.




The following examples use the btmcli configure command to illustrate each case:

	
In the following command, the -l flag is used to specify a user name and password.


btmcli configure -i myConfigureFile -s http://uitst3:8080/btmcentral/sphere/
-l joanna:abracadabra


	
In the following command, no -l flag is specified because the AP_USER_LOGIN environment variable has been set to joanna:abracadabra.


btmcli configure -i myConfigureFile -s http://uitst3:8080/btmcentral/sphere


	
In the following command, the credential JoannaCred has been defined by thecredStoreTool command as follows:


btmcli credStoreTool -createCred JoannaCred -credType up
-credValue joanna:abracadabra


The configure command will then look like this:


btmcli configure -i myConfigureFile -s http://uitst3:8080/btmcentral/sphere/
-l JoannaCred


	
In the following command, the credential JoannaCred has been defined by the credStoreTool command as follows:


btmcli credStoreTool -createCred JoannaCred -credType up
-credValue joanna:abracadabra


The AP_USER_LOGIN environment variable has then been set to JoannaCred=joanna:abracadabra. The configure command will then look like this:


btmcli configure -i myConfigureFile -s http://uitst3:8080/btmcentral/sphere/









Command Summary

The following table lists CLI commands in alphabetical order and provides a summary of the command action.


	Command Name	Description
	addBaseAddressAlias
	Add the specified alias for the entry point with the given base address. If another entry point with this alias as its base address is already known to the sphere, the two entry points and their contents are merged, and duplicate WSDLs and endpoints are removed.
	addNodeAlias
	Add network aliases to an already registered node.
	addPathAlias
	Use the addPathAlias command to add an alias representing an alternative URL path that can be used to access the specified WSDL or endpoint. Specifying this alias can help prevent duplicate artifacts from being created during discovery.
	configure
	Read a configuration xml file and use the information to configure the installation associated with the given sphere URL.
	configureAlivenessCheck
	Specify the preferred method for the sphere to check the aliveness of endpoints, rather than using the default ping.
	createOrUpdateGenre
	Specifies the name of a new service or endpoint genre, and identifies a custom icon to be used in representing the new genre.
	createOrUpdatePolicy
	Create or update the specified policy directly in the sphere.
	createSettingsDocument
	Use the createSettingsDocumentcommand to create a settings document for input to the createOrUpdatePolicy command.
	credStoreTool
	Creates, obtains, or deletes the specified type of credential from the credential store.
	encryptPassword
	Convert the specified text string using the Business Transaction Management encryption engine. The resulting cipher text appears in the command output.
	exportBusinessObjects
	Create a settings document for input to the createOrUpdatePolicy command.
	exportMessages
	Export messages for an endpoint for a specified period of time. Exporting messages can be useful in testing and debugging.
You have the option of exporting messages to a file; whether you do or not, output is always sent to the Console.


	exportPolicies
	Export the specified policies either to stdout, or to the named output file. Policies can be exported by name, type, or by means of a query that defines a set of policies.
	exportPolicyTemplates
	Export the specified policy templates either to stdout, or to the named output file. Policies templates can be exported by name, type, or by means of a query that defines a set of policies.
	exportProfile
	Export the profile values for the specified object(s) either to stdout, or to the named output file. Profiles can be exported by name or id.
	btmcli exportSchedules
	Export schedules from the target sphere. You can output the schedules to a file or to stdout. Schedules can be exported by name or by means of a query that defines a set of policies.
	exportTransactionDefns
	Export the specified transaction definitions. If you do not specify an output file, the definition is sent to stdout.
	generateMonitoringScript
	Generate a batch script that you can use later to recreate the system's current monitoring state.
	getSetupData
	Write the setup file for the specified service to standard output. You can use this setup file as input for the putSetupData command.
	importBusinessObjects
	Import one or more of the specified business objects described by the specified XML file into the target sphere. By default, this command replaces all existing objects that are older than the imported objects.
	importPolicies
	Import the policies contained in a previously created export file. The policies to be imported will be taken from the file specified by the -i parameter, or from stdin, if no such file is specified.
	importPolicyTemplates
	Import the policy templates contained in a previously created export file. The policy templates to be imported will be taken from the file provided by the -i parameter or from stdin if no such file is specified.
	importProfile
	Import a previously exported object profile into the system. Note that importing a profile does not cause new objects to be created, it only updates the profile attributes of existing objects.
	importSchedules
	Import previously exported schedules to the target sphere. By default, this command replaces all existing schedules that are older than imported schedules.
	importTransactionDefns
	Import previously exported transaction definitions to the specified sphere. By default, this command replaces all existing definitions that are older than imported definitions.
	listInstruments
	List the instruments defined by the policy templates in the system, as well as the attribute names and segments for each. You can use this information as arguments for the retrieveObjectData command.
	listNodeAliases
	List all the aliases for a single network node, or for all known network nodes.
	mergeServices
	Merge two versions of the specified service. This command removes the source version and moves its endpoints to the target version.
After the merge, the target version contains all the endpoints from both versions. If the source version has any profile attributes or message properties that you want to retain for the merged versions, you must recreate these on the target version.


	monitorEndpoint
	Monitor the specified endpoint with the monitor agent where it is registered.
	moveEndpoints
	Move one or more endpoints from the source version to the target version of the specified service.
	moveMeasurements
	Move the measurements collected for a service or endpoint that has been deleted from the sphere to another endpoint or service that is its logical successor.
	putSetupData
	Read the setup file from a named file or from standard input and save it as the setup data for the specified service.
	register
	Register the services (found within the specified WSDL file) with the sphere and write the location URLs of the WSDL's service endpoints to standard output. This command produces the same output if the WSDL is already registered with the sphere.
	registerDevice
	Register a management device with the sphere. Currently, hardware and software load balancers are the only supported device type, and the F5 BigIP is the only fully-supported load-balancer.
If you register multiple devices, you can use the setDefaultLoadBalancer command to set the default device.


	registerExternalContainer
	Group the endpoints of one or more entry points (not part of an observed container) into their own external container. This is only necessary for manually-registered endpoints.
	registerMonitor
	Register a monitor agent with Business Transaction Management.
	removeBaseAddressAlias
	Remove the specified alias to the entry point with the given base address. The alias must be defined locally for this entry point only. Aliases defined at the network node level must be removed using the removeNodeAlias command.
	removeDuplicateEndpoint
	Remove the specified duplicate endpoint. Typically, you would use this command when the system discovers two endpoints with the same path but different host names due to a DNS alias that was not known to the system. Executing this command also adds the missing alias to make sure that future discoveries do not result in recreating the duplicate endpoint.
	removeNode
	Remove a network node from the sphere.
	removeNodeAlias
	Remove aliases from a registered node.
	removePathAlias
	Remove an alias representing an alternative URL path that can be used to access the specified WSDL or endpoint. Any future registration or discovery will again treat the two paths as distinct.
	removePolicy
	Remove an applied policy and optionally wait for the removal of the policy to complete.
	removePolicyTemplate
	Removes the specified policy template from the system.
	renameEndpoint
	Change the specified endpoint's friendly name in the sphere.
	resetSphereUrl
	Make sure the sphere URL for container services currently registered with this sphere matches the current sphere URL. You might need to use this command if the base address of the sphere changes.
	retrieveObjectData
	Retrieve profile and measurement data for one or more objects. You can use this data as input to a reporting tool.
	sendEventNotification
	Create and send an event notification using the Notifier Service. How the notification is handled is determined by the currently active subscriptions.
	sendToNotifier
	Send commands to the Notifier Service for processing. The commands are specified in the XML input file. The command returns the response document returned by the Notifier Service.
	setBaselines
	Set baselines for managed objects. The input document format is the same as the output of the retrieveObjectData command.
	setDefaultLoadBalancer
	Set the default device used to model routing entry points discovered from observed message traffic.
In a simple environment with only one known load-balancer, that device is automatically used as the default. If you register additional devices, use this command to set which device should be used to model routing entry points.


	showService
	Show the structure of the service specified by the friendly name, qualified name, or URL of any endpoint for this service. You can also specify a single version of the service (-version) or the display of more detailed information (-verbose).
	unmonitorEndpoint
	Stop monitoring the specified endpoint with the monitor agent where it is registered. Once monitoring stops, no performance measurements are recorded, no messages are logged, and no transactions are traced.
	unregister
	Unregister the service, WSDL, or endpoint from the sphere.
	unregisterContainer
	Unregisters the specified container.
	unregisterMonitor
	Unregister the specified monitor agent from the sphere. Use this command only when the monitor has been taken offline permanently. Monitors must be offline long enough for the system to mark them down before you can unregister them.
	updateProfileData
	Update profile attribute data for the specified set of objects. This command only updates existing objects; if it cannot find the specified objects, it returns an error.










Environment Variables

The following table describes environment variables that you can define for use with the Business Transaction Management commands in the place of commonly used command flags.


	Environment Variable	Flag Name Equivalent	Flag Long Name Equivalent	Description
	AP_SPHERE_URL	-s	-sphereUrl	The URL for the sphere. http://hostname:port/apcentral/sphere/
.NET example: http://host:port/apcentral/sphere/soa.asmx


	AP_USER_LOGIN	-l	-userLogin	The log-in credentials for the sphere, in one of the following formats:
username:password

credName=myCredentialName

Typically these would be the credentials of a user with administrative privileges.

See Authentication and Role Mapping for more information.

You can encrypt passwords for use with the CLI using the encryptPassword command.












Command Line Interface Sample Files

Sample files are included with Business Transaction Management to help you become familiar with the CLI. Sample files related to the CLI can be found in the Business Transaction Management installation directory, and are organized as described below:


/BTM_Install_Directory
    /samples
         /cli
             /ant
                 build.xml
                 cliCommands.xml
             /config_files
                 TomcatConfig.xml
                 WebLogicConfig.xml
                 WebSphereConfig.xml


These files provide:

	
a command definition file (cliCommands.xml) that defines macros for use with the CLI that can interact with and modify your Business Transaction Management installation. The macros are defined in such a way that you can use ant properties for common values that you are likely to use across many commands used in the same file (such as the sphere URL or the sphere login)


	
an ant "import" example file (build.xml) that imports the command definition file. This file contains examples of using the macro definitions in the command definition file to manage the Bookmart service deployment


	
example files (TomcatConfig.xml,WebLogicConfig.xml,WebSphereConfig.xml) containing the necessary parameter declarations that you can edit for your own environment to help you to perform initial configuration of a Business Transaction Management sphere using the configure command.









Attribute Names

A number of CLI commands require that you pass an attribute name as a flag value. This section lists valid attribute names for different object types.


Endpoint Attributes 


	Name	Name	Name
	aliases	friendlyName	operationsNote
	binding	gateway	qualifiedName
	businessContact	genericNote	relativeLocation
	businessNote	genre	service
	contact	interface	serviceQName
	container	isAlive	relativeLocation
	defaultCredentials	lastIsAliveChangeDate	service
	dependsOnEndpoint	lastManagementChangeDate	serviceQName
	deployment	lastManagementChangeIdentity	serviceDescriptionURL
	description	lastUpdateIdentity	supportContact
	endpointAppProtocol	lastUpdateMarker	supportNote
	endpointSoftwareType	location	targetEndpoint
	endpointSource	managingIntermediaries	technicalContact
	endpointTransportProtocol	note	technicalNote
	endpointType	operations	testingNote
	firstRegistryDate	operationsContact	uddiBusinessKey
	--	--	uddiKey







Operation Attributes


	Name
	dependsOn
	operationName
	operationType
	propertyOverrides







Interface Attributes


	Name	Name	Name
	businessContact	name	supportNote
	businessNote	namespace	technicalContact
	classifications	note	technicalNote
	contact	operations	testingNote
	description	operationsContact	uddiBusinessKey
	friendlyName	operationsNote	uddiKey
	genericNote	owningEndpoint	--
	lastUpdateIdentity	sourceType	--
	lastUpdateMarker	supportContact	--







Interface Operation Attributes


	Name
	classification
	documentation
	operationName
	operationType
	properties
	sampleMessageNotes







Service Attributes


	Name	Name	Name
	alive	lastIsAliveChangeDate	serviceSource
	applicationGroup	lastManagementChangeDate	serviceType
	businessContact	lastManagementChangeIdentity	supportContact
	businessNote	lastUpdateIdentity	supportNote
	category	lastUpdateMarker	technicalContact
	contact	managedDescriptionURL	technicalNote
	deploymentNames	note	testingContact
	description	operations	testingNote
	documentation	operationsContact	uddiBusinessKey
	endpoints	operationsNote	uddiKey
	firstRegistryDate	organization	version
	friendlyName	originalDescriptionURL	--
	lastDeployDate	primaryDeploymentName	--
	lastDeployIdentity	qualifiedName	--







Transaction Attributes

The only transaction attribute is friendlyName.


Container Attributes


	Name	Name	Name
	administratorUI	lastIsAliveChangeDate	phaseInLifeCycle
	baseAddress	lastDeployIdentity	supportContact
	businessContact	lastDiscoveryDate	supportNote
	businessNote	lastManagementChangeDate	technicalContact
	connectionLimit	lastManagementChangeIdentity	technicalNote
	contact	lastUpdateIdentity	testingContact
	containerInfo	lastUpdateMarker	testingNote
	firstRegistryDate	note	uddiBusinessKey
	friendlyName	operationsContact	uddiKey
	genericNote	operationsNote	--
	hostName	osName	--
	implementationType	osVersion	--
	ipAddress	owner	--
	isAlive	performanceRating	--







Deployment Attributes


	Name	Name	Name
	businessContact	isAlive	supportContact
	businessNote	lastDeploymentDate	supportNote
	contact	lastDeploymentIdentity	technicalContact
	container	lastIsAliveChangeDate	technicalNote
	deploymentCategory	lastUpdateIdentity	testingContact
	deploymentStatus	lastUpdateMarker	testingNote
	deploymentType	note	uddiBusinessKey
	description	operationsContact	uddiKey
	firstRegistryDate	operationsNote	--
	friendlyName	pluginAgentPossible	--
	genericNote	pluginAgentPossibleText	--







Contact Identity Attributes


	Name
	emailAddress
	informationURL
	name
	phoneNumber
	usage







Notes Type Attributes

Includes two attribute names: theNote and usage.


Description Attributes

Includes two attribute names: contacts and notes.








Ways of Monitoring Services

This section lists the ways you can monitor services. The list orders these monitoring tasks from high-level to low-level (top to bottom), and explains, for each task, how you navigate to the view where you can perform the monitoring.

To monitor:

	
Overall status of services, that is total number of services that are up/down and with SLA warnings/failures

Navigate to Dashboards > Operational Health Summary > Services




	
Most stressed services

Navigate to Dashboards > Top 10 Services




	
Current summary information across all services, endpoints, and operations (includes up/down status, SLA compliance, and performance)

	
Navigate to Explorer > Services to Endpoints or navigate to Explorer > Services to Operations and look at the Main area.

Services To Endpoints provides a physical view, letting you drill down from services to endpoints and then physical operations. Services To Operations provides a logical view, letting you drill down from services to logical operations.


	
Select the service or endpoint of interest in the Main area.


	
Select the Summary tab.







	
Detailed current performance and usage for a specific service, endpoint, or operation

Navigate to specific service, endpoint, or operation > Analysis tab




	
Detailed current SLA compliance for a specific service, endpoint, or operation

Navigate to specific service, endpoint, or operation and click the Compliance tab




	
Recent history of issues affecting a specific service, endpoint, or operation

Navigate to specific service, endpoint, or operation and click the Alerts tab




	
Logged messages

Navigate to specific service, endpoint, or operation and click the Message Log tab. Message logging is available only if a service endpoint is part of a transaction and if message logging is enabled for the transaction.









Troubleshooting Transactions

This section offers information to help you resolve problems in working with transactions.

If performance monitoring is not working as expected for transactions, the two most common issues to consider are the following:

	
Has there been any traffic flowing through your services in the period of time for which you are expecting results? Business Transaction Management cannot measure the performance of inactive services.


	
Has the feature upon which measurement or analysis depends been enabled? Feature refers to consumer segmentation, instance logging, message content logging, and most fundamentally, transaction monitoring. Check the Profile tab for the transaction to make sure that the desired features are enabled.




If monitoring is enabled for the transaction, if traffic is flowing during the period for which you seek results, and if the required features are activated, you should be seeing complete and correct data. If not, read through the following discussion for possible issues and resolutions.




	
Note:

Remember to check Alerts in the last hour > System Alerts for information that might pertain to your problem.








You cannot create a transaction

Business Transaction Management is unable to validate your transaction definition and cannot create the defined transaction. Possible causes include the following:

	
The name of an operation in the transaction contains a special character. Business Transaction Management can process names with periods in them, but other special characters might pose a problem.


	
You selected a start operation that is used by another transaction.


	
You chose an end operation that differs from the start operation, but did not specify manual keys to correlate the start/end messages.


	
There are disconnected flows in your transaction definition.


	
The start and end operations are different and use different message log databases.





Your transaction has been disabled

You have not explicitly disabled monitoring for the transaction, but no measurements are gathered, and logging and condition processing are disabled. When you check the status shown in the Profile tab, you find that the status for a transaction is disabled or system disabled.

This can happen for a number of reasons:

	
You have modified or deleted a property that was used as a key in the transaction definition.


	
You have deleted a service or operation that was included in the transaction definition.


	
You have disabled a service that was included in the transaction definition.


	
For transactions where the start operation is not the same as the end operation, one or more of the start/end operation endpoints no longer shares the same message log database.


	
You delete a property used for consumer segmentation, or user edits a consumer property used for consumer segmentation and removes consumer mapping information.





Performance measurements are incomplete or inaccurate

This can happen for a number of reasons:

	
The value you specified for Maximum transaction duration is too short for your transaction.


	
You have defined two or more transactions that share an operation. Total response time for each of the transactions will be accurate, but the link measurements to the shared operation will show the sum of the invocations from each caller. In the following diagram, showing transaction ABC and YBC, response time for the BC link will be a sum.

[image: Description of txs_w_shared_svc.gif follows]




	
The transaction has not finished executing.


	
Business Transaction Management uses the start and end operations to define response time. It is assumed that these operations are called only once within the interval defined for Maximum transaction duration. It is also assumed that the content that appears during that interval is unique. If these requirements are not satisfied, performance measurements generated for the transaction might not be accurate.





Segmented information is missing

Consumer segmentation is enabled but information for the consumer is not collected.

	
Check to see whether a property used for consumer segmentation has been deleted or modified so that it is no longer mapped to a consumer.


	
If you have imported the transaction definition from a previous release, consumer mapping information is not imported. You will have to modify the transaction definition and recreate the mapping information.





Logged instances or messages do not contain the expected information

For logged instances, check to see whether the property that is associated with the expected information has been deleted.

It is a requirement that all messages for one transaction be logged to the same database. Sometimes, it is not possible to satisfy this requirement because the transaction crosses a firewall. In this case, you might need the assistance of Business Transaction Management support.

For logged message problems, you might need to check log policy settings and report what you find to Business Transaction Management support.


A condition has been disabled

Check to see whether a property used in the condition definition has been modified or deleted.

You disable instance logging and there is at least one enabled condition for the transaction that depends on it.


A condition has not triggered an alert

The Transaction server was down when a condition needed to be evaluated; check the status of your servers.


A missing message condition is erroneously triggered

A missing message condition is triggered, but the message exists and has been collected. This can happen when monitor processing is especially slow and the missing message condition is evaluated after the transaction's time to live interval has expired. A rare situation.


Viewing Log Policy Settings

Based on the storage settings for the transaction, Business Transaction Management creates a log policy for each transaction and refers to this policy when monitoring the transaction and storing logged messages. Log policy settings are partly derived from the information you provide when you define a transaction. The following table shows the correspondence between log policy settings and transaction definition runtime settings.


	Log policy fields	Transaction definition runtime settings	Description
	Guaranteed storage time	Retain individual messages
Default: 24 hours

	The amount of time Business Transaction Management must retain unassembled messages in the transaction server's database. These messages are thus available for assembly.
	Rotation interval (minutes)	Rotate message log
Default: 720 minutes

	Specifies the rotation interval for the log policy that backs the transaction. Messages that are rotated out, are held for the amount of time defined for Retain individual messages.
	Text index message content	Text index message content	Creates a text index in the oracle database that enables faster keyword-based searches (free text search) at the expense of additional storage and initial processing.






The log policy is named System Generated Log Policy for TransactionName. The only time you might need to view this policy is when troubleshooting logging problems.

To view log policy settings for a transaction

	
In the Navigator, select Administration > System Policies.


	
In the Main area, select the System Generated Log Policy forTransactionName entry.


	
Open the tab area if it is not already open and select the Profile tab. Settings for the transaction's log policy are displayed.










3 Discovering Services and Dependencies

This chapter explains how you use Business Transaction Management to discover containers, services, and dependencies. Using this information you can get an exact picture of how your distributed application works, what components have performance issues, and what components require closer monitoring. It includes the following sections:

	
About Discovery


	
Viewing Discovered Containers


	
Viewing Discovered Services


	
Looking at Dependencies


	
Manually Registering a Service







About Conditions

You can associate one or more conditions with a transaction. A condition is an expression that Business Transaction Management evaluates against a transaction instance. You might use conditions to have Business Transaction Management let you know about the following kinds of events:

	
An order larger than $10,000 is processed.


	
A customer's fault rate is greater than 1%.


	
A transaction instance has exceeded its expected completion time.




You can define three types of conditions for a transaction:

	
Content-based conditions, which issue an alert when the criteria you specify is met. The criteria might specify a property value and/or a fault for a particular operation.


	
Missing message conditions, which issue an alert if the message you specify is not seen by the system in the specified time period.


	
Fault monitoring conditions, which issue an alert when a fault occurs on any operation in a transaction. These type of conditions are the equivalent of defining a content-based condition for any fault on any operation in your transaction. Fault monitoring conditions are disabled by default.




When a condition evaluates to true, Business Transaction Management does the following:

	
Creates a condition alert based on the severity specified in the condition definition


	
Tracks the number of occurrences of the condition


	
Assembles and logs the instance of the transaction that evaluated to 'true'.


	
Keeps the logged transaction instance for the length of time specified for the transaction's "Retain archived condition instances" value in the Storage Settings tab. By default, this is 30 days.




Conditions are evaluated on a per-instance basis; therefore, instance logging must be enabled. If you define a condition for a transaction and you have not enabled instance logging, Business Transaction Management automatically turns it on for that transaction.

When you define a condition, you also assign a severity level to the alert that will be issued when the condition evaluates to true. Severity levels include info, warning, and failure.

Working with Conditions explains how you define conditions, view condition information, modify a condition, and delete a condition.


Defining and Evaluating Conditions

You must observe the following limitations when defining content-based conditions.

	
Condition definitions can include multiple clauses, but all clauses must reference the same message (operation.request, operation.reply or operation.fault).


	
A content-based condition can test for a property value, a fault value, or both. If both, the property must be defined on the fault phase of the operation.


	
Only message elements that are referenced by means of properties can be used in a condition definition, with the exception of fault codes.




The system evaluates a content-based condition when the message for which it is defined is seen. If the condition evaluates to true, Business Transaction Management will correlate back to the transaction's start message to make sure that the instance that has satisfied the condition has been called from within the transaction. If so, the resulting instance is assembled and saved for the time duration specified on the transaction's storage settings Retain archived condition instances.

The system begins to evaluate a missing-message condition when it sees the starting message for the transaction. It then looks for the message for the period specified in the condition definition. If it does not see the message in that period, the missing message condition evaluates to true.

Once you have defined a condition on a transaction, it is listed in the transaction's Conditions tab.





Interpreting Condition Alerts

Alerts are commonly thought to signal that something bad has happened, for example, that an error has occurred. However Business Transaction Management uses condition alerts to signal the occurrence of any kind of message pattern. So, depending on the condition definition, an alert could signal a positive event: a customer has doubled an order, a process has attained a certain level of efficiency, sales in a particular region have exceeded the norm, and so on. You can use severity settings to signal whether the alert denote a positive event (info level) or a negative one (warning or failure level).

Once an alert is issued, you have several ways to deal with the situation. You can:

	
view the logged instance


	
notify interested parties by email




Condition alerts that have occurred can be queried, filtered, and viewed on the Alerts tab of the related transaction instance. Alerts created in the last 24 hours for all objects can also be filtered and viewed using the Condition Alerts view (from the Navigator bar). The dashboards also include various alert counts.








createOrUpdatePolicy

Use the createOrUpdatePolicy command to create or update the specified policy directly in the sphere.

Creating or updating a policy might involve the following three steps:

	
Generate the template settings document using the createSettingsDocument command.


	
Edit the generated document to provide the specific values required for the policy being created.


	
Create the policy using the createOrUpdatePolicy command, providing the settings document created in Step 2.




To create a new policy, you need to supply only a template name, type, and name. If the policy requires settings, you must also provide a settings document. You can provide additional information to more precisely identify the source template to specify the initial state of the policy, but these are not required.

To update a policy, you must provide a name, type, the -overwrite flag, and any arguments for elements you want to update. Any values you do not specify remain unchanged. Because the policy name and version identify the policy, you cannot use this command to change either. Instead, create a new policy with the desired name and/or version.


Command Syntax


btmcli createOrUpdatePolicy [-templateName templateName]
                            [-t type][-subType subType] [-templateVersion version]
                            -n name [-V version] [-desc description]
                            [-settings settingsDocument]
                            [-criteria criterion1 [criterion2]...]
                            [-enable] | [-disable]
                            [-overwrite] [-f]
                            [-s sphereUrl] -l username:password



	Name	Long Name	Description
	-templateName	--	The name of the template on which to base the new policy.
This parameter is ignored when performing an update.


	-t	-type	The policy type for the new policy.
This parameter is also used to determine if the specified policy already exists.


	-subType	--	The policy sub type for the new policy.
This parameter is also used to determine if the specified policy already exists.


	-templateVersion	--	The version of the template on which to base the created policy.
This parameter is ignored when performing an update.


	-n	-name	The name of the new policy.
This parameter is also used to determine if the specified policy already exists.


	-V	-version	The version of the new policy.
This parameter is also used to determine if the specified policy already exists.


	-desc	-description	A description of the policy.
	-settings	-settingsDocument	The policy's settings document, created with the createSettingsDocument command.
	-criteria	--	A list of application criteria for the policy. The form of each criterion is described below.
	-enable	--	Marks the policy as enabled.
	-disable	--	Marks the policy as disabled.
	-overwrite	--	Indicates that if the policy already exists, it should be updated with the specified information.
	-f	-force	Update the policy even if it is marked internally as "cannot be updated."
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Application Criteria

When creating or modifying a policy, you can specify a set of criteria to be used in determining the monitored objects to which the policy can be applied. The format of each criterion in the set is as follows:

monitoredObjectType [;query [,{UNION | EXCLUDE}]]+

For detailed information on how to specify criteria visit http://www.oracle.com/support/contact.html or visit http://www.oracle.com/accessibility/support.html if you are hearing impaired.


Example

The following example shows the createOrUpdatePolicy command used to enable the enforcement of a pre-existing policy, MyPolicy.


btmcli createOrUpdatePolicy -name MyPolicy -enable
                            -s http://localhost:8080/btmcentral/sphere/ 
                            -l admin:abracadabra






generateMonitoringScript

Use the generateMonitoringScript command to generate a batch script that you can use later to recreate the system's current monitoring state.

The generateMonitoringScript command is part of the backup and recovery process. Using this command to capture the system's current monitoring state, allows you to restore that state later if the system is damaged and needs to be recovered.


Command Syntax


btmcli generateMonitoringScript [-scriptLanguage bat | sh]
                                [-o outputFile]
                                -s sphereUrl -l username:password



	Name	Long Name	Description
	--	-scriptLanguage	The scripting language to use for the output: bat for Windows batch file or sh for Unix shell script. If not specified, it defaults to bat for Windows and sh for Unix.
	-o	-outputFile	The name of the file where the monitoring script is written. If the file already exists, the system will generate a new name by appending a unique number to the given file name.
If you omit this flag, output is sent to stdout.


	-s	-sphereUrl	Required. The URL of the sphere with which you want to register the container.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example specifies that the script be written to the file MyMonitoringStateFile.


btmcli generateMonitoringScript -scriptLanguage bat -oMyMonitoringStateFile
                            -s http://myHost:8080/btmcentral/sphere/ 
                            -l admin:abracadabra






Viewing Transaction Instances

A transaction usually executes many times in a given period. If you have enabled transaction instance logging or if you have enabled fault monitoring, Business Transaction Management tracks the flow of messages included in the transaction and maps these to particular transaction instances. It assembles the messages for a transaction instance in the following cases:

	
when an alert is generated as a result of a fault, or a condition being met


	
when you explicitly ask for assembly




Once a transaction instance is assembled, you can use the Instances tab to view detailed performance information for that instance. You can also use the Message Log tab to search for messages containing particular property values. To view the content of a message, you must also enable message content logging.

This section explains how you do the following:

	
View a summary of all transaction instances and search for a subset of these


	
Assemble and inspect an instance





Viewing Captured Transaction Instances

The Instances tab in the Transactions Tabs area allows you to view captured transaction instances.

The ID column of the table displays both instances that have been assembled (these have an ID value assigned) and instances that have not been assembled (these have an Assemble button).

Information for each instance shows when it was captured, what the overall response time for the transaction instance was, and values for properties if you have created these.

The Show instances filtering control allows you to list instances that have occurred in a set time period or to show only assembled instances.

Which instances you choose to assemble depends on what interests you. For example, you might want to assemble an instance with an unusually slow response time; or you might want to assemble an instance with an unexpected property value.

If you are capturing a very large set of messages, you might want to use the Message Log tab to search for a smaller set of messages, based on property values, and then assemble one or more of these.





Assembling Instances and Using the Instance Inspector

You can assemble an instance by clicking the Instance Inspector icon (magnifying glass) in the Instances tab:

Business Transaction Management brings up a Transaction Instance Inspector. This view consists of three parts: identifying information for the transaction instance at the top, a map view in the middle, and a grid view at the bottom showing all the operations included in the transaction instance.

The top part of the inspector shows the name of the transaction, the time the assembled instance started executing, its ID, the number of message exchanges, the total messages exchanged, and the response time between the starting and ending message. Any warnings or faults will also be displayed in this area.

In the instance map that follows, you can view the entire transaction instance, with the response time given for each request/response link. Move the cursor over the operation name to display the service type, the endpoint name, and the host name and port.

At the bottom of the inspector window, a grid view shows you detailed information for each message included in the transaction instance. The view includes columns to show property values if you have defined these.

Clicking on the magnifying glass (tear-off control) for any operation, opens a Message Content inspector window and displays the contents of the selected message if you have enabled message content logging for that operation.








credStoreTool

Use the credStoreTool command to create, obtain, or delete a credential from the credential store. This command allows you to create three different types of credentials:

	
credentials based on a username:password format.

You use these credentials to access btmcli commands. Nearly all commands require a user name and password.


	
credentials based on a trusted issuer and secret

Business Transaction Management components use this type of credential to establish trust relationships between them.


	
binary credentials (AES keys for the System Default Encryption Key).

An AES encryption key is used to encrypt sensitive data that is transmitted from one Business Transaction Management component to another or when that sensitive data is stored in a database or on disk.




Before you can use this command, you must install and configure the Oracle Java Platform Security classes as described in the Business Transaction Management Installation Guide.

The syntax of the credStoreTool command varies depending on the type of credential you are working with. The sections that follow provide syntax and parameter information for each kind of credential.

In all cases, the commands allow you to create a credential, to obtain a credential if you need to copy it to other servers, and to delete a credential.


Using user:password Credentials

This option is more secure than specifying the user name and password on the command line itself or in a script. For additional information in how you use this credential to access btmcli commands, see Security Options in Accessing CLI Commands.


Command Syntax


btmcli credStoreTool -createCred credName [-credType up] 
                     [credValue username:password]

btmcli credStoreTool -getCred credName [-credType up] [-showPwd]

btmcli credStoreTool -deleteCred credName [-credType up]



	Name	Description
	-createCred	Specifies the name of the credential to be created.
	-getCred	Specifies the name of the credential to be obtained.
	-deleteCred	Specifies the name of the credential to be deleted.
	-credType	The kind of credential to be created, obtained, or deleted.
The default is up.


	-credValue	If you do not specify this option, you will be prompted for a user name and password. The password entered will be masked with asterisks.
	-showPwd	For the getCred option, asks that the user name and password be displayed.









Using Trusted Issuer and Secret Credentials

Business Transaction Management components use this type of credentials to establish a trust relationship. When a component receives a request for a service, before it acts, it checks that it came from one of its trusted cohorts.


Command Syntax


btmcli credStoreTool -createCred credName credType is [-credValue issuer:secret]

btmcli credStoreTool -getCred credName -credType is [-showSecret]

btmcli credStoreTool -deleteCred credName -cretType is



	Name	Description
	-createCred	Specifies the name of the credential to be created.
	-getCred	Specifies the name of the credential to be obtained.
	-deleteCred	Specifies the name of the credential to be deleted.
	-credType	The kind of credential to be created, obtained, or deleted.
	-credValue	If you do not specify this option, you will be prompted for an issuer and secret. The secret entered will be masked with asterisks.
	-showSecret	For the getCred option, asks that the issuer and secret be displayed.









Using Binary Credentials

An AES encryption key is used to encrypt sensitive data that is transmitted from one Business Transaction Management component to another or when it stored in a database or on disk.


Command Syntax


btmcli credStoreTool -createCred credName 
          -credType bin {credValue Base64-encoded-bytes | -genKey AlgName:KeySize}

btmcli credStoreTool -getCred credName credType bin [-showSecret]

btmcli credStoreTool -deleteCred credName -credType bin



	Name	Description
	-createCred	Specifies the name of the credential to be created.
	-getCred	Specifies the name of the credential to be obtained.
	-deleteCred	Specifies the name of the credential to be deleted.
	-credType	The kind of credential to be created, obtained, or deleted.
	-credValue	Specify a set of bytes (base-64 encoded). These bytes might or might not represent a valid encryption key.
	-genKey	AlgName refers to the JCE (Java Cryptographic Extension) reserved algorithm name. Currently only AES is supported.
The KeySize is the size of the key that you want to generate. Different algorithms have different allowable key sizes. For AES, these are 128, 192, and 256, which refer to bits (not bytes). 128 is recommended because this is supported in all of the underlying platform's cryptographic implementations.


	-showSecret	For the getCred option, asks that the size (in bytes) of the binary credential be displayed along with the base-64 encoded bytes themselves. For example,
16 bytes long ... Base-64 = [qvw1wEOxprSeJf2TbtuK5w==]

If you do not specify this parameter, the bytes will not be displayed.














Viewing Condition Alert Information

When a condition evaluates to true, the system tracks its occurrence and automatically creates a condition alert. This section explains the various ways Business Transaction Management displays count and condition alert information, and it explains how you can modify the amount of time that alerts are stored.

You cannot manually delete alerts.


Viewing Count Information

You can view count information condition alerts as follows:

	
In the Operational Health Summary dashboard (counts for each type of alert).


	
In the Top 10 Transactions dashboard.


	
In the Alerts tab of a transaction.


	
In the Performance pane of the Analysis tab for the transaction.


	
In the Conditions pane of the Analysis tab for the transaction.




You can also edit the summary view (for a transaction) to show a count of condition alerts and the current condition alert rate by using the column chooser and selecting the Condition alert and Condition alert rate instruments. The Condition alert instrument specifies the condition occurrences in the specified period. The Condition alert rate instrument specifies the number of condition occurrences per hour in the given period.





Viewing Alert and Detail information

You can view condition alerts in the following ways:

	
on the Alerts tab of the related service, endpoint, operation, or transaction instance. Detailed information for the selected alert is shown in a separate window if you click the looking glass icon or double click the alert


	
in the Condition Alerts view from the navigator for condition alerts that occurred in the last hour. Detailed information for the selected alert is shown in the Info tab in the tab area.




Condition alert detail includes the following information:

	
the name and severity of the condition and the expression whose evaluation triggered the alert.


	
summary information: The name of the transaction, the time it was captured (Start Time), its ID, the number of message exchanges and the total messages, the response time for the transaction, and any conditions alerts raised while the transaction executed (with severity flags shown).


	
a graph of the transaction, showing the operation for which the condition expression evaluated to true with a red broken arrow. To display the request and response message for each operation, click the inspector icon for the desired operation in the list below the graph.








Modifying Alert Expiration Time

By default logged information for alerts expires after 1 year (31536000 seconds).

You can change the alert expiration time as follows:

	
Select Administration > System Services from the Navigator.


	
Select the AP_Notifier_Service in the summary pane.


	
Select Edit Setup Data for AP_Notifier_Service from the Admin menu.


	
Modify the Logged notification expiration time field to the desired number (of seconds).


	
Click Apply.











Accessing JVM Diagnostics

JVM Diagnostics (JVMD) is a diagnostic tool that allows you to view the details of an executing Java Virtual Machine (JVM) process. You can see stack frames for executing threads, thread state information, aggregate information about the frequency and cost of method execution, information regarding the holding of Java and DB locks, and details about the objects in the Java heap. JVMD also stores historical data for each JVM it monitors so you can view data relating to things that have happened in the past and get a sense for historical trends.

Using JVMD to access additional information can be useful in situations like the following:

	
You are viewing summary information for a transaction and see that a particular operation is unusually slow or faulty. You want to get more information about the execution of that step, and you initiate a drill through to JVMD from this point.


	
You are viewing the details of a logged transaction instance and you notice that one of the steps in the transaction did not behave as expected. You would like more details about the execution of this step from JVMD, and you initiate a drill through to JVMD from this point.


	
You are viewing a collection of logged messages in the message log search tool and you notice a message that appears abnormal or unusual. You would like to get more details of the handling of that message using JVMD, and you initiate a drill through to JVMD from this point.




This section explains how you configure Business Transaction Management to connect to the Enterprise Manager (EM) Console, and how you access the information described above.


Configuring the Connection to the EM Console

The following procedure specifies the information Business Transaction Management needs to be able to invoke the JVMD UI.

	
Select System Services from the Navigator.


	
Find and select the AP_Sphere_Service entry.


	
Select Admin > Edit Setup Data for AP_Sphere_Service.


	
Click the Edit XML button.


	
Scroll to the bottom of the XML document and find the emgcURL element.


	
Edit this XML element so that it contains the base URL for the EM console. For example, if you have an EM console running at https://adc2101158:4473/em, you would enter https://adc2101158:4473, and the edited entry would look like this:


<pfx6:emgcURL>https://adc2101158:4473</pfx6:emgcURL>. 


Note that the namespace prefix might be other than pfx6; use whatever value appears in the XML text.


	
Click the Apply button to save changes.




You will have to supply login information for the JVMD console when you access it. Single sign on is not supported.





Initiating Access to the JVMD Console

You can access the JVMD console from the following entry points:

	
Transaction summary graph Right click on an operation and select Drilldown to JVMD from the drop-list. Supply the service ID and the currently chosen time interval.


	
Transaction instance graph Right click on an operation and select Drilldown to JVMD from the drop-list. Supply the service ID and the instance time (start time and end time). When a step is executed repetitively, the first endpoint on which it was executed is selected.


	
Message search log tool Right click on a message row and select Drilldown to JVMD from the drop-list. Supply the endpoint ID and the time of the message (start time and end time).




In each of these cases, a new window is displayed showing the JVMD screen. In the multi-VM case, JVMD shows a VM group target and aggregate information for that group.







6 Working with Consumers

This chapter explains how you can present performance results to reflect consumers' use of your services. It explains how you set up consumer segmentation, how you create consumers, how you map messages to consumers, and how you view and manage consumer-based performance information. It includes the following sections:

	
About Consumers


	
Mapping Messages to Consumers


	
Monitoring Consumers


	
Adding and Deleting Consumers


	
Editing Consumer Names


	
Customizing the Consumer Label







btmcli exportSchedules

Use the exportSchedules command to export schedules from the target sphere. You can output the schedules to a file or to stdout.

You can specify all schedules, a specific schedule, or schedules of a certain type.

After export, you can use the importSchedules command to import the schedules to a different sphere.


Command Syntax


btmcli exportSchedules -n Name | -query filterQuery | -exportAll
                       [-o fileName]
                       -s sphereUrl sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The name of the schedule to export.
	-query	-filterQuery	An AQL query specifying the set of schedules to export.
Use the Filter tool to construct the query, and then copy and paste the query into the command line.


	-exportAll	--	Specifies that all schedules should be exported.
	-o	-outputFile	Specifies a file into which the results of the export will be placed. If this flag is not used, output goes to stdout.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following command exports all schedules known to the specified sphere to the file MySchedules.


btmcli exportSchedules -exportAll -o C:\Home\MySchedules 
                       -s http://localhost/btmcentral/sphere/ -l admin:pass






importPolicies

Use the importPolicies command to import previously exported policies.

The imported policies are taken from the file to which they were exported (-inputFile parameter), or from stdin if no such file is specified.

Not all files can be imported. Data that you cannot migrate between sphere environments includes the following:

	
Logging policy data collected by your transaction management database.

You cannot migrate information that has been collected and written to either file or database storage through the application of logging policies on your managed services.


	
Instance data for exceptional conditions that have occurred in your transactions.

You cannot migrate information that has been collected by the transaction management component of Business Transaction Management.




By default, this command replaces all existing policies that are older than the imported policies.


Command Syntax


btmcli importPolicies [-i inputFile]
                      [-replace ALL | all | NEWER | newer | NONE | none]
                      [-v] -s sphereUrl -l username:password



	Name	Long Name	Description
	-i	-inputFile	The name of the file containing the data to be imported.
	-replace	-replacementLevel	Determines the outcome when an imported policy matches an existing policy in the system:
ALL: replace all existing policies

NEWER: replace existing policies that are older than the imported policies. (Default)

NONE: do not replace any existing policies.


	-v	-verbose	Display more detailed information about command execution.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Examples

The following example shows the importPolicies command used to import data from the file MyPolicies.


btmcli importPolicies -inputFile MyPolicies -replace ALL
                  -s http://localhost:8080/btmcentral/sphere/
                  -l admin:abracadabra






importSchedules

Use the importSchedules command to import previously exported schedules to the target sphere.

By default, this command replaces all existing schedules that are older than the imported schedules.


Command Syntax


btmcli importPolicyTemplates [-i inputFile]
                      [-replace ALL | all | NEWER | newer | NONE | none]
                      [-v] -s sphereUrl -l username:password



	Name	Long Name	Description
	-i	-inputFile	The name of the file containing the data to be imported. If this is not specified, data is imported from stdin.
	-replace	-replacementLevel	Determines the outcome when an imported schedule matches an existing schedule in the system:
ALL: replace all existing schedules.

NEWER: replace existing schedules that are older than imported schedules. (Default)

NONE: do not replace any existing schedules.


	-v	-verbose	Display more detailed information about command execution.
	-s	-sphereUrl	The URL of the sphere. http://hostname:port/btmcentral/sphere/
This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example imports schedules from the file MySchedules and replaces all existing schedules.


btmcli importSchedules -inputFile MySchedules -replace ALL
                       -s http://localhost:8080/btmcentral/sphere/
                       -l admin:abracadabra





9 Commands and Scripts

This chapter introduces the Business Transaction Management command line interface (CLI), which you can use to execute commands as well as scripts. It explains how you use the CLI, how you get help and version information, how you can execute commands securely, and it describes the system variables you can set to use with commands. It includes the following sections:

	
About the Command Line Interface (CLI)


	
Getting Help and Version Information


	
Executing CLI Commands and Scripts


	
Security Options in Accessing CLI Commands


	
Command Summary

Environment Variables


	
Command Line Interface Sample Files


	
Attribute Names




In addition to commands, Business Transaction Management also provides several utilities. These are described in Chapter 10, "Utilities."



2 Using the Management Console

This chapter describes the process of working with the Business Transaction Management console; it includes the following sections:

	
Getting to Know the Management Console


	
Viewing Data


	
Creating New Views


	
Management Console Reference







updateProfileData

Use the updateProfileData command to update profile attribute data for the specified set of objects. This command only updates existing objects; if it cannot find the specified objects, it returns an error.

This command is useful in two distinct cases:

	
You want to update a collection of objects with a common set of attribute values. For example, you want to set the application group for a set of services to the same value.


	
You want to set the attribute values for a collection of objects to different values. For example, you want to import data obtained from an external data source.




See the discussion below for additional information.


Command Syntax


btmcli updateProfileData -t type [-query filterQuery] 
          [-val name1:val1 [[name2:val2]...]]] | [-profileData profileData]
         -s sphereUrl -l username:password



	Name	Long Name	Description
	-t	-type	The type of objects to update.
	-query	-filterQuery	Selects the set of objects that match the query.
Use the Filter tool to construct AQL queries, and then copy and paste these into the command line.


	-val	-attributeValues	A list of name:value pairs used to update the selected objects. Each entry in the list specifies the name of an attribute and its value.
If you provide this argument, you must also provide the -query argument.

Look here for a complete list of commonly used attribute names and object types.


	--	-profileData	Specifies the name of a file containing the profile data to update. This file can have one of two formats, depending on the flags specified.
If you provide the -query argument, the file should be a Java properties file where each entry is an attribute name and its associated value.

If there is no -query argument, this file should be a text-delimited file in csv form where the first row specifies the attributes to update, and subsequent rows provide values for a series of object instances. In order to identify the objects to be updated, the key attributes must be included (either the object id or the attributes that make up the type's natural key).


	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.








Discussion

This command has essentially three forms of use:

	
In order to update one or more attributes to the same values for a set of objects use the following form:

updateProfileData -t myType -query myQuery -val attr1=valueattr2=value ...

or the form

updateProfileData -t myType -query myQuery -profileData javaPropFile




	
In order to perform a bulk update of a set of objects where the attribute values for each object are different (such as when updating from an external database), use the form:




updateProfileData -t myType -profileData CSVFile_with_1_row_per_Object_to_update


Example

The following example shows the updateProfile command.


btmcli updateProfileData -t endpoint -profileData MyJavaPropertyFile 
          -s http://localhost:8080/btmcentral/sphere/ -l Admin:abracadabra






setBaselines

The setBaselines command sets baselines for the specified objects. Setting baselines enables you to then create a baseline SLA policy.

You can use the retrieveObjectData command to retrieve and output historical performance data to a file; then you can use that file as input to the setBaselines command. If you create the input file by hand, use the same format as the output of the retrieveObjectData command.

You can also use this command to delete existing baselines for the specified object or for all managed objects.


Command Syntax


btmcli setBaselines -i inputFile [-delete] [-all] 
                    -s sphereUrl -l username:password



	Name	Long Name	Description
	-i	--	An XML document that indicates the baseline values for services, service operations, endpoints, endpoint operations, and transactions. Baseline values can be used for baseline service level agreements (SLAs based on historically-derived performance thresholds).
	-delete	--	Delete any existing baselines for the referenced managed objects before setting new baselines.
	-all	--	When combined with the -delete option, deletes all existing baselines for all managed objects. In this case, an input file is not required.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the setBaselines command.


btmcli setBaselines -i MyBookmartBaselines -delete
            -s http://mySphereHost:1771/btmcentral/sphere/ 
            -l my_btm_admin_username:my_btmadmin_password






Getting Information About a Transaction

Once you have defined a transaction, you can use detail area tabs to get information about policies, conditions, and properties applied to a transaction. You can also display the transaction's profile. In some cases, you can modify the definition or status of elements shown in a tab.


Getting Profile Information

Use the Profile tab of the Transaction view to see a map of the transaction and to see its definition.

The Profile tab provides essentially the same information you would see if you displayed the transaction definition by choosing Edit TxName from the Modify menu. Selecting the Profile tab instead, makes it easy to switch to other tabs or views, prevents your making unintentional changes, and provides three additional pieces of information:

	
the date the definition was last modified,


	
any user attributes defined for the transaction


	
the transaction identifier, which is sometimes needed to identify the transaction in CLI commands.








Getting Policy Information

Use the Policies tab to view information about policies associated with a transaction.

By default, the tab shows information about applied policies. You can use the filter control to view changed policies, disabled policies, pending policies, rejected policies and unapplied policies. 

The name of the applied policy is shown in a tree view in the Name column. Expanding the policy node shows the following information:

	
Policy Status Details lists any issues arising from the application of the policy.


	
Monitored Object Type specifies the targets to which the policy is applied.


	
Location specifies the address of a target endpoint


	
Management Intermediary specifies the Business Transaction Management agent that is applying the policy.




Double clicking the policy name in the Policy tab, opens a new window that you can use to view alert, profile, and target information for the selected policy.





Getting and Changing Condition Definitions

Use the Condition tab for the Transaction view, to display the conditions you have defined for a transaction. This tab allows you to do the following:

	
View and change the status of fault monitoring: enabled or disabled.


	
View condition definitions and status


	
Use the Edit drop down list, shown for each condition, to modify the condition definition, to duplicate the condition, or to delete the condition.








Getting Property Information

Use the Properties tab for the Transaction view, to display a list of all the properties defined for messages included in a given transaction. In addition to listing the properties, the tab shows information about the following:

	
The service and operation for which the property is defined


	
The phase (request/response) of the operation


	
The data type of the property value


	
Whether the value is deemed sensitive


	
Whether it is mapped to a consumer (denoted by a human icon on the left) and what consumer mapped attribute it is associated with.


	
A description if you have supplied one when you created the property.




An Edit drop down list for each property listed allows you to modify, duplicate, or delete the property definition.







5 Monitoring Services

This chapter describes how you can use Business Transaction Management to monitor services. It explains the meaning of the instruments used for monitoring, and it describes the Top 10 Services dashboard. It includes the following sections:

	
Ways of Monitoring Services


	
Top 10 Services Dashboard


	
About Instruments







Working with Conditions

This section explains how you complete the following tasks in working with conditions:

	
Enabling and Disabling Fault Monitoring


	
Defining a Condition


	
Enabling and Disabling Conditions


	
Viewing Condition Information


	
Modifying a Condition Definition


	
Duplicating a Condition Definition


	
Deleting a Condition




Viewing Condition Alert Information, provides information on viewing alert counts and alerts that are generated when a condition is met.



Enabling and Disabling Fault Monitoring

When you create a transaction, a fault monitoring condition is automatically created on the transaction and is disabled.


To Check Fault Monitoring Status

	
Select the transaction of interest.


	
Click the Conditions tab. Fault Monitoring state is shown.


	
You can click the Edit button to enable fault monitoring, or you can use the Modify menu as described next.





To Enable Fault Monitoring

	
Select the transaction for which you want to enable fault monitoring.


	
Select Modify > Enable/Disable Fault Monitoring for TransactionName. Business Transaction Management displays the Edit Fault Monitoring tool for the selected object.


	
Use the Severity drop down list to select the severity level you want to associate with fault-generated alerts for this object. Business Transaction Management shows the fault monitoring is enabled for the service on the Conditions tab for the service, and also shows the severity status for fault monitoring.


	
To disable, you can click the Edit button in the Conditions tab and deselect the enable check box in the resulting dialog. (You can also use the Enable/Disable Monitoring item from the Modify menu.









Defining a Condition

How you define a condition differs, depending on whether it's a content-based condition or a missing message condition. Both options are described below.


To Define a Content-Based Condition

	
Select the transaction for which you want to define a condition.


	
Select Create > Transaction Condition > Content Condition for TransactionName. Business Transaction Management displays the Create Condition tool dialog.


	
Specify the name of the condition in the Name text box.


	
Select a value for the severity you want to associate with this condition from the Severity drop-down list.

Associating a severity level with a condition allows you to filter your views of alerts based on this attribute.


	
Use the Enabled check box to enable or disable the condition.


	
Optional: Use the Description text field to provide a description that helps you understand the nature or use of this condition without having to read through the boolean expression.


	
Use the buttons and the items in the Criteria area to create the boolean expression that will be used when the condition is evaluated. Three buttons are displayed from which you can select the elements that will compose your condition. (All clauses must belong to the same message (operation phase).

The Property button is displayed only if you have defined properties for the selected object.) The table below describes the use of the buttons. Once you click a button to select an element, a row is added to the Criteria used to define the condition. For each row, select an operator, and a value to test.

When you are done, click Apply.


	Buttons	Description
	New Property	If you need to define a property to base the condition on and you have not done so already, you can use the New Property button to create one.
	Property	Select an existing property.
	Fault	Select the operation whose status interests you, and specify whether you are looking for a particular code or any fault in the Criteria section.









To Define a Missing-Message Condition

To define a missing message condition, you must specify the message whose arrival time interests you and how much time must elapse before its absence raises an alert. The absent message can be a request, a response, or any fault.

	
Select the transaction for which you want to define a condition.


	
Select Create > Transaction Condition > Missing Message Condition for TransactionName. Business Transaction Management displays the Create condition tool dialog.


	
Specify the name of the condition in the Name text box.


	
Select a value for the severity you want to associate with this condition from the Severity drop-down list. Associating a severity level with a condition allows you to filter your views of alerts based on this attribute.


	
Use the Enabled check box to enable or disable the condition.


	
Optional: Use the Description text field to provide a description that helps you understand the nature or use of this condition without having to read through the boolean expression.


	
Use the drop down lists in the Criteria area to create the boolean expression that Business Transaction Management will evaluate when the condition is evaluated. Three drop down lists are displayed from which you can select the elements that will compose your condition.


	Drop-down list	Description
	Operation name	Select an operation from the drop down list.
	Operation phase	Select request, response, or fault from the drop down list
	Evaluation period	Select the period of evaluation: either before the transaction's maximum duration has expired or Use timer.
If you select Use timer, you must specify the time period in milliseconds.

In either case, Business Transaction Management will start timing on a per instance basis when the transaction's start message arrives.















Enabling and Disabling Conditions

You can enable and disable conditions individually or multiple conditions at once.


To Enable or Disable an Individual Condition

	
Select the transaction for which this condition is defined.


	
Click the Conditions tab in the detail area.


	
Click the Edit button for the condition you want to enable or disable.


	
Select Modify from the drop down list.


	
In the ensuing dialog click the Enabled/Disabled check box to change the status of the condition.


	
Click Apply.





To Enable or Disable Selected Conditions

	
Select the transaction whose conditions you want to enable or disable.


	
Select Modify > Enable/Disable Conditions for TransactionName.


	
In the ensuing dialog click the Enable All or Disable All buttons to change the status of the conditions or use the radio buttons to select the conditions of interest.


	
Click Apply.









Viewing Condition Information

	
Select the transaction of interest. from the Transactions view.


	
Click the Conditions tab to see all defined conditions. An icon indicates the severity level of the condition: green for Information, yellow for Warning, red for Failure. 









Modifying a Condition Definition

	
Select the transaction of interest.


	
Click the Conditions tab in the detail area.


	
Select Edit from the Edit drop-down list for the condition.


	
Use the Condition tool to modify the definition.









Duplicating a Condition Definition

	
Select the transaction of interest.


	
Click the Conditions tab.


	
Select Duplicate from the Edit drop-down list for the condition.


	
Modify the definition if needed.


	
Click Apply.









Deleting a Condition

	
Select the transaction of interest.


	
Click the Conditions tab.


	
From the drop-down Edit menu for the condition of interest, select Delete.











createSettingsDocument

Use the createSettingsDocument command to create a settings document for input to the createOrUpdatePolicy command.

A settings document is an XML file. The source of the settings document can be a policy template or an existing policy.

	
If you specify a policy template, the command returns the default settings document for the policy template.


	
If you specify a policy, the command returns a settings document with the settings for the current policy instance. You can edit the values in the settings document before submitting it to the createOrUpdatePolicy command.




To determine the type and subtype of a policy or policy template, select the appropriate object in the Navigator. The type and subtype for each policy or policy template is displayed in the summary pane.


Command Syntax


btmcli createSettingsDocument -n name [-t type] [-subType subType[ [-V version]
                              -fromPolicy [-o outputFile]
                              -s sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The name of the template or policy whose settings document you want to use.
	-t	-type	The type of the policy template or policy whose settings document you want to use.
	-subType	--	The subtype of the policy template or policy whose settings document you want to use.
	-V	-version	The version of the policy template or policy whose settings document you want to use.
	-fromPolicy	--	Indicates that the settings document should be constructed using a pre-existing policy instance and not a template.
	-o	-outputFile	The file where the settings document is written. If this is not specified, the settings document is sent to standard output.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the createSettingsDocument command used to create the settings document MySettingsDoc.


btmcli createSettingsDocument -namemySecurePolicy -o mySettingsDoc
                  -s http://localhost:8080/btmcentral/sphere/
                  -l admin:abracadabra
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Overview

Business Transaction Management provides the following elements to help you create reports:

	
the retrieveObjectData command, which produces the data that you want to use in your report. You specify the data you are interested in using command parameters. For example, you could extract data about fault count by service, maximum response time by transaction, condition alert rate by transaction, and so on.


	
templates that you can use with the Oracle BI Publisher (11 g) application to create well-formatted reports in HTML, PDF, RTF, Excel, PowerPoint, MHTML, and Data formats.


	
sample retrieveObjectData commands that you can use for the type of report you want to generate.


	
sample retrieveObjectData output files that you can use to experiment with your reporting tool without having to generate data.




Material to help you create reports is found in the following directory:

BTM_Install_Directory\samples\reports

The directory includes two sub-directories:

	
templates: this directory includes templates you can use only with the template tools provided by the Oracle BI Publisher (11 g) application. It also includes the reports.xls file, an Excel spreadsheet that shows, for each template, the appropriate retrieveObjectData command that will provide the output data to be combined with the template to generate the report.

For example, the retrieveObjectData command to be used with the AvgResponseTimeByService template is


btmcli retrieveObjectData -s sphere -l sphereLogin -type service 
     -attributeNames  friendlyName averageResponseTime -inTheLast 24h 
     -intervalSize 1h -format xmltable > AvgResponseTimeByService.xml


Or, the retrieveObjectData command to be used with the FaultCountByService template is


btmcli retrieveObjectData -s sphere -l sphereLogin -type service
     -attributeNames friendlyName faultCount -inTheLast 24h -intervalSize 1h
     -format xmltable > FaultCountByService.xml


	
sampleData: this directory contains sample retrieveObjectData output files that you can use to see what reports might look like without having to generate data.








4 Working with Transactions

A transaction is a sequence of operations that you want to monitor as a single unit. This chapter discusses the advantages of using transactions, how you define and monitor transactions, how you access JVM diagnostics, and how you troubleshoot transactions. It includes the following sections:

	
About Transactions


	
About Properties


	
Working with Properties


	
Defining, Modifying, and Deleting Transactions


	
Viewing and Monitoring Transaction Performance


	
Top 10 Transactions Dashboards


	
Viewing Transaction Instances


	
Viewing Logged Messages and Properties


	
Accessing JVM Diagnostics


	
Getting Information About a Transaction


	
Troubleshooting Transactions







Scheduling Service or Endpoint Downtime

If you need to shut down a service without affecting the state of your SLAs, you should schedule a downtime for the service before shutting it down. Instrument measurements continue to be collected and displayed during scheduled downtimes, but these measurements are not used for SLA evaluations.

In order to schedule downtime of a service, you must first create a downtime schedule and then add the schedule to each of the service's endpoints.

This section also explains how to view a schedule, how to remove a schedule from and endpoint, and how to delete a downtime schedule from all endpoints.


To Create a Downtime Schedule

	
Choose Create > Schedule to open the Create Schedule tool.


	
Give your schedule a descriptive name.


	
Set the Schedule Type to Custom.


	
Click the first drop list and choose the recurrence frequency for the downtime. For example, the following schedule chooses a weekly downtime, specifies the day, the starting time, the duration of the down period, and the starting date.

[image: Description of down_schedule.gif follows]




The pick a day of month options let you schedule by a numeric day of the month, for example, on the 1st day of each month.

The pick a day of week options let you schedule by the name of a day, for example, on the 1st Monday of each month.


	
Use the remaining fields and drop lists to specify the time the downtime begins, its duration, and the date of its first occurrence.


	
To schedule additional downtimes to the schedule, click add new period.


	
Click Apply.





To Add a Downtime Schedule to an Endpoint

	
Select the endpoint.


	
Choose Modify > Set Endpoint Downtime Schedule.

The Set Endpoint Downtime Schedule tool opens.


	
Choose your downtime schedule from the Choose schedule drop-list.


	
Click Apply.





To View Scheduled Downtimes for an Endpoint

	
Select the endpoint


	
Open the Downtimes tab.

The name of the schedule is shown, followed by a list of all events specified for that schedule.





To View All Schedules

	
Select Explorer > Schedules from the Navigator.


	
Currently defined schedules are listed in the main pane.


	
The Profile tab shows the definition of any schedule selected in the main pane.





To Remove a Downtime Schedule from one Endpoint

	
Select the endpoint.


	
Choose Modify > Set Endpoint Downtime Schedule.

The Set Endpoint Downtime Schedule tool opens.


	
Choose No Downtimes from the Choose schedule drop-list.


	
Click Apply.





To Delete a Downtime Schedule from All Endpoints

	
In the Navigator, select Schedules.


	
In the summary area, select the schedule you want to delete.


	
Choose Modify > Delete schedule_name.


	
Click Delete.









createOrUpdateGenre

Use the createOrUpdateGenre command to create or update the definition of the indicated service or endpoint genre in the sphere. The genre object provides the information needed to properly display service and endpoint type information such as friendly name and icon.

In general, this command will be used when an observer is released off-cycle. At such times, explicit instructions will be provided about the createOrUpdateGenre command to use to teach your current system how to recognize the new genre and how to display services or endpoints of that type.


Command Syntax


btmcli createOrUpdateGenre -n name -id id
                           -t service | endpoint [iconUrl iconUrl]
                           -overwrite
                           -sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The user visible or friendly name of the genre. By convention this is often the local name of the qualified name used as the genre's id (when the id is given as a QName).
The value specified will be used as the string to display in the Type field for services and endpoints.; for example, WEB_SERVICE, JAXRPC, DATABASE.


	-id	--	The unique identifier for the genre. By convention this is often given as a qualified name with a namespace of urn:com.amberpoint.servicegenres. This value must match the genre identifier returned by the observer when discovering services and/or endpoints. For example: urn:com.amberpoint.servicegenres:JAXRPC
	-t	-type	Indicates whether this genre represents a service type or an endpoint type.
	-iconUrl	--	The URL where the system can find the icon used to represent the genre in the management console.
There will be two icon files for any genre. The file names will be greyTypeIcon.ext and greyTypeOperationIcon.ext, where the value of ext specifies the type of the icon file: gif, bmp, jpeg, or png. The value of Type is either Endpoint of Service.

	
A URL with the prefix asc:// indicates that the icon should be found inside the views/images/genre/urlPath directory of the btmui application.


	
Any other URL will be used directly as the base of the icon file URL.





	-overwrite	--	A switch that specifies whether it is permissible to replace any existing genre of the same id. You must specify this switch when doing an update.
	-s	-sphereUrl	The URL of the sphere where the service whose setup data you want to get is registered. http://hostname:port/btmcentral/sphere/
This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the createOrUpdateGenre command used to create the endpoint type MyGenre.


btmcli createOrUpdateGenre -name MyGenre 
                           -id urn:com.aberpoint.servicegenres:MyGenre
                           -s http://localhost:8080/btmcentral/sphre/
                           -l admin:abracadabra






Backing up and Restoring Business Transaction Management

The following sections explain how you back up and restore your system. The topics covered include the following:

	
About the Back up and Restore Process


	
Backing up Business Transaction Management


	
Restoring Business Transaction Management


	
Data Storage Reference






About the Back up and Restore Process

Oracle Business Transaction Management stores a large amount of data. This data describes the system's configuration, what the system is monitoring, and the current and past states of monitored applications. All of this data is needed for the operation of the system; if something happens that causes this data to be lost or damaged, the system can no longer perform as you expect. This is why it is important to create a backup of the system's data and to be able to recover this data.

You might need to back up Business Transaction Management for different reasons:

	
on a regular basis to enable recovery from unforeseen events


	
before migrating to a new sphere


	
before upgrading an application server in the Business Transaction Management environment or adding an application server


	
before installing a new version of Business Transaction Management




This section offers general guidelines for backup and recovery, and suggests milestones for testing the process you have defined. How often you create a checkpoint by backing up your data depends entirely on the lifecycle stage of your application and on business requirements.

Backing up and restoring Business Transaction Management does not include the backup and recovery of the hosting application server and its configuration settings, some of which Business Transaction Management needs to function properly: JVM settings, Java System parameters, and so on. You should already have processes in place for backing up your application servers and their configurations.


Before You Back Up

Business Transaction Management operates in a complex environment. For this reason, before backing up, it is important to make sure that you can isolate Business Transaction Management components and that you can identify any other systems that might be affected by the backup and recovery process. Consider issues like the following:

	
Databases might be shared with components other than Business Transaction Management. Unless the problem is database failure itself, it is important to restore only those database instances that are used by Business Transaction Management.


	
Recovery might affect other systems. For example, if Business Transaction Management shares JDBC drivers with other applications, recovery might restore a driver to a previous version and cause other applications using the driver to fail.








Testing the Backup and Recovery process

You should test your backup process periodically by attempting a recovery and making sure the system can be brought up to the desired state with no side effects. Identifying and resolving problems with the backup process will ensure successful recovery when recovery matters. Your backup verification checklist should include things like the following:

	
database and file system structure, and permissions are as expected


	
Business Transaction Management is functional and in the expected state: the console shows everything is running, services are reachable, traffic flows normally, and so on.


	
no application sharing the same resources is adversely affected.











Backing up Business Transaction Management

This section describes how Business Transaction Management data is organized, explains how you back up each type of data, and discusses timing issues related to backups.


How Business Transaction Management Data Is Organized

The next figure shows the various kinds of Business Transaction Management data and the Business Transaction Management system services that rely on this data.
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With reference to the figure, the basic principle of backing up data is as follows:

	
All data contained in databases is backed up by backing up the database.


	
All data contained in files or directories is backed up by backing up the btmstorage directory, which can be found on every host where one of the Business Transaction Management system services or monitors is deployed. The location of this directory for your server is specified in Backing up Business Transaction Management Data.




The rest of this section provides more information about elements shown in the previous figure. You do not need to know this level of detail just to do backup and recovery. But this detail might be helpful in troubleshooting and in understanding the resources used by Business Transaction Management. If you want, you can skip ahead to Backing up Business Transaction Management Data.

As the figure shows, Business Transaction Management is composed of multiple system services:

	
The sphere, responsible for the overall operation of Business Transaction Management and coordination of its member services


	
The SLM service, responsible for gathering performance measurements


	
The ExM service, responsible for transaction management


	
Monitor agents, responsible for collecting data from observers




Each of these services depends upon data that specifies the system's configuration, describes what it is monitoring, and records the state of monitored applications. This data can be grouped into the three categories shown in the figure.

	
Definitional metadata is stored in two places and contains the following information: 

The Sphere database contains data that describes Business Transaction Management as well as the monitored user systems. It includes a description of the users' applications, the policies used to monitor them, and transaction definitions.

Monitor agent configuration files contain data that describes whether and how each user endpoint is being monitored.


	
Operational data is the information Business Transaction Management gathers about user applications: performance and behavioral metrics, logged messages, transaction instances, and generated alerts. This information is stored in the Measurement, Transaction, and Agent Message log databases shown in the figure.


	
System configuration data controls the basic behavior of Business Transaction Management: what databases it connects to, the address a container should use to connect to the sphere, default GUI views and layout. This information is saved in various configuration files: initial configuration data, GUI customization, setup data, container registration, and miscellaneous configuration files.









Backing up Business Transaction Management Data

Backing up Business Transaction Management is fairly simple: you back up data contained in databases by backing up the respective database; you back up data contained in files or directories by backing up the btmstorage directory.

The btmstorage directory can be found on every host where one of the Business Transaction Management system services or monitors is deployed. The location varies with your server.

For WebLogic, the location is the following:

WebLogic_InstllDir/user_projects/domains/MyDomain/servers/MyServer/btmstorage

For WebSphere, the location is the following:

WAS_InstallDir/profiles/MyProfile/btmstorage/MyNode/MyServer

Once you have backed up the databases and the btmstorage directory, you are done with the backup process.

In general it is best to back up and recover all data, even if only a subset of your data has been damaged or lost. However, if you would like a more detailed understanding of the individual components used by Business Transaction Management, see Data Storage Reference.





Timing Backups

The timing of backups is important: you should back up the databases and the btmstorage directory as close together in time as possible. If possible, follow these guidelines:

	
Quiesce the system if possible.


	
Back up the btmstorage directories.


	
Back up the databases, with the Sphere data last.











Restoring Business Transaction Management

The goal of restoring Business Transaction Management is to bring it back to the desired state with no side effects. Before you start this process, make sure that you have complete and accurate information about the Business Transaction Management system you are trying to restore.

It is assumed that you are restoring Business Transaction Management to the same environment from where it was backed up. If you need to recover to a different environment, for example, in the case of hardware failure; you will need to change the host name of the machine where you restore to (at the operating system level) to the host name of the machine that failed. You will also need to make sure that Business Transaction Management services hosted on the new machine can run on the same ports as on the old machine. It will then be possible to recover services to the new machine without disruption.

The restore procedure recovers the whole system to the last checkpoint created by the backup process.




	
Note:

After the restore, the database schema and the file system must reflect the state they were in at the time of the backup. To make sure this happens, before you restore, check that the existing database and storage directory is completely clean. Because the data in the two storage locations are connected in various ways, problems can arise if either holds data that is newer than the backed up data. Thus, you should never restore a backup on top of an existing btmstorage directory. Most database restores take care of this issue; be sure yours does.







The restore procedure consists of two steps:

	
Restore databases


	
Restore the btmstorage directory on each server hosting a system service or monitor.




In the case where there is some damage to the Business Transaction Management software itself because something has damaged or corrupted the installed instance, we recommend that you do the following.

	
Reinstall the Business Transaction Management software.


	
Restore the btmstorage directory on each server hosting a system service or monitor agent.


	
Restore the databases.







	
Note:

If the damage affects only the EAR, WAR, or JAR files themselves, a simple re-installation of the Business Transaction Management software is all that is required












Data Storage Reference

The following table offers some additional detail about the Business Transaction Management components. This detail might be helpful to understand the role of each component or to locate specific information.


	Data	Contents	Backup Procedures
	Sphere database	Description of Business Transaction Management system, monitoring and logging policies, transaction definitions, user application definitions.	Use the backup features of the Oracle database to create a backup.
	Monitoring state	Information about whether and how each user endpoint is being monitored.
This data is also replicated in the sphere database; however the monitor agent's configuration file is considered the master source for this information. Although monitoring state data is backed up when you back up the sphere database (and restored when you restore it), that copy does not count, and if you recover an agent without capturing its original monitoring state, your endpoints will end up unmonitored.

	Back up the btmstorage directory.
	Operational data	Information Business Transaction Management gathers about user applications. This data is stored in the Performance Manager's database, the Transaction Manger's database, and the message log database. These might be located on the same physical database, but they are considered to be distinct databases.	Use the backup features of the Oracle database to create backups.
	Initial configuration data	By default, information gathered from the user's initial configuration of Business Transaction Management is saved in the file essentialConfiguration.xml in the directory
WebLogic_InstallDir/user_projects/domains/MyDomain/servers/MyServer/btmstorage/globalPreferences

WAS_InstallDir/profiles/MyProfile/btmstorage/MyNode/MySrvr/DeployEarFileName/globalPreferences

This information includes the location of databases used by Business Transaction Management, deployment credentials, and database type.

	Back up the btmstorage directory.
	UI customization	Information about customizations done by the administrator and preferences and views created by the user. By default, this information is stored in files in the following directories:
WebLogic_InstallDir/user_projects/domains/MyDomain/servers/MyServer/btmstorage/btmui/userPreferences

WAS_InstallDir/profiles/MyProfile/btmstorage/MyNode/MySrvr/DeployEarFileName/btmui.war/userPreferences

	Back up the btmstorage directory.
	Monitor registration	Registration information about monitor agents that you have added to the system.	Back up the btmstorage directory.
	System Service setup	Setup data for each of the Business Transaction Management system services.	Back up the btmstorage directory.
	Miscellaneous scripts and configuration	In the course of configuring Business Transaction Management, you might create various configuration scripts: for example, scripts to configure email subscriptions known to the notifier service or scripts to set up baseline performance values.	Back up the btmstorage directory.
If you have stored scripts anywhere else, back up that directory as well.














moveMeasurements

Use the moveMeasurements command to move the measurements collected for a service or endpoint that has been deleted from the sphere to another endpoint or service that is its logical successor.

Caution: Use this command with care. The system does not check to see that the services or endpoints are actually different iterations of the same object. Once merged, the measurements for the two objects cannot be separated.

When you deploy a new version of a service known to the sphere, and the modified WSDL is registered or discovered, the qualified name of the service defined in the WSDL is expected to match the name of the service found in the WSDL the last time it was read. If there is no match and the service name change option (in the service versioning policy) has a value of "replace the previous endpoints (losing all measurements)," Business Transaction Management deletes the endpoints that were previously read from the WSDL and creates new endpoints belonging to the service currently defined in the WSDL.

If only the namespace or service name defined in the WSDL has changed, the new endpoints might look the same as the old ones (same URL and binding), but they will have a different unique ID. Business Transaction Management depends on this ID to associate measurements with their respective objects; if the ID changes, it leaves measurements made for the old endpoints orphaned and inaccessible. If the service and endpoints defined in the updated WSDL are logically the same, you should use the moveMeasurements command to re-associate the measurements with the new incarnation of the service or endpoint.

Since the old endpoint and service have already been deleted, the old object to move measurements from must be identified by its unique ID. You can determine what the ID of a deleted service is by checking the sphere system log, as follows:

	
Select Administration > System Services in the navigator.


	
Select AP_Sphere_Service in the summary pane.


	
Select Open System Service Log for AP_Sphere_Service from the Admin menu.


	
The Log Viewer is displayed: look for the deleted service, and note its Exchange ID value.




Because no metadata about the deleted object is known to the sphere, this command is limited in the validation it can do. The command will refuse to do anything if the target cannot be found or is not specified uniquely. It will also refuse to move any measurements if the ID specified refers to an extant object that has not been deleted from the sphere.

See Resolving Discovery Issues, for a discussion of the use of this command in resolving discovery issues.


Command Syntax


btmcli moveMeasurements -id id -n friendlyName | -qname qname [-V version]
                        [-e endpointUrl] [-bn bindingName]
                        -s sphereUrl -l username:password



	Name	Long Name	Description
	-id	--	The UUID of the deleted endpoint or service for which to move measurements.
If the system deletes a service or endpoint because a WSDL has changed, it will send a system alert containing the UUID(s). Otherwise, you will need to check the service log for the sphere service (as described above) to get the id.


	-n	-name	The friendly name of the target service where to move measurements.
	-qName	
	The qualified name of the target service where to move measurements.
	-V	-version	The version of the target service where to move measurements. Only required if there are multiple versions of the service.
	-e	-endpointUrl	The URL of the target endpoint to move measurements to.
	-bn	-bindingName	The binding name of the target endpoint. (Only needed if the endpoint URL is not unique.)
	-s	-sphereUrl	The URL of the sphere. http://hostname:port/btmcentral/sphere/
This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following examples show the use of the moveMeasurements command:


btmcli moveMeasurements -id 00EB2838-7E62-11DF-ABB5-27339B5EB390
                        -n MyCreditService
                        -s http://localhost:8080/btmcentral/sphere/
                        -l admin:abracadabra

btmcli moveMeasurements -id CAEAF3FF-C5A7-11DF-80D5-2DF5BB94EBDE
                     -e http://text12.myhost.com:7012/bookmart/ofder/OrderService
                     -s http://localhost:8080/btmcentral/sphere/
                     -l admin:abracadabra






registerDevice

Use the registerDevice command to register a management device with the sphere. Although Business Transaction Management is able to infer the existence of load balancing devices by analyzing message traffic, explicitly registering a device enables the display of its friendly name and of other information, and provides access to the device's administrative interface if any.

Currently, hardware and software load balancers are the only supported device type for this command, and the F5 BigIP is the only fully-supported load-balancer.

In most cases, Business Transaction Management automatically detects and models routing entry points by observing message traffic and reading destination information from the message header. However, if the observed messages do not carry information about their original recipient (the load balancer) in the HTTP Host headers, you will need to manually assign a routing entry point to the load balancer. You will also need to add target entry points to indicate where the messages are being routed. You need to use the Business Transaction Management management console to do this. See Setting up Load Balancers, (setting up a load balancer) for a full discussion.

If you register multiple devices, you can use the setDefaultLoadBalancer command to set the default device. (Any newly discovered routing entry points will be modeled as part of the default device unless they belong to an F5 load balancer.)

To unregister a device, you must use the management console.


Command Syntax


btmcli registerDevice -baseAddress baseAddress -fn friendlyName 
                      -vendor vendor
                      [-administratorUI administratorUI]
                      [-phaseInLifecycle DEBRECATED | deprecated 
                      | DEVELOPMENT | development |PRODUCTION | production
                      | STAGING | staging |TEST | test]
                      -deviceLogin login:password
                      -s sphereUrl -l login:password



	Name	Long Name	Description
	--	-baseAddress	The base address of the URL of your load balancer; for example https://myf5:443/.
	-fn	-friendlyName	The friendly name for your load balancer. This name is displayed in the Business Transaction Management Management Console.
	--	-vendor	If you are registering an F5 BigIP device, specify F5 (case insensitive). When set to this value, the vendor flag is functional.
For other types of load balancers, this flag is required, but it is purely descriptive. You can specify any value (except F5). The specified value is displayed in the Management Console.


	--	-administratorUI	For devices other than F5, the URL of your load balancer's HTML administrative console. The management console uses this URL to display a link to your load balancer's console.
This flag is not required for F5 devices because the URL is automatically obtained.


	--	-phaseInLifecycle	Specifies the lifecycle phase of the device container and all of the endpoints that are created within it. Valid values are deprecated, development, production, staging, and test. These are case insensitive.
	--	-deviceLogin	This flag is required for F5 devices and ignored for other types of load balancers.
The login credentials for the F5 load balancer in the format login:password. A user role of Guest provides sufficient privileges.

If this is a limited-privilege account, Business Transaction Management will discover the objects and policies managed by the device, but you might not be able to modify them using Business Transaction Management.

You can encrypt passwords using the encryptPassword CLI command, for example:

btmcli encryptPassword -password "myPassword"


	-s	-sphereUrl	Required unless you have set the AP_SPHERE_URL environment variable for your sphere.
Specify the URL of the sphere with which you want to register the device; for example:

http://mySphereHost:8080/btmcentral/sphere/

Replace the host name and port number with appropriate values. This URL always ends with btmcentral/sphere/.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows how you use the registerDevice command to register an F5 load balancer.


btmcli registerDevice -baseAddress https://myF5:443
                      -fn MyF5LoadBalancer
                      -vendor F5
                      -phaseInLifecycle development
                      -deviceLogin my_F5_username:my_F5_password
                      -s http://mySphereHost:1771/btmcentral/sphere/
                      -l admin:abracadabra






Business Transaction Management System Security

This section provides information to help you administer Business Transaction Management system security and includes the following subsections:

	
Authentication and Role Mapping


	
Business Transaction Management Application User Roles






Authentication and Role Mapping

Business Transaction Management relies on the application server in which it is deployed for authentication of users. By default, authentication is enabled for the Management Console. To disable authentication, use whatever tool or procedure is appropriate for the application server you are using.




	
Note:

In order to log into the Management Console, you must use credentials that are mapped to at least one of these Business Transaction Management user roles: btmAdmin, btmUser, or btmObserver.







If you disable authentication, users of the Management Console must still log in. However, they can log in using any user name and are not required to provide a password. Note that all UI personalizations, such as edits to the Navigator, filters, and column sets are stored as preferences and associated with the user name.

This topic describes how the supported application servers authenticate users and map them to Business Transaction Management application roles.


Summary of Initial Application Role Mapping


	Business Transaction Management Role	WebLogic Group	WebSphere Group
	btmAdmin	WebLogic Administrators	Administrators (Windows)
adm, sys, bin (Unix-like systems)


	btmUser	WebLogic Operators & Monitors	All authenticated users
	btmObserver	Everyone	All authenticated users
	btmInspector
(Note that the role name is singular while the group name is plural.)

	btmInspectors	btmInspectors









	
Note:

The role btmInspector is, by default, mapped to a group named btmInspectors, but the application server administrator must create a group named btmInspectors and assign it to the appropriate users.











WebLogic

Business Transaction Management applications rely on the WebLogic container for authentication and association of roles with users.





WebSphere

If you installed Business Transaction Management into a WebSphere container, the WebSphere server authenticates users and maps roles to groups. Note that the initial mappings assume that WebSphere security is configured to use Local OS Registry. If you are using a different security setup, you may have to remap users/groups based on your authentication domain settings. You can change these mappings in the WebSphere Administrative Console, on the "Mapping Users to Roles" page. If you change the mappings, you should change them for all Business Transaction Management applications. The names of all these applications (EAR files) begin with the string "btm".








Business Transaction Management Application User Roles

Business Transaction Management uses roles to authorize access to various parts of the user interface.


Primary Roles

Each user must be assigned at least one primary role. The primary roles are:

btmAdmin – users with this role are granted all privileges. These users can use all tools and facilities provided by the Business Transaction Management Console, including the ability to view and create sensitive properties and to view all message content.

btmUser – users with this role have most privileges needed to configure basic monitoring. For example, they can configure monitors; create, edit, and delete policies (does not include system policies); register services; set registry attributes on services and endpoints; and create and edit transactions and conditions. They also have all the privileges of btmObserver. This role does not grant the privilege to modify the Business Transaction Management environment, access message content, or view or edit sensitive properties.

btmObserver – users with this role have privileges to use most of the basic monitoring facilities. They can view summary, dependency, and administrative information about the monitoring system, but are not allowed to configure any of the policies or settings related to it. They can also view transactions and conditions, but are not allowed to create or edit them. This role does not allow users to modify the Business Transaction Management environment, access message content, or view or edit sensitive properties.




	
Note:

All navigation and views in the Management Console are available to all primary roles. However, some roles cannot access certain menus and menu items and the tools associated with them.











Auxiliary Role

In addition to the primary roles, Business Transaction Management defines an auxiliary role. The auxiliary role provides additional privileges that you might want to assign certain users. For example, you might want to let a user access message content but not want to give that user full administrative privileges. You could do this by assigning the user a primary role of btmUser and an auxiliary role of btmInspector. The auxiliary role is:

btmInspector – users with this role can view message content and view and create properties, including sensitive properties.




	
Note:

The btmAdmin role has all of the privileges of btmInspector.
















sendToNotifier

You can use the sendToNotifier command to manage email and web service subscriptions.

The sendToNotifier command sends a command (specified in an XML input file) to the Notifier Service for processing. You can create an email subscription, list existing subscriptions, delete subscriptions, and so forth. The command returns the response document returned by the Notifier Service. To issue additional commands, you must call sendToNotifier again, specifying an input file that contains a different command.

Command syntax for sendToNotifier is fairly simple, but creating the input command document can be complicated.

Business Transaction Management currently supports email and web service subscriptions only through the command line interface.

The command document, described at the end of this section, can contain an xml message (command) that accomplishes one of the following tasks:

	
Create an email subscription


	
Create a subscription to call a notification operation on a web service


	
List existing subscriptions


	
Delete a subscription from the notifier





Command Syntax


btmcli sendToNotifier -i inputFile [-o outputFile] 
                      -s sphereUrl -l username:password



	Name	Long Name	Description
	-i	-inputFile	An XML file containing the command to send to the Notifier Service. Each file can contain one command.
	-o	-outputFile	A file to hold the response from the Notifier Service. If none is specified, the response is sent to stdout.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Setting up Email Notification

The use of sendToNotifier is one step in setting up email notification. The overall procedure also includes the following steps:

	
Select System Services from the Navigator and select AP_Notifier_Service from the services listed in the summary area.


	
Edit its setup data (from the Admin menu) to specify the mail host and the email sender to be used.


	
Use the sendToNotifier command to register a subscription to SLA alerts, condition alerts, and so on. (The input command document will contain a command that specifies which alerts you are interested in.) For example, the following document registers a subscription for condition alerts:


<ap:registerSubscription
   soap:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
 <ap:subscription name="All Exception Alerts" enabled="true" userID="testID">
    <ap:deliveryMechanism> 
      <ap:sendEmail format="long" style="html">
           <ap:from>BTM.TEST@oracle.com</ap:from> 
           <ap:recipient type="TO">your.name@yourdomain.com</ap:recipient> 
      </ap:sendEmail> 
  </ap:deliveryMechanism> 
  <ap:notificationFilters> 
      <ap:source> 
           <ap:value>ExM</ap:value> 
           <ap:operation>in</ap:operation> 
      </ap:source> 
   </ap:notificationFilters> 
  </ap:subscription> 
 </ap:registerSubscription>


	
Define SLA or condition alerts for the objects of interest.








Managing Email Notifications

You can also use sendToNotifier to list subscriptions and delete subscriptions. Here are sample command documents that illustrate how you would do this.

To list subscriptions


<ap:getSubscription xmlns:ap="http://namespace.amberpoint.com/amf"/>


To cancel subscriptions


<ap:cancelSubscription xmlns:ap="http://namespace.amberpoint.com/amf">
 <ap:subscription name="All Exception Alerts" userID="testID"/>
 <ap:subscription name="All SLA Alerts" userID="testID"/>
 <ap:subscription name="All System Alerts" userID="testID"/>
</ap:cancelSubscription>


Examples

The following example shows the sendToNotifier command.


btmcli sendToNotifier -i MyNotifierCommand -o MyNotifierReponse 
               -s http://localhost:8080/btmcentral/sphere -l admin:abracadabra





The Notifier Command Document

A Notifier Service command (xml message) can be included in a command document that is input to the sendToNotifier command. Notifier service commands are described in the following subsections; they allow you to do the following:

	
Create an email subscription


	
Create a web service subscription


	
List subscriptions


	
Delete a subscription


	
Get notification interest


	
Get a template




You may include only one command per document. To execute several commands, you must create a document for each command and invoke the sendToNotifier command for each document.


Notifier Service Commands

The following subsections describe the commands you can include in a Notifier Document.


Create an Email Subscription

This command supports the following variations:

	
Create a subscription for all alerts of a particular type (e.g. system alert, SLA alert, condition alert)


	
Create a subscription for all alerts on a particular object (e.g. transaction, service, endpoint, operation, consumer, system service)


	
Create a subscription for all alerts of a particular severity (e.g. failures and warnings, but not compliance or info alerts)


	
Create a subscription for all alerts generated by a particular policy (e.g. all alerts generated by the Baseline SLA Policy)


	
Create a subscription for all alerts generated by a particular condition (e.g. all condition alerts for the FaultMonitoring condition)




In addition to the sample commands below, you also need to be familiar with the metadata used to specify alert types. This is described in the next subsection.


<ap:registerSubscription xmlns:ap="http://namespace.amberpoint.com/amf"
                xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
                xmlns:xsi="http://www.w3.org/1999/XMLSchema-instance"
                xmlns:xsd="http://www.w3.org/1999/XMLSchema"
                soap:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
 <ap:subscription name="All SLA Alerts" enabled="true" userID="testID">
   <ap:deliveryMechanism>
         <ap:sendEmail format="short" style="text">
           <ap:from>BTM.TEST@oracle.com</ap:from>
           <ap:recipient type="TO">your.email@oracle.com</ap:recipient>
         </ap:sendEmail>
   </ap:deliveryMechanism>
   <ap:notificationFilters>
         <ap:source>
           <ap:value>ASLM</ap:value>
           <ap:operation>in</ap:operation>
         </ap:source>
   </ap:notificationFilters>
 </ap:subscription>
</ap:registerSubscription>


Here is a more detailed example with comments:


<ap:registerSubscription xmlns:ap="http://namespace.amberpoint.com/amf"
             xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
             xmlns:xsi="http://www.w3.org/1999/XMLSchema-instance"
             xmlns:xsd="http://www.w3.org/1999/XMLSchema"
             soap:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
 <ap:subscription name="Warning and Failure SLA Alerts" enabled="true"
                                                          userID="testID">
    <ap:deliveryMechanism>
      <ap:sendEmail format="long" style="html">
        <ap:from>BTM.TEST@oracle.com</ap:from>
        <ap:recipient type="TO">your.name@oracle.com</ap:recipient>
      </ap:sendEmail>
    </ap:deliveryMechanism>
    <ap:notificationFilters>
     <ap:source>
        <ap:value>ASLM</ap:value><!-- subcribe to SLA alerts -->
        <ap:operation>in</ap:operation>
     </ap:source>
     <ap:severity>
      <ap:value>WARNING</ap:value> <!-- subcribe to WARNING and FAILURE alerts -->
      <ap:value>FAILURE</ap:value>
      <ap:operation>in</ap:operation>
     </ap:severity>
    </ap:notificationFilters>
 </ap:subscription>
 <ap:subscription name="Exception Alert transaction OrderService_submit"
                                           enabled="true" userID="testID">
 <ap:deliveryMechanism>
   <ap:sendEmail format="short" style="text">
      <ap:from>BTM.TEST@oracle.com</ap:from>
      <ap:recipient type="TO">your.name@oracle.com</ap:recipient>
   </ap:sendEmail>
 </ap:deliveryMechanism>
 <ap:notificationFilters>
     <ap:event>
      <ap:value>Exception Detected</ap:value> <!-- subscribe to Exception alert
                                                                  event-->
      <ap:operation>in</ap:operation>
     </ap:event>
   <ap:info>
     <ap:name>correlationName</ap:name> <!-- subcribe to tx by friendly name-->
     <ap:value>OrderService_submit</ap:value>
     <ap:operation>in</ap:operation>
   </ap:info>
  </ap:notificationFilters>
 </ap:subscription>
</ap:registerSubscription>




Create a Web Service Description

This command supports the following variations:

	
Create a subscription for all alerts of a particular type (e.g. system alert, SLA alert, condition alert)


	
Create a subscription for all alerts on a particular object (e.g. transaction, service, endpoint, operation, consumer, system service)


	
Create a subscription for all alerts of a particular severity (e.g. failures and warnings, but not compliance or info alerts)


	
Create a subscription for all alerts generated by a particular policy (e.g. all alerts generated by the Baseline SLA Policy)


	
Create a subscription for all alerts generated by a particular condition (e.g. all condition alerts for the FaultMonitoring condition)





<ap:registerSubscription xmlns:ap="http://namespace.amberpoint.com/amf"
    xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"
    xmlns:xsi="http://www.w3.org/1999/XMLSchema-instance"
    xmlns:xsd="http://www.w3.org/1999/XMLSchema"
    soap:encodingStyle="http://schemas.xmlsoap.org/soap/encoding/">
       <ap:subscription name="Dispatch" enabled="true" userID="ABC">
         <ap:deliveryMechanism>
           <ap:callWebService>
              <ap:httpEndPoint>
            <ap:uri>http://10.148.118.72:8080/eProxy/svc/NotifPort_Proxy</ap:uri>
                   <!-- this is my test webService, replace with your own.-->
         <ap:soapAction>ReplaceWithRealSoapActionForDotNetService</ap:soapAction>
              </ap:httpEndPoint>
           </ap:callWebService>
         </ap:deliveryMechanism>
         <ap:notificationFilters>
            <ap:source>
                           <ap:value>ASLM</ap:value>
                           <ap:value>ExM</ap:value>
                           <ap:value>System</ap:value>
                           <ap:operation>in</ap:operation>
           </ap:source>
        </ap:notificationFilters>
    </ap:subscription>
 </ap:registerSubscription>



Get Subscriptions

This command supports the following variations:

	
List all email subscriptions


	
List all web service subscriptions


	
List all subscriptions for a particular email address


	
List all web service subscriptions for a particular web service


	
List all subscriptions for a particular object (transaction, service, endpoint, operation, system service, consumer)




Here are some examples for these actions:

Get all subscriptions


<ap:getSubscription xmlns:ap="http://namespace.amberpoint.com/amf"/>


Get subscriptions by subscription name


<ap:getSubscription xmlns:ap="http://namespace.amberpoint.com/amf">
         <ap:subscription name="Dispatch"/>
</ap:getSubscription>


Get subscriptions by user name


<ap:getSubscription xmlns:ap="http://namespace.amberpoint.com/amf">
    <ap:subscription userID="mary"/> 
</ap:getSubscription>



Cancel Subscription

This command supports the following variations:

	
Delete all subscriptions for a particular email address


	
Delete all web service subscriptions for a particular web service


	
Delete all subscriptions on a particular object (e.g. transaction, service, endpoint, operation, system service, consumer)




For example,


<ap:cancelSubscription xmlns:ap="http://namespace.amberpoint.com/amf">
          <ap:subscription name="Dispatch" userID="mary"/> </ap:cancelSubscription>



Get Format Information

This command returns available formats such as "long HTML", "short text." The following is sample output for the command:


<ap:getFormatInformationResponse xmlns:ap="http://namespace.amberpoint.com/amf"
 xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/"> 
 <ap:for value="Email" xmlns:ap= "http://namespace.amberpoint.com/amf">
   <ap:format value="long"xmlns:ap="http://namespace.amberpoint.com/amf"/> 
   <ap:format value="short" xmlns:ap="http://namespace.amberpoint.com/amf"/>
   <ap:style value="html" xmlns:ap="http://namespace.amberpoint.com/amf"/> 
   <ap:style value="text" xmlns:ap="http://namespace.amberpoint.com/amf"/> 
  </ap:for> 
</ap:getFormatInformationResponse



Get Notification Interest

Use a command like the following:


<ap:getNotificationInterest xmlns:ap="http://namespace.amberpoint.com/amf"/>



Get Template

Use a command like the following:


<ap:getTemplate/>





Metadata for Alert Types

You will need to be familiar with metadata for SLA, Exception, and system alerts. You use this information to properly format a subscription for a particular type of information. Metadata information is shown in the following tables.


Metadata for SLA Alerts

The following table specifies metadata for SLA alerts.


	Metadata	Available values	Sample subscription
	(header) source	ASLM	

<ap:notificationFilters> 
  <ap:source> 
   <ap:value>ASLM</ap:value>
   <ap:operation>in</ap:operation> 
  </ap:source> 
</ap:notificationFilters>


	(header) event	enforcement_condition	

<ap:notificationFilters> 
   <ap:event> 
      <ap:value>enforcement_condition</ap:value> 
      <ap:operation>in</ap:operation> 
   </ap:event> 
</ap:notificationFilters>


	(header) severity	WARNING
FAILURE

SUCCESS

INFO

	

<ap:notificationFilters> 
   <ap:severity>
      <ap:value>WARNING,FAILURE</ap:value>
      <ap:operation>in</ap:operation> 
   </ap:severity> 
</ap:notificationFilters>


	(header) templateSet	ASLM-Template	

<ap:notificationFilters> 
   <ap:templateSet>
      <ap:value>ASLM-Template</ap:value>
      <ap:operation>in</ap:operation>
    </ap:templateSet> 
</ap:notificationFilters>


	(info) com.amberpoint.notification.enforcementValue	(value of SLA enforcement that triggered the alert)	

<ap:notificationFilters> 
  <ap:info> 
     <ap:name>com.amberpoint.notification.
                         instrumentName</ap:name>
     <ap:value>85</ap:value>
     <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.instrument
Name

	(qualified name of instrument)	See Note below table.
	(info) com.amberpoint.notification.objectType	Service, Endpoint, Transaction	

<ap:notificationFilters> 
  <ap:info>
    <ap:name>com.amberpoint.notification.
                            objectType</ap:name> 
    <ap:value>Service</ap:value> 
    <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.objectId	(UUID of the object that SLA policy is applied on)	

<ap:notificationFilters> 
  <ap:info>
    <ap:name>com.amberpoint.notification.
                            objectId</ap:name>
    <ap:value>uuid:DA936829-98FF-11DF-828B-
                      A3EAF532919E</ap:value>
    <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.policyId	(UUID of the SLA policy)	

<ap:notificationFilters> 
  <ap:info> 
    <ap:name>com.amberpoint.notification.
                                policyId</ap:name>
    <ap:value>uuid:896FCF93-9900-11DF-8753-
                           57E6CFA43E9B</ap:value>
    <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.senderId	(UUID of the AP_Enforcer_Service)	

<ap:notificationFilters> 
  <ap:info>
     <ap:name>com.amberpoint.notification.
                              senderId</ap:name>
     <ap:value>uuid:896FCF93-9900-11DF-8753-
                         57E6CFA43E9B</ap:value>
     <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.senderUrl	(Location of AP_Enforcer_Service)	

<ap:notificationFilters> 
  <ap:info> 
     <ap:name>com.amberpoint.notification.
                              senderUrl</ap:name>
     <ap:value>http://localhost:8080/
                btmperformance/endorcer</ap:value>
     <ap:operation>in</ap:operation> 
   </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.transaction
Id

	UUID of transaction (only if the SLA is applied on a Transaction)	

<ap:notificationFilters> 
  <ap:info>
      <ap:name>com.amberpoint.notification.
                          transactionId</ap:name>
      <ap:value>uuid:896FCF93-9900-11DF-8753
                          -57E6CFA43E9B</ap:value>
      <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) endpointId	(UUID of AP_Enforcer_Service system endpoint)	

<ap:notificationFilters> 
  <ap:info>
    <ap:name>com.amberpoint.notification.
                              endpointId</ap:name>
    <ap:value>uuid:896FCF93-9900-11DF-8753-
                           57E6CFA43E9B</ap:value>
    <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) serviceID	(UUID of AP_Enforcer_Service)	

<ap:notificationFilters> 
  <ap:info>
     <ap:name>com.amberpoint.notification.
                               serviceId</ap:name>
     <ap:value>uuid:896FCF93-9900-11DF-8753-
                           57E6CFA43E9B</ap:value>
     <ap:operation>in</ap:operation>
  </ap:info> 
<ap:notificationFilters>








Sample subscription for (info) com.amberpoint.notification.instrumentName is as follows:


<ap:notificationFilters> 
  <ap:info> 
     <ap:name>com.amberpoint.notification.instrumentName</ap:name>
     <ap:value>http://schemas.amberpoint.com/instruments/transactions/
                                      types:startedTransactionCount</ap:value> 
     <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>



Metadata for Condition Alerts

The following table specifies metadata for condition alerts.


	Metadata	Available values	Sample subscription
	(header) source	ExM	

<ap:notificationFilters> 
  <ap:source> 
     <ap:value>ExM</ap:value> 
     <ap:operation>in</ap:operation> 
  </ap:source> 
</ap:notificationFilters>


	(header) event	Exception Detected	

<ap:notificationFilters> 
  <ap:event> 
    <ap:value>Exception Detected</ap:value>
    <ap:operation>in</ap:operation> 
  </ap:event> 
</ap:notificationFilters>


	(header) severity	FAILURE,
WARNING,

INFO

	

<ap:notificationFilters> 
  <ap:severity> 
    <ap:value>WARNING</ap:value>
    <ap:operation>in</ap:operation> 
  </ap:severity> 
</ap:notificationFilters>


	(header) templateSet	Exm-Template	

<ap:notificationFilters> 
  <ap:templateSet> 
     <ap:value>Exm-Template</ap:value>
     <ap:operation>in</ap:operation> 
  </ap:templateSet> 
</ap:notificationFilters>


	(info) com.amberpoint.notification.objectType	Transaction	

<ap:notificationFilters> 
  <ap:info>
   <ap:name>com.amberpoint.notification.objectType</ap:name>
   <ap:value>Transaction</ap:value>
   <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.objectId	(UUID of Transaction)	

<ap:notificationFilters> 
 <ap:info>
  <ap:name>com.amberpoint.notification.objectId</ap:name>
  <ap:value>uuid:896FCF93-9900-11DF-8753-57E6CFA43E9B
                                          </ap:value>
  <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.transactionId	(UUID of Transaction)	

<ap:notificationFilters> 
 <ap:info>
  <ap:name>com.amberpoint.notification.transactionId</ap:name>
  <ap:value>uuid:896FCF93-9900-11DF-8753-57E6CFA43E9B
                                                   </ap:value>
  <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) correlationName	(Friendly name of function)	

<ap:notificationFilters> 
 <ap:info> 
   <ap:name>correlationName</ap:name>
   <ap:value>testTransaction1</ap:value>
   <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) detectionTime	(Human readable time stamp. E.g. Thu Jul 22 12:25:49 PDT 2010)	

<ap:notificationFilters> 
 <ap:info> 
   <ap:name>detectionTime</ap:name> 
   <ap:value>Thu Jul 22 12:25:49 PDT 2010</ap:value>
   <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) exceptionPriority	failure, warning, informational	

<ap:notificationFilters>  
 <ap:info> 
   <ap:name>exceptionPriority</ap:name>
   <ap:value>warning</ap:value>
   <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) exceptionTemplate	(friendly name of condition)	

<ap:notificationFilters> 
  <ap:info> 
    <ap:name>exceptionTemplate</ap:name>
    <ap:value>condition2</ap:value>
    <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) exceptionType	(name of transaction + name of condition Or name of service + name of condition)	

<ap:notificationFilters> 
 <ap:info> 
   <ap:name>exceptionType</ap:name>
   <ap:value>testTransaction1+condition2</ap:value>
   <ap:operation>in</ap:operation> 
 </ap:info> <ap:notificationFilters>


	(info) exceptionsURL	(URL that links back to the exception instance UI page)	

<ap:notificationFilters> 
 <ap:info> 
   <ap:name>exceptionsURL</ap:name>
   <ap:value>http://localhost:8080/btmui</ap:value>
   <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) instanceID	(UUID of exception instance)	

<ap:notificationFilters> 
 <ap:info> 
   <ap:name>instanceId</ap:name>
   <ap:value>uuid:896FCF93-9900-11DF-8753-57E6CFA43E9B
                                              </ap:value> 
   <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>









Metadata for System Alerts

The following table specifies metadata for system alerts.


	Metadata	Possible values	Sample subscription
	(header) source	System	

<ap:notificationFilters> 
  <ap:source> 
     <ap:value>System</ap:value> 
     <ap:operation>in</ap:operation> 
  </ap:source> 
</ap:notificationFilters>


	(header) event	business_object_creation	

<ap:notificationFilters> 
  <ap:event> 
     <ap:value>business_object_creation</ap:value>
     <ap:operation>in</ap:operation> 
  </ap:event> 
</ap:notificationFilters>


	(header) severity	INFO	

<ap:notificationFilters> 
   <ap:severity> 
      <ap:value>INFO</ap:value> 
      <ap:operation>in</ap:operation> 
   </ap:severity> 
</ap:notificationFilters>


	(header) templateSet	System-Template	

<ap:notificationFilters> 
   <ap:templateSet> 
     <ap:value>System-Template</ap:value>
     <ap:operation>in</ap:operation> 
   </ap:templateSet> 
</ap:notificationFilters>


	(info) com.amberpoint.notification.senderId	(UUID of service that sends out this alert.)	

<ap:notificationFilters> 
 <ap:info> 
  <ap:name>com.amberpoint.notification.senderId</ap:name> 
  <ap:value>uuid:896FCF93-9900-11DF-8753-57E6CFA43E9B</ap:value>
  <ap:operation>in</ap:operation> 
 </ap:info> 
<ap:notificationFilters>


	(info) com.amberpoint.notification.senderUrl	(Location of service that sends out this alert.)	

<ap:notificationFilters> 
  <ap:info>
    <ap:name>com.amberpoint.notification.senderUrl</ap:name>
    <ap:value>http://localhost:8080/btmperformance/endorcer
                                                  </ap:value> 
    <ap:operation>in</ap:operation> 
  </ap:info> 
<ap:notificationFilters>
















Viewing Discovered Containers

Discovery displays information about containers hosting Business Transaction Management system services and hosting observed components. This section describes the information available about a container. It also explains how you edit container profile information and how you unregister a container.


Viewing Container Information

You can view container information from the Explorer > Container view or from the Maps> Container Map view.

To view a container map:

	
Select Maps >Container Map in the Navigator.


	
Float-over help specifies the host name for each container. Pass your cursor over the containers to display the help.


	
Opening the Tabs area and clicking on a container icon displays the Profile and Services tabs for the container. See the next section for a description of the tab contents.








Viewing Summary and Detail information

To view summary information about discovered containers and their contents:

	
Select the Explorer > Containers view in the Navigator. Information about discovered containers is shown in the main area. By default Business Transaction Management shows information about all known containers. Use the Filter control to filter the displayed information about containers.


	
Click the plus icon by the container name to display the contents of the container. This allows you to view the application components hosted in the selected container.


	
Click the plus icon by the component name to view the operations that make up that component. The operations are listed in a tree view under the container.




To view detail information about a discovered container:

	
Select the container in the main area.


	
Double click the container name. Two tabs are shown in the details pane: Profile and Services.


	
The Profile tab displays information about the container and the deployed observer; the table below describes the fields of the Profile tab. User-defined fields can be filled in by editing profile information.


	
The Services tab displays information about the services running in this container.





	Field	Description
	Notes	User-defined field. Specify any information that helps you understand the use or contents of the container
	Base address	The http-based address (entry point) for this container
	Aliases	All the IP addresses by which the container might be known to the Sphere. This might include VPN adapter address, user-defined aliases, or other addresses Business Transaction Management discovers by observing message traffic to the container. This information is useful in investigating improper setup of the container.
	Container Type	The container type and version number.
	OS	The operating system and version
	Host	The host name where the server is running.
	Identifier	Unique identifier for this object in Business Transaction Management.
	Administration UI Console	User-defined field: URL of administrative console for the container. You can use this link to launch the console Although Business Transaction Management supplies a value for this address, it might not be accurate and should certainly be changed if the console is moved. You can change this value by editing the container profile.
	Monitoring Details	Information about the observer deployed in the specified container and dates for last discovery, registration, synchronization with the Sphere, and version.
	Contact information	User-defined field to provide contact information for the server administrator or other support personnel.
	Routing details	Information about any load balancers observed routing messages to the container









Editing Container Profile Information

To edit container profile information.

	
Select the container in the container map area or in the main area.


	
Select the Modify > Edit Profile for <container> item.


	
Change any of the editable fields (shown in yellow).


	
Click Apply.








Unregistering a Container

Unregistering a container removes the container and all discovered serves deployed in the container from the sphere registry. You might need to do this after completing one of the following tasks:

	
Moved a container to another sphere.


	
Uninstalled the Business Transaction Management observer from a container.


	
Uninstalled or physically removed the container from your system.




You should unregister the container only after you have completed one of these tasks. Otherwise, an unregistered container will register itself upon startup if nothing has changed.

	
Select the container in the Maps > Container Map view or in the Explorer > Container view.


	
Select DeleteContainerNameRegistration from the Modify menu.


	
Click Delete.











retrieveObjectData

The retrieveObjectData command retrieves profile and measurement data for one or more objects. You can use this command's output file in the following ways:

	
Input to a reporting tool.




Business Transaction Management provides Oracle BI Publisher templates that you can use with the command's output file to produce formatted reports. See Chapter 8, "Creating Reports," for more information on using these templates.

	
Input to the setBaseLines command.




In this case, you set performance baseline values for a set of objects by using the output file of retrieveObjectData as an input file to setBaselines. Setting baselines enables you to then create a baseline SLA policy. (Do not set the retrieveObjectData command's attribute if you are using the output file to set baselines.)

Command syntax


btmcli retrieveObjectdata -t type1 [[type2] ...] [-query filterQuery]
           [-attributeNames attrName1 [attrName2] ... instrName1 [instrName2] ...]
           [-segments segment1 [segment2] ...] 
           [-inTheLast inTheLast] | [-startTime startTime] [-endTime endTime]
           [-intervalSize intervalSize] 
           [-format XML|CSV|SQL] 
           [-o outputFile] 
           [-metadata drop|create|none] [-tableName tableName] 
           -s sphereUrl -l username:password


You can use the listInstruments command to get the information about attributes, segments, and instruments that you must pass as arguments to the retrieveObjectData command. If you specify a list of attributes and a list of segments, the command parser applies each segment to any instrument in the attribute list that has that segment.

If no time values are specified, the last hour's data is retrieved in a single segment.


	Name	Long Name	Description
	-t	-type	Specifies the object tree whose data is to be retrieved.
At a minimum a root object type must be given that determines (along with the query) which objects will be retrieved.

In addition to this, you can specify any number of 'child' types. These trees mirror those found in the custom data explorer. An example type tree is 'service endpoint operation' or 'observer probe endpoint'.


	-query	-filterQuery	Limits the objects to be retrieved to the set defined by the query filter.
The query must apply to the root object type of the tree. Only those objects that match the given query will be returned in the result set, along with the associated objects in the sub-tree.

Use the Filter tool to construct AQL queries, and then copy and paste these into the command line.


	--	-attributeNames	Use this argument to specify which attribute and instrument values to retrieve for each object, for example:
-attributeNames friendlyName averageResponseTime

In this example, friendlyName is an attribute and averageResponseTime is an instrument. You can specify multiple attribute names (separated by spaces) followed by multiple instrument names (separated by spaces).

Attribute names can refer to any attribute that is available in the column chooser. Attributes can be qualified by an object type followed by two colons ('::'), for example:

Endpoint::friendlyName

If you specify a qualified attribute name, attribute values are retrieved for only the specified object type (in the example, that would be the friendly names of only endpoints). If you specify an unqualified attribute name, attribute values are retrieved for all object types listed in the type argument that have that attribute (for example, endpoints, services, and operations). See Attribute Names, for a complete list of commonly used attribute names and object types.

For a complete list of instrument names, run the listInstruments command.


	-segments	--	Specifies the segments to use when retrieving the data for any specified measurement attributes (instruments). This provides a breakdown of the data for each specific value of the named segment that was recorded during the specified time-frame.
	-inTheLast	--	Specifies a time range extending from the current time back into the past by the indicated amount.
The value is given as a number followed by a unit (s, S = seconds; m, M = minutes; h, H = hours; d, D = days) e.g. "1H" for "1 Hour".


	-startTime	--	Specifies the start of a time range over which to produce values for any specified measurement attributes (instruments). If 'endTime' is not specified, the range ends at the current time.
The current default date format is used, e.g. "2010-08-03 15:00:00".


	-endTime	--	Specifies the end of a time range over which to get values for any specified measurement attributes (instruments).
The current default date format is used, e.g. "2010-08-03 18:00:00".


	--	-intervalSize	Indicates the size of the intervals into which the specified time range is to be divided.
The interval size is given as a number followed by a unit (s, S = seconds; m, M = minutes; h, H = hours; d, D = days) e.g. "1H" for "1 Hour". The interval size must be less than or equal to the length of the specified time range.

If this optional argument is not specified the entire time range will be used and only a single interval is returned.

Note: Do not set this attribute if you are using the output file as input to the setBaselines command. The setBaselines command cannot accept more than one value per instrument type per object. Omitting this attribute ensures that only one value per instrument type per object is output.


	-format	--	Specifies the format of the output file. Legal values are XML, CSV, and SQL. XML is the default format.
	-o	-outputFile	Name of the output file.
	-metadata	--	Specifies whether SQL metadata commands are created.
Valid values are "drop" to drop and create the table, and "create" to only create the table.


	-tablename	--	Specifies the SQL table name used for SQL output; if no name is specified then a name is generated.
	-s	-sphereUrl	The URL of the sphere. For example, http://hostname:port/btmcentral/sphere/
This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.








Example 1: Retrieving data for containers.


btmcli retrieveObjectData
         -t container
         -s http://myHost:7003/btmcentral/sphere/
         -l my_sphere_username:my_sphere_password
         - my_containers_output.xml


Example 2: Retrieving the average response time for each service for purposes of reporting (note that -intervalSize is specified).


btmcli retrieveObjectData
         -t service
         -s http://my_host:7003/btmcentral/sphere/
          -l my_sphere_username:my_sphere_password
          -attributeNames firendlyName averageResponseTime
          -inTheLast 24h
          -intervalSize 1h
          -format xml
          -o my_avg_response_time_output_for_reporting.xml


Example 3: Retrieving the average response time for each service, endpoint, and operation for purposes of setting baselines (note that -intervalSize is not specified).


btmcli retrieveObjectdata
          -t service endpoint operation
          -s http://my_host:7003/btmcentral/sphere/
          -l my_sphere_username:my_sphere_password
          -attributeNames friendlyName averageResponseTime
          -inTheLast 24h
          -o my_avg_response_time_output_for_baselines.xml






Getting to Know the Management Console

The Business Transaction Management console displays information about the objects known to the sphere and allows you to access tools for monitoring and managing these objects. The information is presented using different types of views; these include dashboards, charts, maps, graphs, and tables. This section introduces the main areas of the console: the Navigator, the main area, the tabs area, and the main menu.

When you first install Business Transaction Management, the console offers you a set of default views of the objects in the sphere. You can create additional views and save these views to make it easier to access the objects and instruments that interest you. In addition, you can use the custom data explorer to view any object in the system in relationship to any other object.

After you have read through this section, continue reading through the rest of this chapter to learn about the following:

	
controls used in each type of view


	
interpreting default views


	
modifying views


	
creating new views




In addition to using the console, you can also use the Business Transaction Management Command Line Interface (CLI) to issue management commands from the command line or through the use of scripts. You use CLI commands to configure the system, manage DNS aliases, resolve replication issues, register services, manage metadata, control monitoring, apply policies, migrate data, or generate data needed for reporting.



General Console Design

The figure below shows the main areas of the mangement console.

[image: Description of audi_console_areas.gif follows]




The following sections describe each area in some detail. Here is a brief summary:

	
The Navigator provides a list of views that are available by default. Selecting one of these items displays all objects of this type in the main area.


	
The main area displays the view selected in the navigator. Double clicking any item in the main area opens the tabs area if it is not already opened, and displays detailed information about that item. The main area includes controls at the top that you can use to filter the objects displayed.


	
The menus provide actions that you can perform on the item selected in the main area, or it provides actions unrelated to the selected item, like creating a new object, or performing some administrative action.


	
The tabs area provides additional information about the item selected in the main area.








The Navigator

The navigator is a facilitator that allows you to quickly get to the objects and relationships that interest you. The default navigator sections are the following (they are normally displayed in their expanded form):

[image: Description of navigator_abbrev_audi.gif follows]




The navigator includes two kinds of controls:

	
A minimizing control (arrow) in the upper right hand corner. Click this control to collapse the Navigator, which allows more room for the main area.


	
Expansion controls (triangles) to the left of each view name that you can click to expand and view category contents.




Note that each item in the Explorer view contains a numeric value in parenthesis; this indicates the number of such objects known to the sphere. If you were to filter the corresponding main view to show fewer items, the number shown in the Navigator would remain unchanged.

The table below summarizes the contents of the default Navigator categories.


	Category	Description
	My Views	A list of any views you have modified or created that you have saved.
	Dashboards	A dashboard is a heterogenous view comprised of smaller views, typically used to summarize information of interest. It provides a summary view of the state of the system and monitored objects.
By default, the console provides three dashboards: one that summarizes the operational health of the system, and two that provide summary information for the top ten services and transactions.


	Maps	Graphical views of services and their dependencies, and of containers.
	Explorer	Tabular views of monitored and non-monitored objects and their relationships. Also includes the custom data explorer, which allows you to view any object in the sphere in relation to other objects.
	Alerts in the last hour	Tabular views of all alert types: SLA, condition, and system.
	Administration	Tabular views of system service containers, system services, system policies, monitors, and unassigned endpoints.









Main Area

For any item selected in the Navigator, except those in the Dashboards and Maps categories, the main area displays a tabular view and, just above the table, a series of controls that you can use to filter the columns and the number of items shown. Here is an example of what is shown in the main view when Containers is selected in the Navigator.

[image: Description of main_view_example_audi.gif follows]





Use the up/down control in the lower right hand corner of the main area to open and close the tabs area. You can control the size of the main area by moving the slider control bordering the main area and the tabs area.





Menus

Menu items relate directly to the item currently selected in the main area or the tabs area. You might think of the items in the main or tabs area as the nouns and of the menu items as the verbs. Thus, selecting a menu item will result in taking some action that affects the item selected in the main or tabs view.

Although menu items are never hidden, they might be disabled if the operation cannot be applied to the current selection, if the currently selected object is not in an appropriate state, or if the user is not authorized to operate on the target. Look here for additional information about user roles.





Tabs Area

The tabs area is organized into tabbed panels. The tabs shown vary with the item selected in the summary area.

Use the arrow control in the lower right hand corner of the main area to collapse the tabs area. You can expand it again either by double clicking an item of interest in the main area or by clicking the up arrow at the bottom right hand corner of the summary pane.





Object Detail Window

The console provides access to an inspector window or a separate window that includes the tabs area for the selected object. This view is available for any object or area that shows a tear off control (magnifying glass). Clicking the control opens a separate window with additional detail information about the selected item. The information shown varies with the selected object.








removeNode

Use the removeNode command to delete information about the specified node from the sphere database. Removing a node deletes all information related to that node including its aliases.

Removing a node is not something you would normally need to do unless aliases for different machines have gotten so mixed up that you face the choice of pruning nodes or reinstalling the system. Under most circumstances (bad hosts file corrected, DNS alias changed to point to a different machine), removing an alias from one node and adding it back to a different node should be all that you need to do.


Command Syntax


btmcli removeNode -n nodeName -alias aliasName
                  -s sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The canonical name of the network node. Typically a fully-qualified domain name. For example, jbujes-myPC.edgility.com
	-f	-force	Forces the node to be removed even if it is still referenced by containers or entry points.
If you assign this node's aliases to another network node before you remove this node, you can enable a container to associate itself with a different node.


	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the removeNode command.


btmcli removeNode -n jbujes.edge.com
                  -s http://localhost:8080/btmcentral/sphere/
                  -l username:password






Manually Registering a Service

Normally, if a service is not under direct observation, it cannot be discovered or monitored. But you can manually register a service, display it, and obtain measurements for calls going out to it.

You should register a service if you will have outgoing calls to the service but cannot install an observer on the service's container. Once you register the service, the system will be able to record measurements and log messages that are observed on the client side of the message exchange.

After registering the service, you might want to use the registerExternalContainer command to group its endpoints into an external container. Otherwise, by default, manually registered endpoints are allocated to the System container, and are displayed under the Unassigned Endpoints node.

To register a service

	
Choose Admin > Register > Service WSDL from the main menu.


	
Specify the URL of the service's WSDL and click Next.


	
Specify the name by which the service will be registered with the sphere. By default, the name is extracted from the WSDL definition; you can use an alternate name if you like.


	
Optionally, specify a version for the service.


	
Click OK.




The service should now be listed in the summary area of the Services to Endpoints or Services to Operations view.






Features

Using Business Transaction Management, a component of the Oracle Management packs, you can do the following:

	
discover the services deployed in your application environment and understand how they work together


	
define and track transactions, and understand the business context of each transaction, including the transaction's consumers and business payload


	
monitor the performance of services and transactions in real time


	
define service-level agreements to set performance targets based on business criteria and to monitor performance relative to those targets


	
generate alerts that warn you of unusual conditions


	
monitor failures and perform root-cause analysis to locate bottlenecks, errors, and incomplete transactions




You access the Business Transaction Management feature set by way of the Management Console. For information about using the console, read Chapter 2, "Using the Management Console."

You can also use a command line interface (CLI) to execute scripts and individual commands. For information about using the CLI, see Chapter 9, "Commands and Scripts."






setDefaultLoadBalancer

Use the setDefaultLoadBalancer command to set the default device used to model routing entry points discovered from observed message traffic.

In a simple environment with only one known load-balancer, that device is automatically used as the default. If you register additional devices, use this command to set which device should be used to model routing entry points.

See Setting up Load Balancers, for a complete discussion of load balancers and how the default is set.


Command Syntax


btmcli setDefaultLoadBalancer -baseAddress baseAddress | -fn friendlyName
                              -s sphereURL -l username:password



	Name	Long Name	Description
	--	-baseAddress	The base address of the URL for the load balancer. For example, https://myf5:443/
	-fn	--	The friendly name of the load-balancer in the sphere. This name is displayed in the summary pane when you select Devices from the navigator. It is the name you assigned when you registered the load balancer.
	-s	-sphereUrl	Required. The URL of the sphere with which you want to register the container.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example specifies the default routing device:


btmcli setDefaultLoadBalancer -baseAddress https://myF5:443/ 
                 -s http://localhost:8080/btmcentral/sphere -l admin:abracadabra






unregisterMonitor

Use the unregisterMonitor command to unregister the specified monitor from the sphere.

Use this command only when the monitor has been taken offline permanently. Monitors must be offline long enough for the system to mark them down before you can unregister them.

Unregistering a monitor agent has the following consequences:

	
Any monitored endpoints associated with the monitor will be unmonitored.


	
Measurements for unmonitored endpoints will be lost; use this command only when the monitor has been taken offline permanently.





Command Syntax


btmcli unregisterMonitor -baseAddress address  | -fn friendlyName
                         - s sphereUrl -l username:password



	Name	Long Name	Description
	--	-baseAddress	The base address of the monitor in the sphere. For example,
http://localhost:8080/btmmonitor/agent/agent


	-fn	-friendlyName	The friendly name of the monitor agent to unregister.
If the friendly name is not unique, you must use the -baseAddress option instead.


	-s	-sphereUrl	The URL of the sphere where the WSDL is installed.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example unregisters the monitor with the specified base address.


btmcli unregisterMonitor -base address
                               http://localhost:8080/btmmonitor/agent/agent 
              -s http://mydomain.com/btmcentral/sphere/ -l admin:abracadabra






importProfile

Use the importProfile command to import a previously object profile into the system. The profile data to import is taken from the specified input file or from stdin if no file is specified.

Importing a profile does not cause new objects to be created, but only updates the profile attributes of existing objects. For example, importing a service profile does not create the service or register it with the system, it only updates the profile for a service that has already been registered (by virtue of discovery or manual registration).


Command Syntax


btmcli importProfile [-i importFile] [-m EXACT | BEST_FIT}
                     -s sphereUrl -l username:password



	Name	Long Name	Description
	-i	-inputFile	The name of the file containing the profile data to be imported. If not specified, the command imports data from stdin.
	--	-match	Use when importing the profile for a set of related objects to specify how closely the imported set must match the objects that currently exist in the system. The possible values are:
	
EXACT - the imported profile must match the existing objects exactly in both cardinality and structure.


	
BEST_FIT - the imported profile will be matched against the existing objects as best as possible. Any mismatches in either cardinality or structure are ignored. This is the default value.





	-s	-sphereUrl	The URL of the sphere. http://hostname:port/btmcentral/sphere/
This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Examples

The following example shows the importProfile command used to import data from MyContainers.


btmcli importProfile -inputFile MyContainers -match EXACT
                     -s http://localhost:8080/btmcentral/sphere/
                     -l admin:abracadabra






importPolicyTemplates

Use the importPolicyTemplates command to import the policy templates contained in a previously created export file. The policy templates to import are taken from the file provided by the -i parameter, or from stdin if no such file is specified.

By default, this command replaces all existing templates that are older than the imported templates.

Command syntax


btmcli importPolicyTemplates [-i inputFile]
                      [-replace ALL | all | NEWER | newer | NONE | none]
                      [-v] -s sphereUrl -l username:password



	Name	Long Name	Description
	-i	-inputFile	The name of the file containing the data to be imported.
	-replace	-replacementLevel	Determines the outcome when an imported policy template matches an existing policy template in the system:
ALL: replace all existing policy templates.

NEWER: replace existing policies that are older than imported policy templates. (Default.)

NONE: do not replace any existing policy templates.


	-v	-verbose	Display more detailed information about command execution.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the importPolicyTemplates command used to import data from MyPolicyTemplates.


btmcli importPolicyTemplate -inputFile MyPolicyTemplates -replace NONE
                            -s http://localhost:8080/btmcentral/sphere/
                            -l admin:abracadabra
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exportProfile

Use the exportProfile command to export the profile values for the specified object(s). The resulting profile information is either written to the specified file, or to stdout if no file is provided. Specify the object(s) to be exported by specifying their type and then either their name or id.

You can use the importProfile command to import the resulting XML file into another sphere.


Command Syntax


btmcli exportProfile -t objectType
                     [-n name] [-v version] | [-id id]
                     [-o fileName]
                     -s sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The name of the object whose profile you want to export.
	-t	-type	The type of the object whose profile you want to export. Type can be one of the following: deployment, service, interface, endpoint, container, DEPLOYMENT, SERVICE, INTERFACE, ENDPOINT, or CONTAINER.
	-V	-version	The version of the service object whose profile you want to export.
	-id	--	The sphere ID of the object whose profile data you want to export.
	-o	-outputFile	Specifies a file into which the results of the export will be placed.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following command exports profile information for all containers.


btmcli exportProfile -t CONTAINER -o C:\Home|myContainers
                     -s http://localhost:8080/btmcentral/sphere/ -l admin:pass






encryptPassword

Use the encryptPassword command to convert the specified text string using the Business Transaction Management encryption engine and to write the resulting encrypted password to standard output.

You can then copy and paste the output string to provide credentials to commands that require them.


Command Syntax


btmcli encryptPassword -password aPlainTextPswd



	Name	Long Name	Description
	-password	--	A text string that you want to encrypt using the Business Transaction Management encryption engine.
Each encrypted output of the same text string provides a unique ciphertext string.









Example


btmcli encryptPasword -password "abracadabra"






Viewing Logged Messages and Properties

You can use the Message Log tab for a transaction to view the following information:

	
If instance logging is enabled, you can view information about each message logged in a specified time period as well as the value of any property associated with a message. You can also use the Message Log Search tool to search for a message or messages that contain property values of interest.


	
If message content logging is enabled, you can view information about each message logged in a specified time period as well as its content. In this case, in addition to searching for messages based on property values, you can also search based on the content of any message element (free text search).




Business Transaction Management logs message content or instance and property values only if you have done the following:

	
You have enabled monitoring for the transaction


	
You have enabled the appropriate type of logging for the transaction (instance or message)


	
For message logging, you have selected one or more operations




Logged information is stored according to storage settings that you define when you create the transaction.

This section explains how you view information about messages, search message logs for messages, and enable or disable logging.


Viewing Information About Logged Messages and Properties

The Message Log tab for a given transaction displays information using a grid view that displays a list of messages, showing the arrival time of the request message, the service that includes the selected operation, the location of the endpoint that implements the service, the operation (message), and the type of operation. If there are any properties associated with the operation, their values are shown in additional columns whose title is the property name.

If you have message content logging enabled, double clicking on any message shows you the contents of the message.

The set of messages shown in the grid varies depending on the setting of the filters shown at the top of the tab. These allow you to see

	
All operations or specific operations chosen from a drop down list


	
Any response, only successful operations, only failures


	
Messages that arrived within a time interval denoted by the last specified time period, since a certain time, or between two given times.




You can use these controls to narrow the selection of messages shown in the grid. After you change filter settings, click Search again to repopulate the grid.

You can further narrow your search by using the Message Search tool accessed from the Choose Content... link. This allows you to search for messages based on their property values or, if message content is enabled, based on message content. This tool is described in the next section.





Using the Message Log Search Tool

The Message Log Search tool enables you to further refine the scope of your search (in addition to the strictures defined by the view filters). You can access this tool in one of two ways:

	
To find messages belonging to any monitored transaction (for which logging is enabled), choose Search Message Log from the View menu.


	
To find messages belonging to the currently selected transaction, click the Choose Content... link from the Message Log tab of the transaction.




The tool has two main areas you can use to define search criteria: an area labeled Message property search and one labeled Free text search. You use controls in these areas to search for a set of messages based on a property value and/or on text content. As you enter property and free-text values, a search expression is constructed in the text box. To clear the box and start over, press the Clear button.

For additional information about using Oracle query language to formulate your query, look at the following:


http://download.oracle.com/docs/cd/B28359_01/text.111/b28304/cqoper.htm#BABBJGFJ


When you are done defining the expression to be used in the search, click the OK button. Then click the Search button to repopulate the grid according to your newly defined search criteria.


Property-Based Search

The properties that have been defined for the transactions in question are shown in the Message property search area. Use the drop-down lists to specify your property-based search criteria.

	
For a numeric value, the drop down list allows you to search for messages whose properties are less than, equal to, greater than, not equal to, and so on.


	
For a string value, the drop-down list provides a similar set of matching options.








Free Text Search

To use this search option, you must have enabled message content logging.

Enter a string you want to search for in the box labeled Message contains the text. Do not enclose the string in quotation marks unless you're looking for a string enclosed in quotation marks.







Enabling and Disabling Message Logging and Instance Logging

Do the following to enable or disable message logging and instance logging:

	
Select the transaction of interest.


	
Select Modify > Edit TransactionName.


	
In the ensuing dialog, select the Logging tab.


	
Use the check boxes shown to enable or disable message content logging and instance logging.


	
If enabling message logging, select the specific operations you want to log.











Top 10 Transactions Dashboards

The Top 10 Transactions dashboard enables you to quickly identify and assess the health of the most stressed components in your system.

To display the dashboard, choose Dashboards > Top 10 Transactions

The dashboard provides four tables. Each table is based on a particular instrument and lists the transactions with the ten highest measurements for that instrument (except for uptime, which is lowest).

The default evaluation period for the data displayed for transactions is seven days. To change the evaluation period, click the Time Period control at the top of the display. You can change the period to the last day, hour, or 10 minutes.

The Top 10 Transactions dashboard provides tables that list the 10 transaction types with the following characteristics:

	
highest number of started transactions (Most Started table)


	
highest number of completed transactions (Most Completed table)


	
slowest average response time (Slowest Avg Response Time table)


	
highest number of condition alerts (Most Condition Alerts table)




Each table provides numeric instrument values as well as charts. Hover the cursor over a chart to view detailed information for a particular time segment.

For in-depth information and analysis, double-click a transaction or service to display the Tabs area, and select the Analysis tab.






About Transactions

You define transactions on the logical level by specifying which operations participate in the transaction. Business Transaction Management monitors transactions by looking at individual endpoints, and it displays the level of information you require. The level of detail it provides ranges from the minimum of aggregate performance information to the maximum of message content logging. Using Business Transaction Management to monitor transactions is an iterative process: initially you want to look at the greatest possible number of endpoints to get an overall feel for service usage and for potential trouble spots. As you identify these, you want to look at a narrower set of elements but in greater detail. By using this approach, you can get exactly the information you need without straining system resources.

You might want to define and monitor transactions in order to do the following:

	
Assess the performance of business transactions. Business Transaction Management provides information about which transactions are completing, which are failing, and which get stuck. It also tells you how long it takes a transaction to complete as a whole and what part of that duration is used by each operation in the transaction.


	
Find transaction instances based on message content.


	
Troubleshoot problems with transactions: analyze bottlenecks and diagnose the reason for bad performance or failed transactions.




Users playing different roles might use information about transaction performance as follows:

	
Operations personnel need to determine which transactions are impacted by server or component downtime. This helps them prioritize their work and schedule maintenance.


	
Developers need to understand which transactions are impacted by implementation changes to components.


	
A business application owner needs to monitor charts that depict the performance and throughput of transactions.




You define transactions by using the discovery process to identify operation flows. Based on the dependencies revealed by discovery, you can define a transaction to include services whose interactions interest you. You can then modify the default transaction definition to enable monitoring features that provide exactly the level of detail needed about performance and usage. Features include segmenting information by user or host address, instance and property logging, and message content logging.

This section describes this iterative process of defining transactions and the level of detail that is made available as you enable each feature. It includes the following sections:

	
What Defines a Transaction?


	
Properties


	
Auto and Manual Correlation


	
Default Transaction Definition


	
Additional Features


	
Service Level Agreements and Conditions






What Defines a Transaction?

A transaction is defined by the following:

	
A primary operation flow. This is specified by providing the start message, which triggers the flow. The start message is typically the request message for the initial operation of the flow.


	
Additional operation flows if needed, which must be manually correlated to the primary flow.


	
The ending message of the transaction. By default this is the response message from the initial operation of the primary operation flow. However, you can change it to model more complex transactions.




You can alter the transaction's view of the operation flows by deleting one or more operations from a flow.

Business Transaction Management allows you to include the same operation in multiple transactions; the only limitation is that the same operation cannot be the starting operation of more than one transaction. If you do include an operation in multiple transactions, Business Transaction Management is able to keep accurate aggregate measurements for each transaction's overall response time, counting the invocation of the shared operation appropriately as it is called by each of its owning transactions. Business Transaction Management is also able to handle situations where services are replicated, accurately collecting performance information as one replicate or another is used in a failover or load balancing architecture.

A transaction executes many times in a given period; Business Transaction Management tracks the flow of messages included in the transaction and can map these to particular transaction instances.

	
A transaction instance starts when an instance of the primary operation flow is started.


	
A transaction instance ends when the system sees an instance of the ending message that correlates to the instance's starting message.




In addition to the operation flows it contains, a transaction is also defined by settings that specify the following information:

	
The scope of the transaction: how long you expect a single transaction to run. Business Transaction Management uses this value to figure out when to stop looking for messages for a given transaction instance


	
How long to retain logged messages that you might want to assemble so that you can view a particular instance of a transaction


	
Whether transaction monitoring is enabled and whether free text search is enabled


	
Whether segmentation, instance logging, and message content logging are enabled









Properties

In order to allow the user to extract as much information from a message without logging the content of every message, Business Transaction Management offers the use of properties, which are associated with transaction operations. Properties can be associated with parts of the message header or message payload. You can use them in the following ways:

	
To provide values for message keys used to correlate operations in a transaction


	
To surface the value of a message element without having to log the content of the message


	
To search for specific transaction instances


	
To define conditions









Auto and Manual Correlation

Once you define the start and end operation of a transaction, by default Business Transaction Management determines the intervening operations based on traffic flow, and it creates message fingerprints to link together (correlate) the operations of a transaction instance. You can also define manual keys as an alternate means of correlating transaction messages.

You will need to manually correlate operations in the following cases:

	
To add a secondary operation flow to the transaction. This might be necessary in the case of asynchronous systems like JMS or desirable if you want to connect two operation flows that share underlying data but are not causally connected. For example, you have one flow defined by an order entry, and another flow defined by the fulfillment of the order. The same order is involved in two otherwise disjoint processes.


	
To define a transaction whose end message is not the end message of the operation that starts the flow.


	
To define a missing message condition




Look here for additional information on what you need to correlate in each of these cases.

A single transaction definition can contain operations that are correlated automatically and other operations that are correlated manually.






Default Transaction Definition

When you select an operation and choose to create a transaction, Business Transaction Management displays a Create Transaction Definition tool with default values already filled in. According to this default definition:

	
The start message of the transaction is the request message of the operation you selected; the ending message is the response message of that operation.


	
Transaction monitoring is enabled. That is, Business Transaction Management will collect data that enables it to calculate and display the following measurements: the number of started and completed transactions, throughput, average response time, maximum response time, and faults.


	
Messages in the transaction are correlated using message fingerprints (calculated by Business Transaction Management).


	
Segmentation, instance and property logging, and message content logging are disabled.




The default configuration is sufficient to give you a first broad look at your transaction. It can help you identify slow links, faulty services, and unexpected traffic spikes. It can also show you if overall transaction performance is degrading or not completing on time. You can also create fixed value and baselines service level agreements (SLA's) based on the measurements collected for the transaction.

You can customize the default transaction definition in the following ways:

	
Change the operations that are included in a transaction and change the end operation. You might want to do this because the transaction contains one way operations, because you want to limit the transaction to fewer operations than the overall request flow, or because you want to add services in those cases where services are rarely invoked and therefore cannot be found within the discovery period.


	
Correlate messages using message keys.


	
Turn on features that will give you more detailed information about the transaction.




The following subsections describe the features you can add to your transaction definition.






Additional Features

The following are the features you can add to provide a more detailed picture of transaction performance and message content.


Segmentation

You can segment transaction measurements based on host address and by individual consumer. Consumer segmentation might be useful if you have usage contracts with specific customers or if you want to identify customers that make especially heavy or light use of your services.

Segmentation by host address can help you understand the distribution of requests in your network. You can discover whether some network segments or hosts are bearing a disproportionate load of the traffic, or that problematic transactions are all executing on a particular host.





Instance and Property Logging

Enabling instance logging allows you to see a list of transaction instances captured in a given time period. You can assemble and inspect a given instance, view any property values for that instance, and create conditions based on these property values.

You can also search on the logged properties and find the related transaction instance.





Message Content Logging

Enabling message content logging allows you to view message content for the operations you specify, and you can search for an operation based on the content of its request or response message.








Service Level Agreements and Conditions

The features you enable for a transaction record information for the entire transaction and for select operations. In addition to this continual monitoring, whose results you must analyze to discover performance issues, you can also configure Business Transaction Management to alert you about special situations by using conditions and service level agreements.

	
Service level agreements define standards of performance for your transactions based on aggregate measurements. Business Transaction Management then monitors deviations from those standards, and when deviations occur, an alert is issued and displayed in the Management Console.


	
Conditions can alert you when an expected message does not arrive, when a specified message property value is encountered, or when a fault occurs. They are tools to help you detect issues in specific transaction instances. When the condition is triggered and satisfied, Business Transaction Management assembles the corresponding transaction instance, allowing you to view its content and perform whatever analysis is needed for troubleshooting or other performance evaluation.











exportTransactionDefns

Use the exportTransactionDefns command to export transaction definitions known to the target sphere. If you do not specify an output file, the definition is sent to stdout.

You can import exported definitions using the importTransactionDefns command.


Command Syntax


btmcli exportTransactionDefns [-n Name] [-o fileName]
                              -s sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The name of the transaction to export. If you do not provide this value, all existing transaction definitions are exported.
	-o	-outputFile	Specifies a file into which the results of the export will be placed. If you do not provide this value, the output is sent to stdout.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following command exports all transaction definitions to the file MyTransactions.


btmcli exportTransactionDefns -o C:\Home\MyTransactions 
                        -s http://localhost:8080/btmcentral/sphere/ 
                        -l admin:abracadabra






mergeServices

Use the mergeServices command to merge two services (thus removing duplicates). This command removes the source version specified with the -V flag and moves its endpoints to the target version specified with the -T flag. See Resolving Discovery Issues, for a discussion of the discovery issues that might require you merge two endpoints.

After the merge, the target version contains all the endpoints from both versions. If the source version has any profile attributes or message properties that you want to retain for the merged versions, you must recreate these on the target version.

Any historical data maintained for the source version is merged into the data maintained for the target version. Once the merge is completed, it is not possible to return to two distinct aggregated data sets for the two service versions.

You can preview the results of this command before committing to the changes it defines. After previewing, you must run the command again without the -P option to actually make the changes.

Use the moveEndpoints command to move selected endpoints from one service version to another.


Command Syntax


btmcli mergeServices -n friendlyName | -qname qname
                     -V version
                     -T targetVersion [-P]
                     -s sphereUrl -l username:password
             



	Name	Long Name	Description
	-n	-name	The friendly name of the service for which versions should be merged.
If two versions do not have the same friendly name, you must use the -qname flag to specify the service name.


	-qname	--	The qualified name of the service for which versions should be merged.
The qualified name has the form WSDLtargetNamespace:serviceName. For example: http://amberpoint.com/orderService:CreditServiceSOAP.


	-V	-version	The version of the service that will be merged into the specified target.
Use the "-" string to represent the default, unnamed version.


	-T	-targetVersion	The target service version in which to merge the source version (-V). After the merge, this version will contain the endpoints from both versions.
	-P	-preview	Specify this flag to preview the results of the merge without actually performing the merge.
	-s	-sphereUrl	The URL of the sphere.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following example shows the mergeServices command:


btmcli mergeServices -f CreditService -X 1.5 -T 1.6
                     -s http://localhost:8080/btmcentral/sphere/
                     -l admin:abracadabra






unregisterContainer

Use the unregisterContainer command to unregister a container previously registered with Business Transaction Management. Use this command after the container has been taken offline permanently. It is faster to use this command to unregister the container than to unregister each endpoint in it.

Physical containers must be offline long enough for the system to mark them down before you can unregister them.

This command also unregisters all the system services, service descriptors, and endpoints in the container. Any monitored endpoints in the container are no longer monitored, and measurements for these endpoints are deleted.


Command Syntax


btmcli unregisterContainer -baseAddress baseAddress | -fn friendlyName 
                           -s sphereURL -l username:password



	Name	Long Name	Description
	-i	-baseAddress	The base address of an existing entry point in the sphere.
Base address format: scheme://host:port/


	-fn	-friendlyName	Friendly name of the container to unregister. If the friendly name is not unique, you must use the baseAddress option instead.
	-s	-sphereUrl	Required. The URL of the sphere residing in the container you want to unregister.
http://hostname:port/btmcentral/sphere/

This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.









Example

The following command unregisters the container with the friendly name MyApps.


btmcli 
btmcli unregisterContainer -fn MyApps 
                           -s http://localhost:8080/btmcentral/sphere/ 
                           -l admin:abracadabra






showService

Use the showService command to show the structure of the service specified by the friendly name, qualified name, or URL of any endpoint for this service. You can also specify a single version of the service (-version) or the display of more detailed information (-verbose).

The non-verbose output includes: the version number, the qualified name of the service, its friendly name, its binding, who it is managed by and its full URL.


Command Syntax


btmcli showService -n friendlyName  | -qname qname| -e endpointUrl 
                                                               | -wwsdlUrl
                   [-V version] [-v] 
                   -s sphereUrl -l username:password



	Name	Long Name	Description
	-n	-name	The friendly name of the service for which information is sought. You can qualify the name using the-versionflag. Otherwise, information about all the services with the friendly name is displayed.
	-qname	--	The qualified name of the service for which information is sought. The qualified name has the form WSDLtargetNamespace:serviceName. For example: http://amberpoint.com/orderService:CreditServiceSOAP.
	-e	-endpointUrl	The URL of any endpoint of the service. If multiple services define endpoints at this location, information about all these services is displayed.
	-w	-wsdlUrl	The URL of the WSDL file that defines one or more of the service endpoints.
	-V	-version	The version of the service for which information is displayed.
Use the "-" string to represent the default, unnamed version.


	-v	-verbose	Display additional information for each endpoint.
	-s	-sphereUrl	The URL of the sphere. http://hostname:port/btmcentral/sphere/
This flag is not required if you have set the AP_SPHERE_URL environment variable for your sphere.


	-l	-userLogin	The username and password associated with the sphere, in the format: username:password. This set of credentials must belong to a user in the btmadmin role.
See Security Options in Accessing CLI Commands for information on furnishing login credentials.

You can encrypt passwords using the encryptPassword command.








The following shows the output to some sample commands.


btmcli showService -n OrderService

OrderService (Version -)
QName: http://amberpoint.com/orderService:OrderService

   Name: OrderServiceSOAP  Binding: SOAP/HTTP   Managed by: Monitored by Observer
   http://islam.us.oracle.com:7412/bookmart/order/OrderSerrvice


btmcli showService -qname http://schemas.amberpoint.com/sphere:SphereService 

AP_Sphere_Service (Version 7.0.0.0-ExM-Hegemony)
QName: http://schemas.amberpoint.com/sphere:SphereService

   Name: AP_Sphere_Service_SOAP Binding: SOAP/HTTP 
                                      Managed by: AmberPoint AP_Core_Service
   http://islam.us.oracle.com:8080/btmcentral/sphere/
 



Example

The following example uses the showService command to display information for the service defined by the specified wsdl:


btmcli showService 
  -w http://jbujes-desk.edgility.com:7001/bookmart/credit/CreditService?wsdl 
  -s http://localhost:8080/btmcentral/sphere -l admin:abracadabra




